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Welcome to PReS Connect 2021.2

Note

Since we are always looking for new ways to make your life easier, we welcome your
questions and comments about our products and documentation. Use the feedback tool
at the bottom of the page or shoot us an email at doc@ca.objectiflune.com.

PReS Connectis a series of tools designed to optimize and automate customer
communications management. They work together to improve the creation, distribution,
interaction and maintenance of your communications.

The PReS Connect Datamapper and Designer are designed to create output for print, email
and the web within a single template and from any data type, including formatted print streams.
Output presets applied outside the design phase make templates printing device independent.

The Designer has an easy-to-use interface that makes it possible for almost anyone to create
multi-channel output. More advanced users may use native HTML, CSS and JavaScript.

PReS Connect also includes a process automation server, called Workflow. It is capable of
servicing response form web pages and email to provide interactive business communications.
For the user guide of Workflow, see Workflow's Online Help.

PReS Connect can create documents for tablets and mobile devices that run a free Capture
OnTheGo App. Users with a Capture OnTheGo subscription can then download documents to
their own devices, interact with them and send the captured data back to PReS for conversion
into additional documents or workflows.

For more information about the application refer to these websites: Capture OnTheGo and
Capture OnTheGo in the Resource Center.

This online documentation covers PReS Connect version 2021.2.
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Setup And Configuration

This chapter describes the PReS Connect installation and the different considerations that are
important in regards to the installation and use of PReS Connect.

« "System and Hardware Considerations" below

« "Installation and Activation" on page 33

o "Known Issues" on page 117

« "Server Configuration Settings" on page 91

o "Uninstalling" on page 130

System and Hardware Considerations

There are a variety of considerations to be aware of. These are documented in the following
pages:

« "System requirements" on page 30

« "Database Considerations" on page 18

« "Environment considerations" on page 22

o "Known Issues" on page 117

« "Language and Encoding Considerations" on page 25

« "Antivirus Exclusions" below

« "Performance considerations" on page 27

Antivirus Exclusions

The information on this page is designed to assist IT managers and IT professionals decide
what anti-virus strategy to follow with consideration to PReS and their internal requirements
and needs. This page describes the mode of operation and the files and folders used by PReS
as well as the files, folders and executables that are recommended to be ignored for best
possible performance and to avoid issues caused by antivirus file locks.

IT managers and IT professionals then may decide the anti-virus strategy to follow for their
internal requirements and needs depending on the statements outlined herein.
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Directories and folders

All Connect applications are installed under an arbitrarily selectable main folder. If the default
installation folder options were used, this installation folder would be $PROGRAMFILES$\Objectif

Lune\OL Connect.

The installation folder will hold all the executable files and other files and folders required for
the operation of the whole product suite. All these files and folders remain static after
installation. It depends upon the company virus protection strategy, if such files and folders will
be monitored or not.

We do, however, recommend that the following file or folders be excluded from antivirus
protection.

Connect Service

The Connect Service is run via the executable file ServerService.exe. This file has been
reported as causing issues with some antivirus packages, so we recommend adding this file to
the antivirus exclusion list, if possible.

The executable will be installed to the installation target "Connect Server" sub-folder.The full
installation folder can be found by entering $PROGRAMFILES%\Objectif Lune\OL
Connect\Connect Server in Windows Explorer.

AFP Input

Performance issues have been reported with the AFP Input option under Windows Server
versions from Windows Server 2012 onwards. The issues have been specifically associated
with Windows Servers running Windows Defender, but the performance degradation might also
be encountered when using other Antivirus applications.

Consequently, we recommend that an exclusion be made for the afp2pdf.exe executable file in
your Antivirus application.

The afp2pdf.exe file is stored in a subfolder under the installation folder. If the exact installation
folder name is required, enter the standardized system variable spProGrRaMFTLESS in Windows
Explorer and then search for afp2pdf.exe.
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Working folders

Working folders for Connect are created and used on a per-user-basis under the respective
user's profile folder, accessible on Windows with the standardized system variable
SUSERPROFILES in the subfolder "Connect". Working folders are:

e SUSERPROFILES%\Connect\filestore: This folder will hold non-intermediate files
for the operation of Connect. Files in this folder will be used frequently, but not with a high
frequency. Supervising this folder with a virus protection system should not have too
much of an impact on the speed of the whole Connect suite.

e SUSERPROFILE%\Connect\logs:Asthe name implies, log files are created and
updated here. These log files are plain text files. Virus protection may have an impact on
the speed of the whole Connect suite.

e SUSERPROFILE%\Connect\temp: Storage folder for temporary data, usually
intermittent files in multiple folders. Virus protection on this folder and its subfolders may
have a serious impact on the performance of Connect.

e« $USERPROFILE%\Connect\workspace: Usually containing settings and helper files
and folders. Supervising this folder with a virus protection system should not have too
much of an impact on the speed of the whole Connect suite.

Database 1

Depending on the components installed, a database instance is created in a folder called
"connect.database" under the Windows system temp folder. This folder is accessible via the
standardized system variable sTvps. Usually, folders holding such temporary files and folders
should be excluded from a virus protection, because this influences the overall performance of
the whole system at all. However the responsible person for the computer protection has to
decide about the monitoring of such temporary folders following the company guidelines.

Database 2

Another database instance for Connect will be hold and used under the folder, which is
intended to hold data, accessible by and for all users. The path to this folder is stored in the
standardized system variable $pProGraMDATA%. The Connect database instance is located in the

subfolder "Connect\MySQL".

As this database will be in extremely strong usage, virus protection on this folder and its sub-
folders may have a serious impact on the performance of Connect.




Database Considerations

This page describes the different considerations and pre-requisites for the database back-end
used by PReS Connect, whether using the MySQL instance provided by the installer, or pre-
existing (external) instance.

Using the MySQL Instance from the Installer

The MySQL Instance provided in the "Installation Wizard" on page 38is already pre-configured
with options to provide the most stable back-end setup.

These are the specific options that have been changed in our version of "my.ini":

« max_connections =200 : PReS Connect uses a /ot of database connections. This
number ensures that even in high volume environments, enough connections will be
available.

- max_allowed_packet = 500M : In some implementations, especially when using Capture
OnTheGo, large packet sizes are required to allow transferring binary files. This
substantial packet size maximum setting ensures that the data received by PReS
Connect will be able to be stored within the database.

« character-set-server = utf8 , collation-server = utf8_unicode_ci, default-character-
set=utf8 : These indicate database support for UTF-8/Unicode.

Installing / Updating Connect using an existing MySQL instance

If MySQL Server is already present and you wish to use it, the following should be taken into
consideration:

o The minimum supported MySQL version is MySQL 5.6.

« The MySQL account must have access to all permissions using the GRANT Command,
including creating databases.

« The database configuration must include the options detailed in the "Using the MySQL
Instance from the Installer" above topic.

» The database configuration must allow the use of mixed case table names.
This is particularly an issue on Linux MySQL installations.

o The SQL instance must be open to access from other computers. This means the bind-
address option should not be setto 127.0.0.1 or localhost.




Warning

If you chose not to install the supplied MySQL database, and instead opt for using a pre-
existing (External) database then you yourself must ensure that the External database is
accessible to Connect.

Objectif Lune Inc. will take no responsibility for setting up database connections to any
but the supplied MySQL database.

Options available within the installer:

« The Configuration page for the local MySQL is displayed.

« MySQL settings are pre-filled with default values if no existing MySQL database
configuration is found.

« MySQL settings are pre-filled with existing database configuration settings, if they point to
a MySQL database type.

Installing Connect using an existing Microsoft SQL Server instance

If Microsoft SQL Server is already present and you wish to use it, the following should be taken
into consideration:

Warning

If you chose not to install the supplied MySQL database, and instead opt for using a pre-
existing (External) database then you yourself must ensure that the External database is
accessible to Connect.

Objectif Lune Inc. will take no responsibility for setting up database connections to any
but the supplied MySQL database.
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Note

Since PReS Connect version 1.6 the minimum required version of the MS SQL Serveris
SQL Server 2012.

« When MS SQL is selected, the default values for root user are sa and 1433 for the port.

- If database settings from a previous OL Connect installation are found, the pre-exising
settings will be displayed for the matching database type. For MS SQL settings, this will
only work if they were created with Server Config Tool 1.5.0 or later, or the Installer for
OL Connect 1.6.0 or later.

If the database type is changed in the Installer configuration page, the default values for
this database type will be displayed.

If the pre-existing database settings are set to Hsqgldb, the default database type selection
will be MySQL.

« Selected database settings are stored in the preferences, and can be found in this file:
C:\ProgramData\Objectif Lune\OL
Connect\.settings\ConnectHostScope\com.objectiflune.repository.eclipselink.generic.pref
S

Updating With No Local MySQL Product

« When updating a Connect installation from 1.5.0 which contains a Server Product but no
local MySQL Product, the Database Configuration Page will detect which database type
was set before (especially if the database configuration was switched from MySQL to MS
SQL using the Server Configuration Tool), and default to those settings.

« On Update from 1.4.2 or earlier, the Database Configuration Page will always default to
MySQL connection settings, and if the installation was manually tweaked to connect to
MS SQL Server, the user has to switch to "Microsoft SQL Server" type and enter
connection details again.

When modifying Connect

« Iflocal MySQL is removed from an installation, the Database Configuration page will offer
additionally the Microsoft SQL Server database type with respective default values.

« Iflocal MySQL is added to an installation, the usual MySQL Configuration page with
default values will be displayed.




If the user has installed the Installer Supplied MySQL and then switches to an external
Microsoft SQL by using the Server Configuration Tool, the supplied MySQL cannot be switched
off. By design the installer adds a service dependency between Connect Server and the
supplied MySQL service.

Note

The Microsoft SQL selection capability will be available only with 1.6 version and
upwards.

To remove this dependency the user needs to do the following

1. Have a foreign Microsoft SQL running, ready for use with Connect Server.

N

Use the Server Configuration Tool "Database Connection preferences" on page 862 to
switch the database to Microsoft SQL.

Re-start the Connect Server Service, so that the modifications become active.

Counter check that everything is working properly with Microsoft SQL.

Open a command-line prompt with full administration rights.

2R

Enterthe command sc config OLConnect Server depend= /. Thisremoves the
dependency.

Please be aware: The key word depend must be followed immediately by the equal sign,
but between the equal sign and the forward slash there must be a space.

Additional information can be found here: http://serverfault.com/questions/24821.

7. After the dependency has been removed, it is possible to stop the supplied MySQL
service (OLConnect_MySQL).

Warning

If a Connect 1.5 user wants to use Microsoft SQL instead of MySQL for the Connect
Server, there are several points to be taken care of. These are:

« Ifa MySQL instance exists which could be used intermediately, then this should be
selected during the setup. This ensures, that nothing gets installed. Otherwise the
supplied MySQL needs to be installed and the switch to Microsoft SQL needs to be
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done as outlined above.

« ltis not possible to uninstall the supplied MySQL hereafter, when running the
Connect 1.5 Installer in Modify mode.

Important

If a Server Product and a MySQL Product were selected to be installed on Connect 1.5.0, and
then the Server Configuration Tool is used to switch the database used by the Server to an
external Microsoft SQL, then the Update to 1.6 requires an extra step. The procedure is as
follows:

1. Run the Update to Connect 1.6. This will assume the local MySQL database needs to
be updated and configured, so the user has to enter a root password on the MySQL
Configuration Page (can be any password matching Connect security rules).

2. After the update, the Connect 1.6 Setup needs to be run once more to modify Connect.
3. On the Product Selection page, now the MySQL product can be unselected.

4. When stepping forward in the Wizard, the Database Configuration page will be displayed
which allows to configure the Microsoft SQL Server with appropriate settings.

After this modification, the local MySQL is removed, and also the service dependency from
Server to MySQL is removed.

Note

If Connect was initially installed not containing the local MySQL product (i.e. on 1.5
installation an external MySQL was configured as database), then the Update to 1.6 will
allow to select either external MySQL or external Microsoft SQL on the Database

Configuration Page.

Environment considerations

Terminal Server/Service Support

PReS Connect does not support Terminal Server (or Terminal Service) environment as
possible under Windows 2000, 2003 and 2008. This is to say, if Terminal Service is installed




on the server where PReS Connect is located, unexpected behaviours may occur and will not
be supported by Objectif Lune Inc.. Furthermore, using PReS Connectin a Terminal Service
environment is an infringement of our End-User License Agreement.

Virtual Machine Support

PReS Connect supports the following virtual environments:

o VMWare Environments. This includes VMWare Player, VMWare Workstation as well as
VMWare ESX Server.

« VMWare VMotion. This means the virtual machine hosting PReS Connect can be
automatically moved from one ESX server to another in a clustered installation.
Note that if all servers in a VMotion cluster are not strictly identical, you will have to
provide the Objectif Lune Activations team with all possible magic numbers so they can
generate a license that works on all servers. Obtaining the magic numbers is simply a
question of manually moving the VM on which Connect is installed to each server, and
recording the magic number for each of them.

« Microsoft Hyper-V/Azure infrastructure environments.

PReS Connectis not officially supported on any other virtual machines such as Virtual PC,
Parallels, Bochs, Xen, etc.

Warning

Copying (duplicating) a Virtual Machine with Connect installed and using both images
simultaneously constitutes an infringement of our End-User License Agreement.

Note

While some virtual machine environments (from VMWare and Microsoft) are supported,
other virtual environments (such as Parallels, Xen and others) are not supported at this
time.

Remote Desktop Support

Tests have demonstrated that PReS Connect can be used through Remote Desktop. Itis
however possible that certain combination of OS could cause issues. If problems are
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encountered, please contact OL Support and we will investigate.
PReS Connect 1.3 and later have been certified under Remote Desktop.

32-bit or 64-bit Operating Systems?
PReS Connectis a 64-bit software and can only be installed on 64-bit operating systems.
Antivirus Considerations

« Antivirus software may slow down processing or cause issues if they are scanning in

temporary folders or those used by PReS Connect. Please see "Antivirus Exclusions" on
page 15 for more information.

« Antivirus software might interfere with installation scripts, notably a VBS script to install
fonts. McAfee, in particular, should be disabled temporarily during installation in order for
MICR fonts to install and the installation to complete successfully.

Windows Search Indexing Service

Tests have concluded that the Windows Search service, used to provide indexing for Windows
Search, can interfere with Connect when installing on a virtual machine. If the installation
hangs during the last steps, it is necessary to completely disable this service during installation.

« Click on Start, Run.

« Typein services.msc and click OK.

» Locate the Windows Search service and double-click on it.

« Change the Startup Type to Disable, and click Stop to stop the service.
« Try the installation again.

« Once complete, you may re-enable the service and start it.

Commandline switches and .ini entries

PReS Connectis intended to work stably and reliably, based on Java and the Eclipse
framework. To ensure this reliability and robustness, many Java and Eclipse parameters have
been tested and tuned, which is reflected in the respective .ini entries and the used command
line switches. A collection of valuable settings has been elaborated and found its entry in PReS
Connect “good switches list” (called the “whitelist”).
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The protection of the end user’s system is one of our main goals and therefore we have
implemented a very strict verification mechanism, which ensures, that only these whitelisted ini
entries and command-line switches are accepted, when one of Connect components is started
and run. Please be therefore advised, that any non-whitelisted ini entry or command-line switch
will be accepted and will - if tried to be used - lead to the respective application’s “sudden
death”. If you should encounter such a behaviour then please double-check your Connect log
file/s for respective entries.

Language and Encoding Considerations

Please note the following considerations:

« Language:

o PReS Connectis currently offered in several languages. These languages can be
switch between via the Preferences dialog. The current languages include:

« English

« French

« German

e Spanish

« ltalian

« Korean

« Portuguese

o Chinese (Simplified)
« Chinese (Traditional)
« Japanese.

The defaultlanguage is English.
The PReS Connect help system (this document and the online help) is currently
only available in English and (for the biggest part) in French.

« Encoding:

« Issues can sometimes be encountered in menus and templates when running
PReS Connect on a non-English operating system. These are due to encoding
issues and will be addressed in a later release.
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Network Considerations

The following should be taken into consideration in regards to network settings and
communications

« Ifalocal proxy is configured (in the Internet Explorer Options dialog), the option
Bypass proxy server for local addresses must be checked, or some features
depending on local communication will not work.

Firewall/Port considerations

The following describes all of the ports that can be used by an OL Connect solution. IT staff
may decide the firewall strategy to follow for their internal requirements and needs depending
on the statements outlined herein.

Listens on Destination Tupe Comment
port# port # yp
Used for inter-module

communication
Connect Server 9340 TCP Used for Connect REST API

Dedicated internal
connection for inter-process

Messenger 5863/5864 5863/5864 TCP+UDP

Connect Server 9350 TCP e
communication (i.e. between
engines)

HTTP Server 8080 TCP

HTTPS Server 443 TCP

NodedS Server 9090 TCP

ggfvzis HTTPS 5443 TCP

25, or 587 when

SMTP Input plugin encryption is TCP

enabled

Email Input plugin 110 TCP Default POP3 port

;?J(;lijr:e Email Input 993 TCP

Send Email plugin 25 TCP Default SMTP port

Secure Email 587 TCP

Output plugin
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Listens on Destination

port # port # Type Comment
LPR 515 TCP
LPD 515 TCP
Telnet 9100 TCP
FTP Input/Output 21 TCP
MySQL 3306 TCP+UDP
g';:f;sr(’ﬂ sak 1433 TCP+UDP
HyperSQL 9001 TCP

« Port numbers in bold type are user configurable.

« Portnumbers in bold underlined type are based on the type of database used.

« Some of the ports listed above may also be used by other modules.

« User-configurable modules may use other ports entirely, depending on the settings
defined by the end user. A few examples:
The Create Email Content plugin will use the port defined in the Mail host setting in
Workflow's OL Connect Preferences.
The ports used by the HTTP Client Input task, Legacy SOAP Client and SOAP Client
plugin depend on the configured URL.

Performance considerations

In order to get the most out of PReS Connect, it is important to determine how best to maximize
performance. The following guidelines will be helpful in extracting the best performance from
PReS Connect and they give a rough indication when it would be useful to start looking into
hardware upgrades or extra PReS Connect Performance Packs.

Performance analysis details

Connect's output speed is limited to a certain number of output items (web pages, emails, or
printed pages) per minute. What the maximum total output speed will be is determined by your
licence and any additional Performance Packs you might have (see "Speed quota: Pages Per
Minute" on page 98).

To get an indication of the actual Print output speed, output a Print template to a AFP, PDF or
PS file, using one single Weaver engine and the maximum target speed per job (see "Parallel
Processing preferences" on page 106).

Next, open the log file of the Weaver engine. By default, the log files are located in this folder:




C:\Users\ [username] \Connect\logs\WeaverEngine, Where [username] iS your own Windows
user name.

Search the log file for "PPM" (pages per minute). Repeat this a few times to determine the
average output speed.

Likewise, the output speed for an Email or Web template can be found by running it with one
Merge engine and the maximum target speed per job. In the Merge engine's log file, search for
"PPM".

If your jobs are not running at the licensed speed, there may be several ways to improve
performance, as described below. Make sure to address all issues mentioned in this topic
before deciding that you need to invest. Note however that it is not guaranteed that the licensed
speed can be achieved with any job. Creating output for templates with very complex scripts or
complex graphics resources will take a certain amount of time, even on high-end hardware.

Improving performance beyond what can possibly be reached by using the methods described
below requires purchasing a Performance Pack (see Performance Packs).

For advice please contact your local sales office (see Objectif Lune's Contact page).

Engine configuration

As explained in another topic ("Connect: a peek under the hood" on page 133) the Connect
Server cooperates with different engines to handle specific tasks.

A DataMapper engine extracts data from a data file. A Merge engine merges the template and
the data to create Email and Web output, or to create an intermediary file for Printed output. The
intermediary file is in turn used by a Weaver engine to prepare the Print output.

Configuring these engines to match both the hardware configuration and the typical usage
situation is probably the most effective way to improve Connect's performance.

The number of engines is one of the "Parallel Processing Preferences" that let the Connect
Server manage its workload in such a way that the highest possible output speed is achieved.

For an explanation and guidelines to these settings, see "Engine configuration" on page 97
and "Parallel Processing preferences" on page 106.
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Note
Connect Server and Connect Designer each have their own distinct scheduling
preferences.

Use the Connect Server Configuration tool to change the Connect Server settings and
Designer > Windows >Preferences for changing Designer settings.

Template optimization

When you find that the speed per Merge engine - the Content Creation speed - is low,
optimizing a template can make a huge difference. For advice on how to optimize a template
see: "Optimizing a template" on page 1525.

Network and internet connections

Use a fast network and internet connection or avoid loading external or internet resources.
Using images, JavaScript or CSS resources located on a slow network or on a slow internet
connection will obviously lead to a loss of speed. While we do our best for caching, a document
with 5,000 records which queries a page that takes 1 second to return a different image each
time will, naturally, slow output generation down by up to 83 minutes.

Hardware configuration

When processing speed is important, the following is suggested before looking into
Performance Packs to enhance performance (and after addressing the other issues mentioned
in this topic).

« Antivirus exclusions. Sometimes, virus scanners, other security software or indexing
services can interfere. It can help to disable those kinds of tools for the areas where
Connect stores intermediate files. You could exclude the entire
C:\Users\<connectuser>\Connect folder. See also: "Antivirus Exclusions" on

page 15.
« Use a high-performance, low-latency hard drive. Connect benefits from fast I/O. This is

especially true for DataMapper engines (see "DataMapper engine" on page 100).
Preferably use a Solid State Drive (SSD) or similar for storage.

» Use atleast 8+ GB High-Quality RAM. Check memory usage while the Print command is
being executed to see if you need more than the minimum of 8GB. Assuming that the
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Connect Server and the Connect database need 1GB each, and that each engine needs
1GB as well, you can roughly estimate how much memory is needed.

« Consider using a physical machine instead of a virtual machine. When running on a
Virtual Machine, the machine may report that it has sufficient hardware (cores) available,
but in a virtual environment you need to make sure that this hardware is not being shared
with lots of other virtual machines.

« Consider using hardware with more physical cores. PReS Connect doesn't limit the
number of Merge engines that is used for a Print job, so if the number of physical cores is
low, it makes sense to see if that can be increased. When running on a virtual machine,
this is usually easy. When running on a physical machine, it means that you may have to
switch hardware.

« For both virtual and non-virtual environments, make sure the machine is not busy with all
kinds of other processes.

System requirements

These are the system requirements for PReS Connect 2021.2
Operating system (64-bit only)

« Microsoft Windows 2012/2012 R2 Server
Microsoft Windows 2016 Server
Microsoft Windows 2019 Server
Microsoft Windows 8.1

o Microsoft Windows 10 (Pro and Enterprise versions only)

Note

PReS Connect 2021.2 is expected to run on some older operating systems, but just as
Microsoft no longer supports these older operating systems, Objectif Lune Inc. will not
provide support for PReS Connect products running on them.

The historic operating systems that it is expected PReS Connect 2021.2 will continue to
run on include: Microsoft Windows 7; Microsoft Windows 2003 Server; and Microsoft
Windows 2008 Server R2.




Virtual Environments

o VMWare/VSphere
« Hyper-V (8.0)
o Azure

« Amazon Web Services (AWS). Note that only EC2 M4 was certified, other instances may
not work as expected.

Minimum hardware requirements

As with any software application, minimum hardware requirements represent the most basic
hardware on which the software will run. Note however that settling for the minimum
specification is unlikely to produce the performance you expect from the system. It can be used
when configuring a trial or a development system, however.

File system: NTFS (FAT32 is not supported)

o CPU: multi-core

- RAM: 6GB

« Disk Space: 4GB for the software modules, 5GB for work files*

* This depends on the amount of data you process through OL Connect. For instance, a
PostScript file containing several thousands of documents could easily take up several GBs.

Recommended hardware requirements

Due to its versatility, OL Connect is used for a wide variety of applications. Consequently, itis
difficult to determine which hardware configuration will produce the best results for any given
implementation. The following specs should therefore be viewed as a general guideline that is
most likely to produce expected results for most implementations. You should, however, keep
in mind that it may not represent the optimal setup for your particular application.

For more information and tips about performance considerations, see "Performance
considerations" on page 27.

File system: NTFS (FAT32 is not supported)
CPU: Intel Core i7-4770 Haswell or equivalent
« RAM: 16GB

« Disk Space: 4GB for the software modules, 20GB for work files*'




« Storage Type: Solid State Drive (SSD)
« Networking: 10Gb Ethernet

*1 This depends on the amount of data you process through OL Connect. For instance, a
PostScript file containing several thousands of documents could easily take up several GBs.

Requirements for individual Connect modules

OL Connect Products comprises multiple modules that can be operated separately on multiple
PCs. Each module has its own set of requirements that may differ from the other modules.
While the hardware requirements described above are relatively generic when installing all
Connect modules on a single server, they should not be interpreted literally for each individual
module.

When installing on multiple PCs, keep the following rules of thumb in mind:

o The Connect Workflow module requires less RAM but fast hard drive access. It also
benefits from fast multi-core CPUs, in order to run processes in parallel.

o The Connect Server module requires more RAM and benefits from fast multi-core CPUs.
Disk access speed is less of a concern.

o The Connect Designer module requires more RAM and fast disk access to provide a
responsive user-experience.

« The back-end database (MySQL by default) benefits from more RAM, speedy disk access
and fast networking as it will be solicited by all modules simultaneously.

Editions of Connect Products

There are three editions of OL Connect: PrintShop Mail Connect, PlanetPress Connect and
PReS Connect.

While all three editions share common modules, they are generally not used for the same
purposes. Technically speaking, their hardware requirements would therefore be the same but
in practice, PReS Connectis likely to require higher-end hardware while PrintShop Mail
Connect will generally require less power to achieve expected results.

Note

As with any JAVA application, the more RAM available, the faster PReS Connect will
execute.




Installation and Activation

This topic provides detailed information about the installation and activation of PReS Connect
2021.2.

Note

A PDF version of this guide is available for use in offline installations. Click here to
download it.

PReS Connect 2021.2 is comprised of 2 different installers: one for the PReS Connect software
and one for PReS Workflow 2021.2.

Where to obtain the installers

The installers for PReS Connect 2021.2 and PReS Workflow 2021.2 can be obtained on DVD
or downloaded as follows:

« Ifyou are a Customer, the installers can be downloaded from the Objectif Lune Web
Activation Manager (https://www.objectiflune.com/webactivationmanager/) or through the
OL Update Manager if it is activated.

« Ifyou are a Reseller, the installers can be downloaded from the Objectif Lune Partner
Portal site (https://extranet.objectiflune.com/) or through the OL Update Manager ifitis
activated.

Installation - important information

For important information about the Installation, including requirements and best practices,
please see the following topics:

« "Installation prerequisites" on the facing page

o "User accounts and security" on page 35

« "Migrating to a new workstation" on page 61

"Upgrading from previous Connect versions" on page 69
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Installation - "How to" guides

For information on how to conduct the installation itself, choose from the following topics:

« "Installation Wizard" on page 38

o "Running Connectinstallerin Silent Mode" on page 49

« "Installing PReS Connect on Machines without Internet Access" on page 36

Activation

For information on licensing, please see "Activating a License" on page 58.

Installation prerequisites

« Make sure your system meets the "System requirements" on page 30.

o PReS Connect Version 2021.2 can be installed under a regular user account with
Administrator privileges., see "User accounts and security" on the next page.

o PReS Connect must be installed on an NTFS file system.

« PReS Connectrequires Microsoft .NET Framework 4.5 already be installed on the
target system.

« Connect 2019.1 requires updated Connect License and/or Update Manager.
See "Upgrading from previous Connect versions" on page 69 for details.

o In order to use the automation features in Version 2021.2, PReS Workflow 2021.2 will
need to be installed.
This can be installed on the same machine as an existing PlanetPress® Suite 7.x
installation or on a new computer.
For more information, please see "Information about PReS Workflow" on page 68.

If Workflow installation finds that .NET 4.0 is not already installed, it will install that
version as part of the setup process.

If LaserFiche or the ICR libraries are chosen as part of the Workflow installation, then
NET 3.5 must also be installed. This will need to be installed manually, as .NET 3.5 is
notincluded in the Workflow setup.
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User accounts and security

Windows user account

Connectrequires local Windows Administrator rights when installing the software and
activating the software license. This is to allow read/write access to protected Windows folders
and registry entries.

Once installed Connect requires only standard Windows user credentials to run.

The following links contain the details as to when and where Windows Administrator rights are
required:

« Connect Installation: "Installation Wizard" on page 38

« Activating Connect: "Activating PReS Connect" on page 60

Permissions for PReS Connect Designer

PReS Connect Designer does not require any special permissions to run besides that of a
regular program.

It does not require administrative rights and only needs permission to read/write in any folder
where templates or data mapping configurations are located .

If generating Print output, PReS Connect Designer requires permission on the printer or printer
queue to send files.

Permissions for PReS Connect Server

The PReS Connect Server module, used by the Automation module, requires some special
permissions to run. These permissions are set during installation, in the Engine Configuration
portion of the "Installation Wizard" on page 38, but it can also be configured later by modifying
permissions for the service. To do this:

« In Windows, open the Control Panel, Administrative Tools, then Services (this may
depend on your operating system).

« Locate the service called Serverengine_UUID , where UUID is a series of characters that
depend on the machine where the software is installed.

« Right-click on the service and select Propetrties.
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« Inthe Connection tab, define the account name and password that the service should
use. This can be a local account on the computer or an account on a Windows Domain.
The account must have administrative access on the machine. It should also correspond
to the user account set up in PReS Worfklow.

OL Connect Server user accounts

By default, authentication is enabled on the Connect Server. During a new installation the OL
Connect Server's default authentication must be configured by specifying a user name and
password. The default username for new installations is olc-user.

More user accounts can be configured in the Server Configuration Tool (see "Security and
Users Settings" on page 95).

In any Connect Designer that uses a secured Connect Server, an authenticated user account
must be specified via the Designer's Preferences (see the "Connect Servers preferences" on
page 881 sub-section of the Designer Preferences dialog).

Note that prior to PReS Connect version 2020.2, only one user account could be configured on
a Connect Server. The default username was ol-admin and the default password was secret.
When updating to version 2020.2 this user account is not changed. Itis however highly
recommended to modify the default password at least.

Installing PReS Connect on Machines without Internet Access

Installing PReS Connect2021.2 in offline mode requires some extra steps. These are listed
below.

Updating Connect

Updating to Connect 2019.1 from earlier Connect version

In order to update PReS Connect to 2019.1 it is first necessary to update the Connect License.
For details on how to upgrade the Connect License offline see the Upgrading Connect on
machines with no internet access section in the document.

Initial Connect Installation

GoDaddy Root Certificate Authority needs to be installed

In order to install PReS Connectit is necessary for the GoDaddy Root Certificate Authority to
be installed (G2 Certificate) on the host machine and for this to be verified online. When a
machine hosting the installation does not have access to the Internet, the installation will fail




because the verification cannot be performed. To solve this problem one must first ensure that
all Windows updates have been installed on the host machine. Once the Windows updates are
confirmed as being up to date, then complete the following steps:

1. Go to https://certs.godaddy.com/repository and download the following two certificates to
copy to the offline machine:

« GoDaddy Class 2 Certification Authority Root Certificate - G2 - the file is gdroot-
g2.crt

« GoDaddy Secure Server Certificate (Intermediate Certificate) - G2 - the file is
gdig2.crt

2. Install the certificates: Right mouse click -> Install Certificate, and follow the steps through
the subsequent wizard.

3. Now copy the PReS Connect installer to the offline machine and start the installation as
normal

Windows certificate validation - Certificate Revocation List retrieval should be switched
off

For your security Objectif Lune digitally signs all relevant files with our own name and
certificate. The integrity of these files is checked at various times by different, context related,
methods. One of these checks, done during the installation process, uses the Windows
certificate validation check. .

The Windows certificate validation process not only checks the integrity of a file against its
signature, but also usually checks if the certificate itself is still valid. That check is done against
the current Certificate Revocation List (CRL), which needs to be retrieved from the internet.
However, if the machine in question does not have internet access, the retrieval of the CRL
must fail, which will lead to subsequent validation issues.

To circumvent such issues it is highly recommended to switch off the CRL retrieval prior to
installing Connect on machines without internet access. There is no security risk associated
with this, as the CRLs would never be retrievable without internet access, anyway. Advantage
of the switch will not only be found during the installation and operation of Connect, but also in
some speed improvements for any application which use signed binaries.

To switch off CRL retrieval on the computer, complete the following steps:



https://certs.godaddy.com/repository

Open the “Internet Options” via the Control Panel

Select the “Advanced” tab and scroll down to “Security” node.

Uncheck the entry “Check for publisher’s certificate revocation” under that node.
Click the OK button to close the dialog.

Re-start the computer.

AR

Installation Wizard

Updating from Connect versions predating 2019.1

In order to update PReS Connect to 2021.2 from Connect versions prior to 2019.1 itis first
necessary to update the Connect License.

For details on how to upgrade the Connect License see "Users of Connect prior to 2019.1" on

page 70

Starting the PReS Connect installer

The PReS Connect installer may be supplied as an ISO image or on a DVD.

« Ifan ISO image, you can choose between the following, depending upon your Operating
System and the choices available:

1. Burn the ISO image onto a DVD
2. Un-zip the contents to a folder (keeping the internal folder structure intact)
3. Mount the ISO image from within Windows Explorer

« Ifona DVD, eitherinsertthe DVD and initiate the installation from there or copy the
contents to a folder on the target computer (keeping the folder structure intact)

Navigate to the PReS_Connect_Setup_ x64.exe and double-click on it. After a short pause the
Setup Wizard will appear as a guide through the installation steps.

Note that PReS Connect requires prior installation of Microsoft NET Framework 4.5. For a full
list of other prerequisites, see "Installation prerequisites" on page 34.

Running the Installation with extra logging

The installer can be run with enhanced logging options, if needed.
To do so, run the PReS_Connect_Setup_x64.exe from the command line with one of the
following command line options:




e PReS Connect Setup x64.exe --verbose
This adds extra debugging style logging to the installation process.

e PReS Connect Setup x64.exe --trace
This adds full trace style logging to the installation process. The log file this produces will
be very large, as this option logs everything.

Selecting the required components

After clicking the Next button, the component selection page appears, where the different
components of PReS Connect can be selected for installation. Currently, the following are
available:

« PReS Connect Designer: The Designer module (see "The Designer" on page 454) can
be installed standalone (with no other installed modules) on as many machines as you
like. It does not require a license to run as a standalone designer tool . This allows for any
number of people to use the Designer for creating jobs, but without production capabilities
such as automation and commingling.

« PReS Connect Print Manager: The Print Manager module (see "Print Manager" on
page 1529) is required for handling IPDS print output, but can also be used to manage
PCL and PostScript print output.

The Print Manager can be installed standalone and can be installed on more than one
machine.

« PReS Connect Server: The Server back-end that provides Connect production
capabilities such as production content creation (print output, HTML content for emails
and web pages), automation, commingling and picking.

« PReS Connect Server Extension: A Slave server for the main PReS Connect Master
Server module. When an Slave server is installed it communicates with the Master server
in order to shares tasks with it.

Note

Only one of the Server or Server Extensions can be installed on a single machine,
not both.

o MySQL: A supplied MySQL database used by PReS Connect.
The database is used for referencing temporary Connect files and for sorting temporarily
extracted data, and similar.
A pre-existing MySQL or Microsoft SQL server (referred to as an external database, in




this documentation) could be used instead, for the same purposes.

The external database could reside on the same computer or on a separate server.

If you wish to make use of an external database, please make sure the MySQL option is
not selected.

Warning

If you chose not to install the supplied MySQL database, and instead opt for using a
pre-existing (External) database then you yourself must ensure that the External
database is accessible to Connect.

Objectif Lune Inc. will take no responsibility for setting up database connections to
any but the supplied MySQL database.

See "Database Considerations" on page 18 for more information about setting up
external databases.

Note

All instances of PReS Connect Server (Master) and PReS Connect Server
Extension (Slaves) must use the same instance of MySQL. Whilst it is possible for
each separate Slave installation to have its own MySQL instance, doing so will
prevent the Servers from functioning together within a "Server Clustering" on

page 114 environment.

The single MySQL instance can be on any machine, however, whether it be the
Server (master) or one of the Server Extension (slave) machines.

« Installation Path: This is the location where modules are to be installed.

Note

To cater for MySQL requirements, the installation path cannot contain any non
ASCII characters (such as Asian language Unicode characters). Nor can it contain
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characters that Windows disallows in filenames (such as '?', ">' or trailing spaces).
If an invalid character is entered, the Installation Path entry box will turn red and a
description of the error will be displayed in the information area.

The installer can also calculate how much disk space is required for installing the selected
components as well as how much space is available:

. Disk space required: Displays the amount of space required on the disk by the selected
components.

. Disk space available on drive: Displays the amount of space available for installation on
the drive currently in the Installation Path.

« Recalculate disk space: Click to re-check available disk space. This is useful if space
has been made available for the installation while the installer was open.

« Source repository location: Displays the path where the installation files are located.
This can be a local drive, installation media, or a network path.

End User License Agreement

The next page displays the Skin/Formats/CrossReferencePrintFormat("" on page 1), which

needs to be read and accepted before clicking Next.

Configuring Supplied Database Connection

The Default Database Configuration page appears if the supplied MySQL module was
selected for installation in the Product Selection screen. It defines the administrative password
for the MySQL server as well as which port it uses for communication.

The installer will automatically configure the Connect Server to use the supplied password and
port.

o MySQL user 'root' Password: Enter the password for the 'root', or administration
account, for the MySQL server. The password must be at least 8 characters long and
contain at least one of each of the following:

» alower case character(a, b, c...)

« an upper case character (A, B, C ...)
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o anumericdigit(1,2,3...)
« a punctuation character (@, $, ~ ...)
For example: "This1s@K"

Note

When updating from an earlier Connect version, the appropriate MySQL password
must be entered or the update will fail.

If the password is subsequently forgotten, then MySQL must be uninstalled and its
database deleted from disk before attempting to reinstall.

« Confirm MySQL user 'root' Password: Re-enter to confirm the password. Both
passwords must match for installation to continue.

o TCP/IP Port Number: The port on which MySQL will expect, and respond to, requests. A
check is run to confirm whether the specified TCP\IP Port Number is available on the
local machine. If itis already being used by another service (generally, an existing
MySQL installation), the number is highlighted in red and a warning message is
displayed at the top of the dialog.

Note

The MySQL database controlled by the OLConnect MySQL service communicates
through port 3306 by default.

« Allow MySQL Server to accept non-local TCP connections checkbox: Click to enable
external access to the MySQL server.

Note

This option is required if setting up clustering, or if MySQL Server will need to be
accessed from any other machine.

It will also be required if the MySQL database is on a separate machine to this
PReS Connect installation.
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Tip

This option may represent a security risk if the machine is open to the internet.

We heavily recommended that your firewall is set to block access to port 3306 from
external requests.

Configuring External Database Connection

The Database Connection page appears if the supplied MySQL module was not selected for
installation. This page is for setting up the connection to the existing External database.

. Database Configuration: Select the database type to use for thePReS Connect Engine.
Currently only MySQL and Microsoft SQL Server are supported.

« Administrator Username: Enter the user account of a user with database administrative
rights. Administrative rights are required since tables will need to be
created/modified/dropped in the database.

If accessing a database on a different machine, the server must also be able to accept
non-local TCP connections, and the user account must also be configured to accept
remote connection. For example, the "root" MySQL user entered as root@localhost is not
allowed to connect from any other machine than the one where MySQL is installed.

. Database Instance Name: Enter an existing Microsoft SQL Server's instance name.
This option only applies to existing Microsoft SQL Server instances, and not for MySQL.

« TCP/IP Port Number: Enter the port on which the database server expects connections.
For MySQL, this is 3306 by default.
For Microsoft SQL Server itis 1433 by default.

« Server SchemalTable: Enter the name of the MySQL database into which the tables will
be created. The Connect standard name is "objectiflune".

« Administrator Username: Enter the user account of a user with database administrative
rights. Administrative rights are required since tables will need to be
created/modified/dropped in the database.

If accessing a database on a different machine, the server must also be able to accept
non-local TCP connections, and the user account must also be configured to accept
remote connection. For example, the "root" MySQL user entered as root@localhost is not
allowed to connect from any other machine than the one where MySQL is installed.




o Administrator Password: Enter the password for the above user account. For
MySQL the appropriate password must be entered or the Connect installation will fail.

« Use Encrypted SSL Connection checkbox: Check to enable encrypted connections to
MySQL (v5.6.43, v5.7.25, v8.0.x or later) databases using SSL.

The secure connection to MySQL is for the "objectiflune" schema.

Note

Itis notin the scope of the Connectinstaller to configure the MySQL database
Server to accept SSL connections. This must be done prior to the installation of
Connect.

By default, the connection will not verify the server certificate
(verifyServerCertificate=false), which would allow connecting to a server using a
self-signed certificate. If such a certificate is required, then this setting can be
changed after installation within the "Database Connection preferences" on

page 862 (which can be accessed from either the "Server Configuration Settings"
on page 91 tool, or "Preferences" on page 855 window).

« Test Connection button: Click to verify that the information provide into previous fields is
valid by connecting to the database.

Note

This test does not check whether the remote user has READ and WRITE
permissions to the tables under the objectiflune schema. It is solely a test of
database connectivity.

PReS Connect Server/Server Extension Configuration

The Server Configuration page is where either the Connect Server (Master) or Connect
Server Extension (Slave) component is configured, depending upon which option was selected
as part of the installation: Connect Server or Connect Server Extension.
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Connect Server (Master) settings

The Connect Server (Master) settings will be available if Connect Server rather than
Connect Server Extension was selected for installation. The options available are as follows:

o Run Server as: Defines the machine username and password that the Connect Server
module's service uses.

Note

The user account must have access rights to all local and network resources
required for production, as well as Windows "Log on as a Service" rights.

The user account selection must also be retained for future use, as the "Security
and Users Settings" on page 95 dialog can only ever be executed through the user
account specified here.

» Username: The account that the service uses to login. If the machine is on a
domain, use the format domain\username.
This account must be an existing Windows profile with local administrator rights.

- Password: The password associated with the selected user.

« Validate user button: Click to verify that the entered username and password
combination is correct and that the service is able to login.

Note

This button must be clicked and the user validated before the Next button
becomes available.

« Default OL Connect Server authentication: Defines the username and password to
connect to the Connect Server.

« Username: Enter the username for connection to OL Connect Server. The default
username for new installations is olc-user.

« Password: Enter the password to be associated with the selected user.

« Confirm Password: Re-enter the password, to confirm password selection.
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Note that prior to PReS Connect version 2020.2, only one user account could be
configured on a Connect Server. The default username was ol-admin and the default
password was secret. When updating to version 2020.2 this user account is not changed.
Itis however highly recommended to modify the default password at least.

Connect Server Extension Configuration (Slave) settings

The Server Extension Configuration (Slave) options appear when the Connect Server
Extension module has been selected in the installation, rather than the Connect Server
option.

Such an installation assumes that the Connect Server (the Connect Master Server) has
previously been setup on another machine, and that the option "Allow MySQL Server to
accept non-local TCP connections” option were selected during that installation.

Before installing the software, make sure that both TCP/IP ports 3306 and 9340 are open on
the Connect Master Server and Connect Extension Server, in both the Inbound and Outbound
Firewall Rules. Access within the Private and Domain profiles is sufficient.

It is recommended your firewall blocks access to port 3306 from external requests as it may
represent a security risk if the machine is open to the internet!

Before installing the Connect Extension Server it is considered best practice to first setup the
Connect Master Server. To do so, follow the Binding and Root access on the Master server
instructions in "Server Clustering" on page 114.

The following Installation options define the settings which are to be used to connect to the
Connect Master Server.

The Connect Server Slave settings are as follows:.

« Run Server Extension as: Defines the machine username and password that the Slave
Connect Server service uses.

« Username: The account that the service uses to login. If the machine is on a
domain, use the format domain\username.
This account must be an existing Windows profile with local administrator rights.
This should ideally be the same as the logon domain user account for the
OLConnect_Server service on the Connect Master Server.

This account must be a local admin account with existing Windows profile on
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both servers.
« Password: The password associated with the selected user.

« Validate User button: Click to confirm that the username/password combination is
correct.

Note

This button must be clicked and the user validated before the Next button
becomes available.

« Master Server Connection (Default Settings):

o Hostname: Enter the machine name or IP Address where the Connect Master
Server resides. There is no requirement for the Master and Extension servers to
belong to the same IP subnet.

IP subnetting is beyond the scope of this documentation, but more information can
be found here: hitps://en.wikipedia.org/wiki/Subnetwork.

« Port: Enter the port to use to communicate with the Connect Server.
By default the Connect Server controlled by the OLConnect_Server service
communicates through port 9340.

« Use Server authentication checkbox: Check this option to enter appropriate User
details, if the Server expects authentication.
If selected, the following edit boxes activate:

« Username: Enter the user account for connecting to the database on the
Master Server.

« Password: Enter the password for the selected user account.

» Validate Connection button: Click to verify that the connection details to the Master
server database are correct and that the service is able to login to it.

This button does not need to be clicked for the Next button to become available, but
it is advised that you do so, to confirm the Master/Slave Connection settings.

Click Next to display the Selection Confirmation page.
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Selection Confirmation

This page confirms the installation selections made.
Click Next to start the installation itself. This process can take several minutes.

Completing the installation

This screen describes a summary of the components that have been installed.

« Configure Update Check checkbox: This option is enabled by default. It causes the
Product Update Manager to run after the installation is complete. This allows
configuring PReS Connect to regularly check for entitled updates.

Note: this checkbox may not be available in the event that an issue was encountered
during the installation.

« Show Log...: If an issue was encountered during the installation, click this button to
obtain details. This information can then be provided to Objectif Lune for troubleshooting.

« When ready, click the Finish button to close the installation wizard, and initialize the
Product Update Manager, if it was selected.

The Product Update Manager

If the Configure Update Check option has been selected, a message will be displayed after
clicking “Finish” in the setup. The message details the information that needs to be sent back to
Objectif Lune Inc. in order to determine when/if the software needs updating.

Click “Yes” to install or open the Product Update Manager where the frequency with which the
updates can be checked and a proxy server (if required) can be specified.

Note

If the Product Update Manager was already installed by another Objectif Lune Inc.
application, it will be updated to the latest version and will retain the settings previously
specified.

Select the desired options and then click OK to query the server and obtain a list of any
updates that are available for your software.
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« Note that the Product Update Manager can also be called from the “Objectif Lune
Update Manager’ option in the Start menu.

« ltcan be uninstalled via Control Panel | Programs | Programs and Features.
Product Activation

After installation, it is necessary to activate the software. See "Activating a License" on page 58
for more information.

Before activating the software, please wait 5 minutes for the database to initialize. If the
software is activated and the services rebooted too quickly, the database can become
corrupted and require a re-installation.

Running Connect installer in Silent Mode

Updating from Connect versions predating 2019.1

In order to update PReS Connect to 2021.2 from Connect versions prior to 2019.1 itis first
necessary to update the Connect License.

For details on how to upgrade the Connect License see "Users of Connect prior to 2019.1" on

page 70

Required and optional properties

PReS Connect can be installed in a so called "silent mode" to allow an automated setup during
a company wide roll-out or comparable situations. The trigger for the Connect Installer to run in
silent mode is a text file with the fixed name install.properties, which is located either in the
same folder as the PReS_Connect_Setup x86_64.exe or in the unpacked folder of the
installer.exe.

Note

Only the installation can be run silently. Silent Mode does not apply to uninstalling,
modifying, or updating Connect. Any previous version of Connect must be uninstalled
before using the Silent Installer (see: "Uninstalling" on page 130).

The required properties file has the following attributes:
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« Comment Lines, starting with # (e.g. # The options to configure an
external database)

« Key =Value pairs (e.9. install.product.0 = Connect Designer)

For supported keys, please refer to the next paragraph.

Note

The install.properties file notation must follow commons configuration rules. Please
refer to Properties files for more details.

Required and optional properties

Required properties depend on the specified product. Only fields related to that specified
product must be entered. If no product is mentioned, properties must be specified for all valid
Connect products.

Here is an example of an install.properties file.

# Verbose logging
logging.verbose = true

# Product selection

install.product.0 = Connect Designer
install.product.l = Connect Server

# Do NOT install/upgrade the Update Manager
UPDATEMANAGER=0

# Server settings
server.runas.username = Localadmin
server.runas.password = admin

# Database configuration
database.type = mysqgl
database.host = 192.168.116.10
database.port = 3308

database.username = root
database.password = admin
database.schema = my ol
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Verbose logging (optional)

By default, the Silent Installer will log the same way as the GUl installer. That means logging
of error and warnings, and certain information during database configuration. A more verbose
logging can be switched on by using 1ogging.verbose = true.

Product selection (optional)

By default, if nothing is entered for the products to be installed (install.product), Silent
Installer will install all products which are visible to the user for the respective brand. This
doesn't apply to the Server Extension, because only one of the Server or Server Extension can
be installed per installation.)

PReS defaults

install.product.
install.product.
install.product.
install.product.

= Connect Designer
Connect Server

= Connect Print Manager
MySQL

w N PO
(!

Note

The values of install.product properties must contain the exact product names.

Omit the Update Manager from installation (optional)
When specified, this switch instructs the installer not to install the Update Manager.
If itis not specified, or if it has any value other than 0, then it gets installed as usual.

UPDATEMANAGER=0

Note

This entry is case sensitive and must be entered entirely in capitals, as seen here:
UPDATEMANAGER

Installation folder (optional)

To select an installation folder other than the default during a silent installation:
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install.directory=C:/Program Files/Preferred/Directory

Note

This file is a Java properties file. You must use either use forward slashes as shown
above, or double backslashes. Using only a single backslash will result in failed
installations.

If the property is not set, the default path will be used.

Server configuration (required if Server is selected for install)

For Server, the following properties need to be provided:

server.runas.username = <username>
server.runas.password = <password>

Server Extension configuration (required if Server Extension is selected for install)

For Server Extension, the following properties need to be provided:

server.runas.username = <username>
server.runas.password = <password>

server.master.host = <IP or name>

server.master.port = <port>

server.master.authenticate = true or false
server.master.username = <username for the Connect Server>
server.master.password = <password>

Database configuration

Case 1: MySQL is among the selected Connect products to be installed (new MySQL
installation)

If MySQL is selected and there is no previous MySQL configuration on the machine, the
following properties should be defined:

database.password = <password> (required and must meet the rules)
database.port = <port> (3306 is the default port value)
database.unlocked = true or false (the default value is false,
optional)
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Note
The unlocked option should only be used when the database requires an external
access.

If the Silent Installer runs with the default product selection, MySQL is included, and
hence the database.unlocked = true property may be optionally set if MySQL on this
machine is intended to serve as the central database also for remote machines.

If the Silent Installer runs with the explicit installation of a stand-alone
(install.product.0 = Connect Server), the database.unlocked property is irrelevant.

Note

The port will be defined automatically for the MySQL installation. All connect products
selected in the Silent Installer will automatically be configured to use the MySQL running
under the port defined by the database.port property, regardless of the default port 3306
or any other user defined port.

A different port is required if 3306 is already taken on that machine by another
application.

Case 2: The Connect Server or the Connect Server Extension is selected and MySQL is
not selected
In this case, an external database must be configured for the Server (and other Connect

products included in the Silent installation) to be used.

2a: Configuring an external MySQL database

To configure an external MySQL database, the following properties should be defined:

database.type = mysql (required)
database.host <host> (default value is localhost, otherwise

required)

database.port = <port> (default value is 3306, otherwise required)
database.username = <username> (default value 1s root, otherwise
required)

database.password = <password> (required)
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database.schema = <schema name> (default value is objectiflune,
optional)
database.usessl

true/false (select whether to deploy using a
secure database connection (SSL)or not)

2b: Configuring an external Microsoft SQL Server database

Note

Since PReS Connect version 1.6 the minimum required version of the MS SQL Serveris
SQL Server 2012.

To configure an external Microsoft SQL Server database, the following properties should be
defined:

database.type = Microsoft SQL Server (required)

database.host = <host> (default value 1is localhost, otherwise
required)

database.port = <port> (default value is 1433, otherwise required)
database.username = <username> (default value is sa, otherwise
required)

database.password = <password> (required)

database.schema = <schema name> (default value is objectiflune,
optional)

database.usessl true/false (select whether to deploy using a
secure database connection (SSL)or not)

Note

As of PReS Connect 2020.2 the silent installer no longer requires a valid connection to a
database in order to complete. This allows a system administrator to adjust the database
connection post-installation, rather than at installation time.

The installation log records whether the installer tested the database connection or not,
allowing verification post-installation.
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Repository selection

The Connect installation process requires a repository from which the installer copies (locally)
or downloads (online installation) all selected Connect products.

In Silent Installer mode, the installation process looks for the property product.repository in
the install.properties file and then proceeds with the following steps:

1. If the property exists, and its value contains an existing file location with a repository, the
installer will attempt to install from that repository.

2. Ifthe property exists, and its value starts with http:/, the installer will attempt to install from
that location. It will fail if no repository can be found at this location.

3. If none of the conditions mentioned in the previous steps are met, the installer will look
next for a local "repository" folder (located in the same folder as the running Installer
(Setup) executable file). If a repository is found, the installer will attempt to install from that
repository.

4. As a last resort, the installer will attempt to install from the default Connect Update Site
URL.

Examples

product.repository http://192.168.79.73/Connect/Version
0l/repository

product.repository = C:\\iso\\2.0.0.39695 unpacked\\repository

Locale definition
Itis possible to define the Locale which affects the installation language and installed locale for
Connect products by using the following properties in the install.properties file:

user.language
user.country

Locales supported by Connect

The Connect Setup supports a dedicated list of Locales, which is saved in the preinstall.ini file.
Each entry consists of a language tag and a country tag, formatted by the pattern:
<language>-<country>

The current list of supported Locales is found below, but it may be enhanced in future releases:
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« en-US (English, US)

« de-DE (German, Germany)
« fr-FR (French, France)
 ja-JP (Japanese, Japan)

« zh-CN (Chinese, China)

o zh-HK (Chinese, Hongkong)
« zh-MO (Chinese, Macau)

e zh-TW (Chinese, Taiwan)

o it-IT (Italian, ltaly)

« pt-BR (Portuguese, Brazil)

« €s-419 (Spanish, Latin America)

Locale selection by defining user.language and user.country

If both user.language and user.country are defined in the install.properties file, the
combination must match exactly one of the supported locales, otherwise the Installer will exit
with an error.

For example, user.language = fr and user.country = CA will cause an error since fr-CA is
notin the list of supported Locales.

Locale selection by defining only user.language

If only user.language is defined in the install.properties file, the Installer will attempt to find a
Locale in the list which starts with the given language code. The first match is selected for
installation. If no match is found, the Installer will exit with an error.

For example:

e user.language = zh, Will resultin an installation with the Locale zh-CN

e user.language = no, Will resultin an error

Default Locale selection

If neither user.language nor user.country is defined in the install.properties file, the Installer will
select a default Locale:
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1. Ifthe System Locale is in the list of supported Locales, it will be selected.

2. Otherwise, if there is an entry in the list of supported Locales, which matches the System
language, it will be selected (e.g. on a fr-CA system, fr-FR is selected).

3. As last resort, the first Locale in the preinstall.ini is selected (usually that should be en-
us).

Getting the exit code of a silent installation

If getting the exit code of a silent installation is desirable, use the following procedure.

1. Create a new local folder on the machine (or VM) on which Connect shall be installed
and copy/extract the contents of the Connect ISO into this folder.

2. Open a command prompt with Administrator privileges and use the "cd" command to
access this local folder.

3. Run this command to unpack the contents of the Connect Setup executable (as a sample,
we use the PReS Connect brand):
PReS Connect Setup x86 64.exe -nr -gm2 -InstallPath=".\\"

4. In the local folder, the repository subfolder should now be located next to the
preinstall.exe, installer.exe and other Installer files.
5. Create the install.properties file for silent installation in the local folder.

6. With a batch file calling preinstall.exe and then querying the serrorlevels, silent
installation can be started and the exit code can be evaluated. See the sample batch file
below.

Exit codes

0 = Success

« 1=General Errorin preinstall (e.g. not supported settings for user.language /
user.country, for reason see preinstall_err.log)

o 2 =Unknown Errorin preinstall

« 10 = General Error in Installer application (for reason see OL_Install_<timestamp>.log)

Sample batch file
@echo off

preinstall.exe

if errorlevel 10 goto err installer
if errorlevel 2 goto err unknown
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if errorlevel 1 goto err preinstall

echo Success
goto:eof

:err installer
echo "Installer error - see OL Install <timestamp>.log"
goto:eof

:err unknown
echo "Unknown preinstall error - see preinstall err.log"
goto:eof

:err preinstall
echo "Preinstall error - see preinstall err.log"
goto:eof

Activating a License

PReS Connect and PReS Workflow both come with individual 30 day trial license periods
during which time it is not necessary to have a commercial license to run the applications.

This allows time for reviewing the applications and for organizing a commercial license. If a
modification to the trail license is required, such as to allow an extension to the trial period, or
for extra functionality, then a new activation code will need to be requested.

Obtaining the PReS Connect Magic Number

To obtain an activation file the OL™ Magic Number must first be retrieved. The Magic Number
is @ machine-specific code that is generated based on the computer's hardware and software
using a top-secret Objectif Lune family recipe. Each physical computer or virtual computer has
a different Magic Number, and each requires a separate license file to be functional.

To get the PReS ConnectMagic Number open the Connect Software Activation application.

Open the Start Menu

« Click on All Programs and browse to the Objectif Lune folder.

o Open the Connect Software Activation shortcut.

« The PReS Connect Software Activation application consists of the following:
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« License Information subsection:
« Magic Number: Displays the PReS Connect Magic Number.

. -1Copy the magic number to the clipboard: Click to copy the Magic

Number to the clipboard. It can then be pasted in the activation request email
using the Windows CTRL+V keyboard shortcut.

o Licensed Products subsection:

« Name: Displays the name of the application or module relevant to this
activation.

The Information button | 1 | provides detailed information about the application
or module license.

« Serial Number: Displays the trial license serial number or the activation serial
number if the product has been activated in the past.

- Expiration Date: Displays the date when the activation will expire, or the
current date if the product is not activated.

« End-User License Agreement - Appears only when loading a license file:

« License: This box displays the EULA. Please note that this agreement is
legally binding.

« lagree: Select to accept the EULA. This option must be selected to install the
license.

« ldon'tagree: Select if you do not accept the EULA. You cannot install the
license if this option is selected.

« Load License File: Click to browse to the Connect license file (.olconnectlicense),
once it has been received.

« Install License - Active only when a license file is Loaded: Click to install the
license and activate the software.

» Close: Click to cancel this dialog.
Even if a license file has been Loaded, it will not be installed if this dialog is
Cancelled before the Install License button was clicked.

Requesting a license

After getting the Magic Number, a license request must be done for both PReS Connect (for
both Master and Extension Servers, if using a Clustered environment) and Workflow :

o Customers must submit their Magic Number and serial number to Objectif Lune via the
Web Activations page: http://www.objectiflune.com/activations. The OL Customer Care



http://www.objectiflune.com/activations

team will then send the PReS Connect license file via email.

« Resellers can create an evaluation license via the Objectif Lune Partner Portal by
following the instructions there: http://extranet.objectiflune.com/

Note that if you do not have a serial number, one will be issued to you by the OL Activations
team.

Accepting the license will activate it, after which the PReS Connect services will need to be
restarted. Note that in some case the service may not restart on its own. To resolve this issue,
restart the computer, or start the service manually from the computer's Control Panel.

Activating PReS Workflow

PReS Workflow uses the same licensing scheme as PReS Connect. There are two ways of
activating the license for Workflow after saving it to a suitable location:

« Ifonly PReS Workflow is installed, double-click on the license for the PReS Workflow
License Activation dialog to open. Applying the license here activates all of the Workflow
components.

« If you have both PReS Workflow and PReS Connectinstalled, it will not be possible to
double-click on the license file as this will always open the PReS Connect Activations
Tool. Instead, open PReS Workflow manually and apply the license through the
activations dialog within.

Activating PReS Connect

To activate PReS Connect, simply save the license file somewhere on your computer where
you can easily find it, such as on your desktop. You can then load the license by double-
clicking on it, or through the PReS Connect Software Activation tool.

Activating the PReS Connect license requires the user to have local Windows Administration
rights.

« Using a user profile that has local Windows Administration rights, open the Start Menu
» Click on All Programs, then browse to the Objectif Lune folder.
« Run the “Connect Software Activation” tool.

« Click the Load License File button, and browse for the .olconnectlicense file you
received from Objectif Lune Inc..

« Read the EULA and click the / agree option to accept it.



http://extranet.objectiflune.com/

« Click Install License to activate the license. The license will then be registered on the
computer and you will be able to start using the software.

Warning

After installation message will appear warning that the Server services will need to be
restarted. Just click OK to proceed.

Migrating to a new workstation

The purpose of this document is to provide a strategy for transferring a OL Connect (and/or
Workflow) installation to a new workstation.
Before installing the software

Before upgrading to a new version, even on a new workstation, consult the product's release
note to find out about new features, bug fixes, system requirements, known issues and much

more. Simply go to the product page and look for the "Release notes" in the Downloads area.

You should also consult the following pages for some technical considerations before
installing:

« "Network Considerations" on page 26

o "Database Considerations" on page 18

« "Environment considerations" on page 22

« "Installation prerequisites" on page 34

o "Antivirus Exclusions" on page 15

Downloading and installing the software

In order to migrate to a new workstation, the software must already be installed on the new
workstation. Follow the "Installation and Activation" on page 33 guide to download and install
the newest version of PReS Connect on the new workstation.

If using Clustering, please read the "Server Clustering" on page 114 page of this
documentation for more details relevant to the installation.

Note thatin a Clustering setup, both the Master and all Extensions must be upgraded to the
same version.
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Backing up files from the current workstation

The first step in migrating to a new workstation would be to make sure all necessary production
files and resources are backed up and copied over to the new system.

Note

Although it is not necessary to convert all of your documents when upgrading to the latest
version, we strongly recommended doing so. It is considered "Best Practice" to convert
the documents to the version installed and then re-send them to the Workflow Tools.

Backing up Workflow files

To save all Workflow-related files, backup the entire working directory:

C:\ProgramData\Objectif Lune\PlanetPress Workflow 8

Here are a few important points when transferring these files:

« Ifyou are upgrading to the latest version of Connect, it is recommended to open each
template in Designer, produce a proof making sure the outputis correct. Then send the
template with its data mapping configuration, Job Creation and Output Creation preset
files to Workflow by clicking on File > Send to Workflow...

« If you still use PlanetPress 7 legacy documents, PTK files can be imported by clicking on
the Workflow tool button at the top left corner of the Workflow tool interface. If copying the
PlanetPress Workflow 8 folderdirectly, it'simportantto delete any file with the .ps7
extension so as to refresh the PostScript file for the new workstation. Deleting the .ps7
files will make Workflow recreate them.

« The Workflow configuration file itself is named ppwatch.cfg, and is backed up with the
folders. However, it needs to be re-sent to the Service to be used. To do this, rename the
file to .OL-Workflow, open the file with the Workflow tool, and send the configuration.

« Locate Custom Plugins (.dll) from the below folder on the old workstation and import them
onto the new workstation:
C:\Program Files (x86)\Common Files\Objectif Lune\PlanetPress
Workflow 8\Plugins
To import the plugins:

1. Start the Workflow Configuration Tool.
2. Click on the Plug-in Bar.

Page 62




3. Click on the down pointing triangle under the Uncategorized group.
4. Select Import Plug-in and select the .dll file.

Import any external scripts used by the Run Script plugin, making sure they reflect the
same paths as on the previous workstation

Install any external application, executable and configuration files used by the External
Program plugin, making sure they reflect the same paths as on the previous workstation

Reconfigure local ODBC connections (i.e. create local copies of databases or recreate
required DSN entries).

Backup and import other custom configuration files, Microsoft Excel Lookup files, making
sure they reflect the same paths as previously.

Reinstall required external printer drivers and recreate all Windows printer queues and
TCPIP ports.

On the new workstation if the "TCP/IP Print Server" service is running in Windows, it is
requested to disable that service so that it does not interfere with the Workflow LPD/LPR
services.

Configure the Workflow services account as in the previous installation. If accessing,
reading and writing to network shares, it is recommended to use a domain user account
and make it a member of the local Administrators group on the new workstation. Once the
user account has been chosen:

1. Click on Tools in the Workflow Configuration menu bar.
2. Click Configure Services.
3. Select the user account.

If required, grant permissions to other machines (Designer clients and other servers) to
send documents and jobs to the new server.

« Click on Tools in the Workflow Configuration menu bar.
o Click on Access Manager

« Grant necessary permissions to remote machines.

» Restart the Workflow Messenger service.

Reconfigure the Workflow Preferences as previously by clicking on the Workflow button
at the top left corner and clicking on Preferences:

« Reconfigure the Server Connection Settings under Behavior > OL Connect.

« For PlanetPress Capture users, reconfigure the PlanetPress Capture options under
Behavior > PlanetPress Capture.




« Reconfigure each of the plugins, where necessary, under Plug-in as previously.
Capture OnTheGo users may want to enable the Use PHP Arrays option under
Plug-in > HTTP Server Input 1.

« Send the configuration to the local Workflow service.

Backing up Connect Resources

The following resources are used by Connect and can be backed up from their respective
folders:

« Job Presets (.OL-jobpreset):
C:\Users\
[UserName] \Connect\workspace\configurations\JobCreationConfig

o Output Presets (.OL-outputpreset):
C:\Users\
[UserName] \Connect\workspacel\configurations\PrinterDefinitionCo
nfig
« OL Connect Print Manager Configuration files (.OL-ipdsprinter):
C:\Users\
[UserName] \Connect\workspace\configurations\PrinterConfig

o OL Printer Definition Files (.OL-printerdef):
C:\Users\
[UserName] \Connect\workspace\configurations\PrinterDefinitionCo
nfig

« OMR Marks Configuration Files (.hcf):
C:\Users\ [UserName] \Connect\workspacelconfigurations\HCFFiles

Where [username] is replaced by the appropriate Windows user name.
Tip
Actually, the path may not begin with 'C:\Users', as this is language-dependent. On a

French system, for example, it would be 'C:\Utilisateurs'.

Type suserprofiles in a Windows File Explorer and press Enter to open the actual
current user's home directory.

Other Resources
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o OL Connect Designer Templates, DataMapper or Package files, copied from the folder
where they reside.

« All PostScript, TrueType, Open Type and other host based fonts used in templates must
be reinstalled on the new workstation.

« Import all dynamic images and make sure their paths match those in the old server.

« Make sure the new workstation can also access network or remote images, JavaScript,
CSS, JSON, and HTML resources referenced in the Connect templates.

Secondary software and licenses

The following only applies to specific secondary products and licenses that interact or are
integrated into the main product.

Image, Fax and Search Modules

« Reconfigure the Image and Fax outputs with the new host information.

« Import the Search Profile and rebuild the database in order to generate the database
structure required by the Workflow.

Capture

1. Download the latest version of the Anoto PenDirector.

2. Before installing the PenDirector, make sure the pen’s docking station isn’t plugged into
the server. Then install the PenDirector.

3. Stop the Messenger 8 service on the old and new server from the Workflow menu
bar: Tools > Service Console > Messenger > right-click and select Stop.

4. Import the following files and folders from the old server into their equivalent location on

the new server:

C:\ProgrambData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\capture\PPCaptureDefault.mdb

C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\DocumentManager

C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\PGC

5. If Capture was previously using an external MySQL or Microsoft SQL Server, reconfigure
the ODBC connection details as previously from the Workflow Preferences by clicking on
the Workflow button at the top left corner and clicking on Preferences, then reconfigure
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the PlanetPress Capture options under Behavior >PlanetPress Capture > Use ODBC
Database.

6. Start the Messenger 8 service on new server from the Workflow menu bar: Tools >
Service Console > Messenger > right-click and select Start.

OL Connect Send

« As of version 8.6 the Connect Send plugins are installed automatically with Workflow. If
you are using an older version, run the OL Connect Send Plug-in Installer on the new
Workstation to re-install the Connect Send plugins.

« Reconfigure the Server URL and port during the OL Connect Send Printer Driver setup.

o Re-run the OL Connect Send printer driver setup on client system and select the Repair
option to point the clients to the new Server URL.

Configuring the Connect Engines

Any changes made to the Server preferences require the OLConnect_Server service to be
restarted to take effect.

1. Stop the OLConnect_Server service from Control Panel > Administrative Tools >
Services > OLConnect_Server > Stop.

2. Configure the Merge and Weaver Engines scheduling preferences as in the previous
installation

» Open the Server Configuration from:
C:\Program Files\Objectif Lune\OL Connect\Connect Server
Configuration\ServerConfig.exe

« Configure the DataMapper, Merge and Weaver engines preferences (see "Parallel
Processing preferences" on page 106). As of version 2018.1 these preferences
include the minimum (Xms) and maximum (Xmx) memory utilization for the Server,
Merge and Weaver engines.

« Configure any other options for the Clean-up Service.

3. Now start the OLConnect_Server service

Configuring the Server Extensions

In the case where the OLConnect MySQL is installed on the new Master Server, itis important
to reconnect all Server Extension systems to the new Master Server.

Perform the following action on each Server Extension:
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1. Stop the OLConnect_ServerExtension service from Control Panel > Administrative
Tools > Services > OLConnect_ServerExtension > Stop.

2. Open the Server Extension Configuration from:
C:\Program Files\Objectif Lune\OL Connect\Connect Server
Extension\ServerExtension.exe

3. Click on Database Connection and configure the JDBC Database connection settings so
that the hostname points to the new Master Server.

4. Click on Scheduling and type in the location of the new Master Server.

5. Startthe OLConnect_ServerExtension service.

Transferring software licenses

Once all the above resources have been transferred over to the new server, it is recommended
to thoroughly test the new system - in demo mode - with sample files under normal production
load to identify points of improvement and make sure the output matches the user's
expectation.

Output generated at this point will normally bear a watermark which can be removed by
transferring licenses from the old server to the new one.

« To transfer Connect and Workflow licenses, the user is usually required to complete a
License Transfer Agreement which can be obtained from their local Customer Care

department.
« If you want to transfer your licenses to the new machine right away, you may ask your

local Customer Care department for a 30day Transition activation code for your old
machine.

« Upgrades cannot be activated using the automated Activation Manager. Contact your
local Customer Care department.

To apply the license file received from the Activation Team:

1. Ensure that all services are stopped on your old machine before activating and starting
the services on the new machine. Attempting to run the software with the same license
simultaneously will not only run into errors butitis a breach of our EULA.

2. Startthe PReS Connect, PlanetPress Connect or PrintShopMail Connect Software
Activation module:
C:\Program Files\Objectif Lune\OL Connect\Connect Software
Activation\SoftwareActivation.exe

3. Click on Load License File to import the license.OLConnectLicense.
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4. Start the Software Activation module on the Extension servers, where applicable.
5. Click on Load License File to import the above same license.OLConnectLicense.

6. Restartthe OLConnect_Server service and restart the OLConnectServer_Extension
service on the Extension servers, where applicable.

7. The number of Expected Remote Merge and Weaver engines should now be
configurable in the Connect Server Configuration module (C: \Program
Files\Objectif Lune\OL Connect\Connect Server

Configuration\ServerConfig.exe)
To apply the PlanetPress Capture License:

1. Open the Workflow Configuration.

2. Click on Help on the Menu Bar and click on PlanetPress Capture License manager to
import your license.

Uninstalling PReS Connect from the previous workstation

Itis recommended to keep the previous install for a few days until everything is completed.
However, once your transition is successful and complete, the OL Connect software must be
uninstalled from the original server. See "Uninstalling" on page 130.

Information about PReS Workflow

If you wish to use PReS Workflow (automation) in conjunction with PReS Connect, you will
need to install PReS Workflow 2021.2 as well. Workflow 2021.2 is provided through a separate
installer which is available on CD or for download as follows:

« If you are a Customer, the installer can be downloaded from the Objectif Lune Web
Activations page: http://www.objectiflune.com/activations

« If you are a Reseller, the installer can be downloaded from the Objectif Lune Partner
Portal: http://extranet.objectiflune.com/

PReS Workflow can be installed in parallel on the same machine as an existing PlanetPress®
Suite 7 x installation.

Note however:
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« If both versions need to be hosted on the same machine, PReS Workflow 2021.2 must
always be installed after the legacy PlanetPress® Suite 7.x installation.

o When uninstalling PReS Workflow 2021.2, you may be prompted to repair your legacy
PlanetPress® Suite 7.x installation.

« IfPReS Workflow 2021.2 has been installed alongside PlanetPress® Suite 7, Capture
can no longer be used with Workflow 7.
The plugins are now registered uniquely to Workflow 2021.2 and the messenger for
Workflow 7 is taken offline. Itis only then possible to use Capture from PReS Workflow
2021.2.

o PReS Workflow 2021.2 and PlanetPress® Suite Workflow 7 cannot run simultaneously,
since only one version of the Messenger service can run at a time. In fact, no two versions
of Workflow can be run simultaneously on the same machine, regardless of versions.

« lItis possible to switch between different versions running by shutting down one version's
services and then starting the other. However, this is not recommended. There are no
technical limitations that prevent processes from previous PlanetPress Suite Workflow
versions (as far back as Version 4) to run on PReS Workflow 2021.2, removing the need
to run both versions.

For more information on the licensing of Workflow 2021.2, please see "Activating a License" on

page 58.

Upgrading

This page provides information about Upgrading to PReS Connect version 2021.2.
Upgrade information is detailed in the following pages:

« "Upgrading from previous Connect versions" below

« "Upgrading from PReS Classic" on page 73

Upgrading from previous Connect versions

Always backup before upgrading

It is recommended that you always backup your existing Connect preferences before upgrading
to a new version. This will enable you to revert back to the previous version, in a worst case
scenario in which the new version introduces issues with your existing production processes.
Whilst the probability of such a worst case scenario is remote, it cannot hurt to take some
simple precautions, justin case.




For instructions on how to do so, please see "Backup existing Connect version" on the next
page.

Note

The scheduling settings were changed significantly in version 2019.2. Please make sure
to record your current scheduling settings for reference before proceeding with an
upgrade.

Users of Connect prior to 2019.1

Users of Connect 1.1 should see "Users of Connect 1.1" on the next page first.

Users of all other Connect versions prior to 2019.1 should note that Update Client 1.2.40 is a
prerequisite for both OL Connect 2019.1 and Connect Workflow 2019.1 installations. Only
Update Client 1.2.40 has the capacity to upgrade the OL Connect license to the newer format
that is required by the installers of those products.

If you do not have Update Client version 1.2.40 installed already, then the next time you run
your Update Client it will show that there is an update available of itself to Version 1.2.40 (or
later).

Simply click on the “Install” icon # to initiate the upgrade.

For further details on how to upgrade the Update Client and update your Connect License see
the Update Client 1.2.40 Upgrade Guide (http://help.objectiflune.com/en/archive/Update
Client_1.2.40-Upgrade_Guide.pdf).

Note that an erroneous or incomplete uninstall before a reinstall or upgrade to a newer version
of OL Connect may cause issues (see Product or engine exits within a second of starting in
Connect's Knowledge Base).

Note

If an error occurs during uninstallation or after/when re-installing Connect after
uninstalling it, please see: Problems during a Connect installation or version upgrade in
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Connect's Knowledge Base (https://help.objectiflune.com/en/kb-
connect/#KB/FAQ/OL%20Connect/KB2002.htm).

Users of Connect 1.1

In order for users of PReS Connect 1.1 to upgrade to any later version through the Update
Manager itis necessary to install a later version (1.1.8 or later) of the Objectif Lune Update
Client.

If you do not have such a version installed already, the next time you run your Update Client it
will show that there is an update available of itself to Version 1.1.8 (or later).

Simply click on the download button in the dialog to install the new version of the Update
Client. Note that itis no problem to run the update while the Clientis open. It will automatically
update itself.

Once you have done this, PReS Connect2021.2 will become available for download.

Note

From PReS Connect Version 1.2 onwards, the new version (1.1.8) of the Update Clientis
included by default with all setups.

Backup existing Connect version

Itis recommended that you always backup your existing Connect preferences before upgrading
to a new version. This will enable you to revert back to the previous version, in a worst case
scenario in which the new version introduces issues with your existing production processes.
Whilst the probability of such a worst case scenario is remote, it cannot hurt to take some
simple precautions, justin case.

Backing up a virtual machine

Backing up a virtual machine installation is relatively straight forward. Simply take a snapshot
of the virtual machine instance, prior to upgrading. This would save all the localized
preferences and configurations.




Backing up a real machine

Note

The scheduling settings in version 2019.2 have totally changed, making it impossible to
revert these settings back to the previous version. Please make sure to record your
current Scheduling settings for reference before proceeding with an upgrade.

Backup these folders

C:\ProgramData\Objectif Lune\OL
Connect\.settings\ConnectHostScope

C:\Users\ [UserName] \Connect\filestore

C:\Users\ [UserName] \Connect\workspace\configurations

C:\Users\
[UserName] \Connect\workspace\Designer\.metadata\.plugins\org.ec

lipse.core.runtime\.settings

C:\Users\
[UserName] \Connect\workspace\Server\.metadata\.plugins\org.ecli

pse.core.runtime\.settings

Where [username] is replaced by the appropriate Windows user name.

Tip
Actually, the path may not begin with 'C:\Users', as this is language-dependent. On a
French system, for example, it would be 'C:\Utilisateurs'.

Type suserprofiles in a Windows File Explorer and press Enter to open the actual
current user's home directory.

Backup your database

If you want to be completely thorough and be able to exactly replicate your existing system, you
should also backup your existing Connect database.
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If the default MySQL database is being used as the Connect back-end database, we would
recommend the MySQLDump tool be used for this. See for details on this utility
program: mysqgldump (https://dev.mysql.com/doc/refman/5.7/en/mysqldump.html).

Upgrading from PReS Classic

PReS Classic and PReS Connect are very different products.

Whilst PReS Connect provides considerably more options for email and web output, one need
not abandon existing PReS Classic print jobs. They can still be run through Connect Workflow,
via the PReS Print Controls task in the Online Help of Workflow (see
http:/help.objectiflune.com/en/PReS-workflow-user-
guide/2021.2#Workflow/TasksProperties/PReS_Print_Control.html).

Upgrading from PlanetPress Suite 6/7

Note

This document is intended for people that purchased PReS Connect and were previously
users of PlanetPress Suite version 6 or 7. They should already have their new serial
number(s) in hand and the PReS Connect installers.

PReS Connect, Objectif Lune’s innovative technology, embodies a true Production Print as
well as an Interactive Business Communication Solution.

This document provides information on the migration process and the requirements and
considerations for existing PlanetPress Suite users to upgrade to the latest generation of our
products.

What does PReS Connect contain?

PReS Connectis comprised of the following modules:

o PReS Workflow 2021.2. This is the natural evolution of PlanetPress Suite Workflow 7
(Watch, Office or Production). PReS Workflow 2021.2 is very similar to the PlanetPress
Suite Workflow 7 version but contains a number of new features and has the ability to run
PReS Connectjobs, as well as PlanetPress Suite, PrintShop Mail Suite and PReS
Classic documents.
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« Imaging for PReS Connect is available as an option. It contains:
« PReS Fax
« PReS Image
o PReS Search

IMPORTANT: If you owned them, you must also upgrade your Imaging modules to
use the new version.

« PlanetPress Capture is still supported in PReS Workflow 2021.2 but only with
documents created with the PlanetPress Suite Design 7.

« PReS Connect Designer. This is a design tool based on completely new technology. Itis
not backwards compatible and therefore cannot open PlanetPress Suite Design 7
documents. If you want to continue editing those documents you can keep doing so in
PlanetPress Suite Design 7.

« PReS Connect Server. This is the core of the Connect technology (see "Connect: a peek
under the hood" on page 133 in the Online Help:
https://help.objectiflune.com/en/planetpress-connect-user-guide/2021.2/). This new
module automates the merging of data with your new templates and generates the output.
Itis required for PReS Workflow 2021.2 to handle templates created with the PReS
Connect Designer. It can be installed on the same or a different machine as PReS
Workflow 2021.2.

IMPORTANT: PReS Connect does not contain the PlanetPress Design 7.

PReS Connect does not need any printer licenses to print from PReS Connect or
PlanetPress Suite. It can also print PrintShop Mail 7 and PReS Classic documents if these
programs are licensed.

You can keep everything you have

The first thing to know is that you can keep your current PlanetPress Suite Workflow 7
configuration and your PlanetPress Suite Design documents. When upgrading to PReS
Connect, they will remain functional.

Please note that PlanetPress Suite Workflow 7 and PReS Workflow 8 cannot run at the same
time. See "Information about PReS Workflow" on page 68 for information about these

limitations. The only exception is the PlanetPress Suite Design tool that you can continue to
use as itis not part of PReS Connect.




PReS Connect installation considerations

The PlanetPress Suite could run on a computer with a minimum of only 1GB of RAM available.
The PReS Connect Server with PReS Workflow 2021.2, by default, requires 8GB of RAM, but if
you intend on using the new PReS Connect Designer on the same computer, you should
consider having at least 16GB of RAM available. See "System requirements" on page 30.

Distributed installation or not

You can decide to install PReS Connect modules all on the same computer or have each
module on a different computer. Reasons for this could be:

« There is insufficient memory in the computer currently running PReS Workflow 2021.2 to
also run PReS Connect Server.

« You want to use a more powerful computer with more RAM and more cores to run the
Server to achieve maximum performance (see "Performance considerations" on

page 27).

What do | gain by upgrading to PReS Connect?

When upgrading to PReS Connect, PlanetPress Watch users receive key features of
PlanetPress Office such as the following:

« Ability to input data from PDF

« Ability to print your PlanetPress Suite documents on any Windows printer (no need for
printer licenses)

« Ability to create standard PDF output from your PlanetPress Suite documents

« Even if you don’t recreate your existing PlanetPress Suite documents, you can easily
change your workflow to convert your output to PDF, then output them in PCL to any
device supporting it.

« The full version of PlanetPress Connect can open your company to the digital world by
enabling you to send HTML responsive emails as well as creating dynamic responses
and interactive web pages.

You can reuse the content of your existing documents and map it onto responsive
documents that can be sent by email in full HTML glory and/or make them available as
native HTML web pages using the latest CSS/JavaScript features.
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Note

If you were a PlanetPress Production user, you retain all functionalities within PReS
Workflow 2021.2. These are automatically imported during the activation (see below).

Create new documents and integrate them into your workflow at your own pace

You can start benefiting from the innovative technology of the new PReS Connect Designer
right away by designing new documents, or re-doing existing ones at your own pace. You can
also now:

« Use the new DataMapper to easily map any input data into a clean data model that any
designer person can use.

« Easily create documents with tables that spread over multiple print pages, respecting
widow and orphan rules, displaying sub-totals and totals properly.

« Have text that wraps around images.
Upgrade steps

1. To upgrade to PReS Connect, the first step is to stop your PlanetPress Workflow
services. You can do so from the PlanetPress Workflow configuration tool or from the
Windows Service Management console.

2. Then, using the PReS Connect setup, install the Designer and/or Server on the
appropriate computers.

3. Then, using the PReS Workflow 2021.2 setup, install PReS Workflow and/or PReS
Image on the appropriate computers. (See "Installation and Activation" on page 33 for
more details.)

Note
If Workflow installation finds that .NET 4.0 is not already installed, it will install that
version as part of the setup process.

If LaserFiche or the ICR libraries are chosen as part of the Workflow installation,
then .NET 3.5 must also be installed. This will need to be installed manually, as
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4.

5.

.NET 3.5 is notincluded in the Workflow setup.

If you installed PReS Workflow 2021.2 on the same computer where you had
PlanetPress Suite Workflow 6 or 7, you can use the Upgrade Wizard to import your:

« PlanetPress Workflow:
« Processes configuration
« PlanetPress Suite compiled documents
« Service configuration
« Access manager configuration
o Custom plug-ins

« PlanetPress Fax settings

« PlanetPress Image settings

« PlanetPress Search profiles

« Printer activation codes

« PlanetPress Capture database

« PlanetPress Capture pen licenses

o Custom scripts

« Content of your virtual drive

« PlanetPress Messenger configuration

If you installed PReS Workflow 2021.2 on a different computer, please see "How to
perform a Workflow migration" on page 82 for help importing all those settings, if you wish

to import them.

To launch the Upgrade wizard, open the PReS Workflow 8 configuration tool and, from
the Tools menu, launch the Upgrade Wizard.

IMPORTANT: Before you start this process, make sure you have a backup of your current
installation/computer.
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8. Then select the product from which you wish to upgrade:

% Upgrade wizard opticns @

Upgrade from version

IF'IanetF'ress Suite  to PlanetPress Connect ;I

fram which to perfarm the upgrade, and press
et

WARMIMG - Ay files upgraded from a previous
wvergion of the PlanetPreszs Workfow will
avenarite your curent files bearing the same
name. Pleaze backup your curent files to avaoid
arny data lozs.

Exit MHest >

9. Ifyou selected to do a Custom upgrade, select the required options:
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10. Then finally review the log in the final dialog for details on how it went:
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11.

12.

% Upgrade wizard options @

LOG: pgrade Completed. -

Exit

After that you will need to get the activation file for your product.

To obtain your activation, download the PReS Connect installer from the Web Activation
Manager (http://www.objectiflune.com/webactivationmanager/), follow the instructions for
the installation using the serial number provided to you. You can activate your license
through the Web Activation Manager.

From now on, if you need to modify your PlanetPress Design documents, simply open
PlanetPress Design 6 or 7, edit your document and send the updated version to PReS
Workflow 8. In order to do that:

« If you have PlanetPress Design on the same computer as PReS Workflow 2021.2,
you need to save the documents to PTK by using the “Send to” menu, then "PReS
Workflow”, and there use the “Save to file” button. Then, from the PReS Workflow
configuration tool, in the “Import” menu, select “Import a PlanetPress Document” and
select the previously saved file.

« Ifyou have PlanetPress Design on a computer and PReS Workflow 2021.2 on
another, you can simply use the “Send to” menu in the Designer and select the
PReS Workflow tool to which you want to send the PlanetPress Design document.
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How to perform a Workflow migration

What do you need to consider when upgrading from PlanetPress Suite 7 to PReS Connect
Workflow 2021.2 on a new computer?

Installing and Activating Workflow 2021.2 on a new computer

Points to consider:

« Before installing, be sure to read "Installation and Activation" on page 33. There you will
find detailed Connect Workflow installation steps as well as system requirements, notes
on license activation and much more.

« Itis recommended you retain your existing PlanetPress Suite installation for a period of
time after the PReS Connect Workflow 2021.2 installation. We recommend this
particularly when undertaking migration from one to the other. Once the migration has
completed, you should uninstall PlanetPress Suite from your original installation. In the
meantime, a fresh installation of PReS Connect will run for 30 days without requiring an
activation code, to simplify the migration process.

« Request new activation codes for your software licenses (License Transfer agreement
needs to be filled out and signed). Contact your local Activations Department.
www.objectiflune.com/activations

« Please note that PlanetPress Suite Workflow 7 and PReS Workflow 8 cannot run at the
same time. See "Information about PReS Workflow" on page 68 for information about
these limitations. The only exception is the PlanetPress Suite Design tool that you can
continue to use as itis not part of PReS Connect.

Printer Licences

If you are currently using Printer Licenses under PlanetPress Suite 7 and wish to continue
doing so in PReS Connect Workflow 2021.2, there are a few ways in which you can reinstall
those printer activation codes onto PReS Connect Workflow 2021.2. They are as follows:

« If you retained the .pac file (printer activation codes) from your previous installation, then
double click on that file from within your new computer, and the printers will get activated.

If you did not retain the pac file, you can export a new printer activation code. This is done
from the PlanetPress Suite Designer Help > Printer Activation menu option. When the
"Activate a printer" dialog is launched, right click within it and select the Export context
menu option, then save the file on the new computer. Double clicking on the .pac file will
then activate all of your printers on the new computer.



http://www.objectiflune.com/activations

« Login to our Web Activation Manager (www.objectiflune.com/activations) using your
customer number and password to get your Printer Activation Codes.

« If you do not have access to the computer in which PlanetPress Suite was previously
installed, print a Status Page for each printer from your Connect Workflow 8
Configuration. Do this via the Tools > Printer Utilities menu option. Select “Print Status
Page” and then select your printers from the list.

Email the Status Page(s) to activations@ca.objectiflune.com and you will receive a .pac
file in return, with which you can activate your printer(s).

Documents and Resources

PlanetPress Suite Documents and Resources

« Backup all your PlanetPress Suite Design documents from your old computer and copy
them onto the new computer. The files use the extension .ppX, where X is the version
number of the PlanetPress Suite that created the files.

The documents do not have to be in any specific folder.

« Back up the entire directory of: "C:\ProgramData\Objectif Lune\PlanetPress Suite
7\PlanetPress Watch\Documents".
This folder contains all the PlanetPress Design documents and compiled forms (*.ptk and
*.ptz).
Paste the files onto the new computer in the following folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\Documents"

« Back up the latest .pwX (PlanetPress Workflow Tools Configuration) file, found here:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\".
Paste onto the new computer in the following folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\"

There are several ways you can import Documents into PlanetPress Workflow. They are as
follows.

1. In Connect Workflow go to File > Import > PlanetPress Document ... and select the .ptk

document you wish to import.
These files will most likely be found in the Documents folder on the PlanetPress Suite

computer:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\Documents"

2. Copy all the PlanetPress Suite 7 Documents and Compiled forms (*.ptk and *.ptz) from
the Documents folder on the PlanetPress Suite computer and paste them into the
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equivalent folder on the Connect Workflow Computer.

The PlanetPress Suite 7 folder would be "C:\ProgramData\Objectif Lune\PlanetPress
Suite 7\PlanetPress Watch\Documents".

The PReS Connect Workflow 8 folder will be "C:\ProgramData\Objectif Lune\PlanetPress
Workflow 8\PlanetPress Watch\Documents"

3. Use the File > Send To menu option in PlanetPress Suite Designer and select the PReS
Connect Workflow 8 to which you want to send the PlanetPress Suite Designer
document.

This should work with PlanetPress Suite versions 6 and 7.

Make sure that ports 5863 and 5864 are not blocked by firewall on either machine.

Also make sure you add the PlanetPress Suite machine’s IP address to the permissions
listin Connect Workflow 8 from Tools > Access Manager.

Further information about Workflow Access Manager can be found here: Access

Manager.

Windows Operating System Steps:

« Install all the Windows printer queues from the old computer, making sure they are named
the same.

« If your existing documents referenced any local dynamic image resources in a folder orin
Local Host, make sure that you import them onto the new computer as well, or make them
available on a network accessible drive.

« Any special PostScript or TrueType fonts used will also need be installed on the new
computer.

« Verify that you have access to any other resources that the PlanetPress Suite used. This
includes network folders, printers, third party software and the like.

Workflow Plug-ins

Back up any custom PlanetPress Suite Workflow configuration Plug-ins (.dll) and copy them
onto the new computer.

The PlanetPress Suite Workflow plug-ins folder can be found here:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\Plugins".

Make sure that you copy only the custom plug-ins.

Alternatively, you can download custom plug-ins from
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http://planetpress.objectiflune.com/en/suite/resources/support onto the new computer.

Once you've copied your PlanetPress Suite Workflow configurations to Connect Workflow, you
can confirm their availability through the Plug-in Bar Uncategorized category. There you will
find all the Custom plug-ins that have been installed.

Missing plug-ins will be represented in Workflow steps through the use of a "?" icon. Such as in
the following image, which shows that the " TelescopingSortPlugin" is not installed.

Mot Found
Telezcopings artFlugin

To import a plugin:

o & b

Click on the popup control (£ ) in the Plug-in bar.
Select Import Plugin

Browse to the location of the plug-in DLL file
Click on Open.
The new plug-in should appear in the Plug-in Bar Uncategorized category.

Configuring PReS Connect Workflow 8

Reconfigure any settings that may need to be applied to the PlanetPress Suite
Messenger and PlanetPress Workflow Tools LPD services using the Access Manager
(see http://help.objectiflune.com/en/PReS-workflow-user-
guide/2021.2/#Workflow/Interface/Access-Manager.html).

All PostScript and TrueType host based fonts must be reinstalled. Make sure you restart
the computer after this step.

If necessary, reconfigure local ODBC connections. (i.e. create local copies of databases
or recreate required DSN entries)

Manually install all external executables that will be referenced by the Connect Workflow
processes in the configuration file. If possible, retain the local path structure as used on
the older installation.
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« Ifthe Windows "TCP/IP Print Server" service is running on the new computer, itis
recommended that you disable the Server so that it does not interfere with the
PlanetPress LPD/LPR services.

« If you are using images from a virtual drive, copy the entire contents of
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PSRIP" and paste them onto the new
computer here: "C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PSRIP".

» Make sure to set the user who will run the PlanetPress Services. This is done by going
into Tools/Configure services. The user will need to have local administration rights in
order to be able to run the services.

For more information, see Users and Configurations
(http://help.objectiflune.com/en/PReS-workflow-user-
guide/2021.2#Workflow/WorkflowServices/Users_and_Configurations.html).

« Once all these steps have been completed, you will need to import your configuration file.
Find the latest pwX file located on the old computer, if it is not already copied across to
the new computer. The default location on the old computer is “C:\ProgramData\Objectif
Lune\PlanetPress Suite 7\PlanetPress Watch\’.

On the new computer you will need to go to File > Import > Configuration Components.
Browse and find your file. If the file is not visible change the file type to *.pw7

PlanetPress Image, Fax and Search

« Reconfigure the PlanetPress Image and PlanetPress Fax outputs with the new host
information.

« You mustimport the Search Profile and rebuild the database in order to generate the
required database structure.

PlanetPress Capture

« If you have a Capture Solution, please see "How to perform a Capture migration" below.

How to perform a Capture migration

This page provides information on how to conduct a proper migration of a Capture solution. For
information about Capture see: http://capture.objectiflune.com/en/howitworks.

These steps must be executed after a proper Workflow Migration has been completed.
Instructions on how to do such can be found here: "How to perform a Workflow migration" on
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Failure to do so will result in unexpected problems.

Note

Itis recommended that you first update your PlanetPress Suite to version 7.6 before
cross-grading to PReS Connect.

Using PReS Connect Workflow 2021.2 on the same computer as PlanetPress Suite 7.6

Steps to migrate:

1. Update existing installation to PlanetPress Suite version 7.6 if not already done.
2. Install PReS Connect Workflow 2021.2 on the same computer.
3. Do the following for both PlanetPress Suite version 7.6 and PReS Connect Workflow 8.

1. Open Workflow Service Console. This can be done either via the Windows Start
Menu, or from within Workflow Configuration application (via menu option Tools
> Service Console).

2. Select Messenger in the tree list, right click and select M Stop from the context

menu.

Note

These steps must be done for both PlanetPress Suite Workflow 7 and PReS
Connect Workflow 8.

4. Copy the file PPCaptureDefault.mdb from this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\capture"
to this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\capture" and
overwrite the existing database.
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Note

Prior to PlanetPress Suite 7.6, all Capture patterns, documents and several other
details were contained within the one single database. As of PlanetPress Suite 7.6
a separate database has been used for the patterns alone
(PPCaptureDefault.mdb).

5. Copy the contents of this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress
Watch\DocumentManager"
to this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\DocumentManager".

6. Copy the contents of this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\PGC"
to this folder:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\PGC"

7. Restart the PReS Connect Workflow 8 Messenger. To do this,

1. Open Workflow Service Console. This can be done either via the Windows Start
Menu, or from within Workflow Configuration application (via menu option Tools
> Service Console).

2. Select Messenger in the tree list, right click and select p Start from the context
menu options.

8. Contact your local Objectif Lune activation team and transfer any Pen(s) licenses across.

Using PReS Connect Workflow 2021.2 on a different computer to PlanetPress Suite 7.6

Tip
Itis safer to migrate outside high peak production since the Capture solution cannot be
run in parallel on two computers.

Once the Capture database has been transferred to the new computer, any update made
to the old computer will be lost unless the steps to migrate are reproduce again.

Once a Pen has been docked and the data transfer done, its memory is wiped, thus




rending the parallel mode very hard to produce. It is not impossible, but describing how it
can be done is beyond the scope of this migration article.

Steps to migrate:

1. Update existing installation to PlanetPress Suite version 7.6 if not already done.
2. Install PReS Connect Workflow 2021.2 on new computer.

3. The Anoto PenDirector must be installed. It if is not, you can download it from
http://www.objectiflune.com/OL/lib/Common/Downloads/PlanetPressCaptureResources/
AnotoPenDirector.zip and then install it.

Note

Itis strongly recommended that you install the latest version of the PenDirector.
Please use the link provided on the previous line.

Do not get any other version of the PenDirector from the Anoto website, as
they will not have been set up correctly for our Capture solution.

Note

Prior to installation, make sure you unplug the Pen docking station from the USB
port on the computer where you are about to install the Anoto PenDirector.

4. Do the following for both PlanetPress Suite version 7.6 and PReS Connect Workflow 8.

1. Open Workflow Service Console. This can be done either via the Windows Start
Menu, or from within Workflow Configuration application (via menu option Tools
> Service Console).

2. Select Messenger in the tree list, right click and select M Stop from the context

menu.
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Note

These steps must be done for both PlanetPress Suite Workflow 7 and PReS
Connect Workflow 8.

5. Copy the file PPCaptureDefault.mdb from this folder on the PlanetPress Suite 7.6
computer:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\capture"
to this folder on the new PReS Connect Workflow 2021.2 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\capture" and
overwrite the existing database.

Note

Prior to PlanetPress Suite 7.6, all Capture patterns, documents and several other
details were contained within the one single database. As of PlanetPress Suite 7.6
a separate database has been used for the patterns alone
(PPCaptureDefault.mdb).

6. Copy the contents of this folder on the PlanetPress Suite 7.6 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress
Watch\DocumentManager"
to this folder on the new PReS Connect Workflow 2021.2 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress
Watch\DocumentManager".

7. Copy the contents of this folder on the PlanetPress Suite 7.6 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Suite 7\PlanetPress Watch\PGC"
to this folder on the new PReS Connect Workflow 2021.2 computer:
"C:\ProgramData\Objectif Lune\PlanetPress Workflow 8\PlanetPress Watch\PGC"

8. Restart the PReS Connect Workflow 8 Messenger. To do this,

1. Open Workflow Service Console. This can be done either via the Windows Start
Menu, or from within Workflow Configuration application (via menu option Tools
> Service Console).




2. Select Messenger in the tree list, right click and select p Start from the context
menu options.

9. Contact your local Objectif Lune activation team and transfer any Pen(s) licenses across.

Server Configuration Settings

This chapter describes configuring the PReS Connect Server.

In PReS Connect you can install Servers on multiple machines, in a Master/Slave relationship.
To see an overview of these Master/Slave setups, please see the "Server Clustering" on

page 114 topic.

The Connect Server settings are maintained by the Connect Server Configuration utility tool
which is installed alongside PReS Connect.

Connect Server Configuration can be launched from the Start Menu, as seen in the following
screenshot:

Objectif Lune

E Connect Designer

' Connect Server Configurati..,

E Connect Software Activation

The Connect Server Configuration dialog is separated into individual pages, where each
page controls certain aspects of the software.

The following pages are available:

« "Clean-up Service preferences" on page 856

« "Connection preferences" on the facing page

« "Security and Users Settings" on page 95 (not available in Server Extension
(Slave) installations)

o "Database Connection preferences" on page 862
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« Engines preferences

« "Automatic Restart Settings" on page 105 (not available in Server Extension
(Slave) installations)

Note

Automatic Restarts are controlled by the main server. Slaves are treated the
same as local engines in regards to restart timing.

o "Hardware for Digital Signing preferences" on page 873

« "Language preferences" on page 106

"Logging preferences" on page 874

« "Parallel Processing preferences" on page 106 (not available in Server Extension
(Slave) installations)

Connection preferences

Background

The Connection preferences are a way to control precisely how to connect to the PReS
Connect Server.

This preference page was added in Connect 2018.2 to simplify management of
HTTP communication with Connect. HTTPS communication options were then added in
Connect 2021 1.

These preferences allow Connect inter-engine communication to occur on an alternate port,
reducing the chances of inter-engine communication being starved of connections when
running on a system that processes very large numbers of HTTP/HTTPS connections.

In PReS Connect, the Connections choices available to you will be dependent upon whether
the PReS Connectinstallation is a Master (or standalone) installation or a Slave installation.

For standalone and Master installations, see "Connection settings (standalone/Master)" on the

next page.
Fro Slave installation see "Connection settings (Slave)" on page 94.
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Connection settings (standalone/Master)

« REST Services group. Use this to adjustthe HTTP or HTTPS communication settings for
Connect.

o Port: Set the primary HTTP or HTTPS Server connection port number for Connect.

o Protocol: Selectwhetherto use HTTP or HTTPS.
IfHTTPS is selected, the following HTTPS specific options become available:

o Root certificate: This is an optional selection. Use the Browse button to
locate the appropriate rooft certificate file, if one is available.

« Server certificate: Use the Browse button to locate the appropriate server
certificate file. This is a mandatory selection.

« Private key: Use the Browse button to locate the appropriate Private key file.
This is a mandatory selection.

« Private key Password: Enter the Private key password.

« Confirm password: Re-enter the password, to confirm it was entered
correctly.

Note

Enabling HTTPS for the primary REST Services connection requires different
ports be used for the internal connections (IPC and REST) between Connect
Server and its engines.

« Internal communication on separate ports checkbox:
Set the internal connection communication ports. These settings are purely for Connect
inter-engine communication.
It is recommended that this option be selected.

Note

IfHTTPS were selected as the REST Services protocol, these internal Port
settings must be entered.
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Note

Please note that local security settings (including firewalls) must be taken into
consideration when setting Port entries.

« IPC Port: Set the internal connection port number. This cannot be the same at the
primary REST Services port number.

o REST Port: Set the internal REST connection port number. This cannot be the
same at the primary REST Services port, or the IPC Port.

« Advanced group

o Maximum threads: Sets the maximum number of HTTP threads for processing
requests.
This entry should only be changed in consultation with OL.

o Maximum queues: Sets the maximum number of requests can remain in the queue.
This entry should only be changed in consultation with OL.

o Maximum asynchronous tasks: Set the maximum number of requests that can be
executed simultaneously.

Note

This does not limit the number of requests that can be received, just how
many are processed in parallel. Additional requests are buffered and are
processed as capabilities allow.

The default asynchronous task setting is twice the number of processing cores
available to the computer. This can be expanded, if the limitation is deemed a
bottleneck.

Connection settings (Slave)

« Master Server group. Use this to set connection to PReS Connect Master server.
« Hostname: Set the device name for the PReS Connect Master server.
o Port: Set the port number for the PReS Connect Master server.

« Username: The account that the services use to login to the PReS Connect Master
server. If the machine is on a domain, use the format domain\username.
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- Password: Enter the password associated with selected username.

« Initial retry interval (secs): The retry interval when initially trying to connect (or
reconnect) to the PReS Connect Master server.

« Prolonged retry interval (secs): The retry interval for trying to connect (or
reconnect) to the PReS Connect Master server after the initial retry limit period has
been exceeded.

« Initial retry limit (mins): How long the initial connection (or reconnection) attempts
should run for.

Buttons

The Connections preferences also provides you with buttons to :

« Test Connection. This button is available only on PReS Connect Slave installations.
When the button is pressed an attempt is made to connect to the PReS Connect Master
server, using the location, user name and password set in this preference page.

If the connection is successful, a confirmation message is displayed in the top area of the
preferences page.

If the test fails, a warning message is displayed in the top area of the preferences page.
Set logs for further information.

» Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.

« Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

Security and Users Settings

This dialog controls the security settings for external applications connecting to the PReS
Connect Server, such as PReS Connect Designer, PReS Workflow plugins, or scripts
communicating through the REST APIL.

Warning

Itis highly recommended to keep security enabled and change the password on any
server accessible from the web. If these precautions are not taken, data saved in the
server may be accessible from the outside!

- Enable server security: Enable to add authentication to the REST server.
- When enabled, the username and password (which cannot be blank) of an authorized
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user must be entered in any remote Connect Designer that links to this Server. See the
"Connect Servers preferences" on page 881 sub-section of the Designer Preferences
dialog.

- When disabled, a username and password is not required to make REST request, and
tasks in PReS Workflow do not require them in the Proxy tab. Nor would a username and
password be required on any remote Connect Designer that links to this Server.

« Session expiration time (mins): Select a session time (in minutes, between one minute
and one year) that the authentication stays valid for the requested process. This can
reduce the number of requests to the server since an authentication requestis not
necessary during the session.

« Authorized Users table: The Table contains a list of all currently Authorized Users.
All required information is summarized in the table, which has buttons to the right which
allow one to Add ( L:;.)’ Edit () or Delete ( I:;1) individual entries. Double clicking on any

entry in the table also launches the Edit dialog.

The options available in the Add/Edit dialogs are as follows:
« Username: Enter the username for the server security.
« Roles: Check the roles that apply to the user.

. Data Handler: The user can start and stop operations, get results of
operations, and view and handle data (except resources). This appears as
ROLE_DATA in the table.

« Resource Handler: The user can manage resources like data mapping
configurations, templates, and print presets. This appears as ROLE_
RESOURCE in the table.

« Monitoring: Can monitor the server, but cannot see data, change server
settings, or modify resources.This appears as ROLE_MONITOR in the table.

« Password: Enter a password for this user for the server security. There are no
specific password requirements or restrictions.

« Confirm password: Re-enter the password assigned to this user.

Note

Existing client sessions are not affected by changes to authorized users. Clients may only
see the effect after their session expires.




Engine configuration

The Connect Server cooperates with different engines to handle specific tasks. A DataMapper
engine extracts data from a data file. A Merge engine merges the template and the data to
create Email and Web output, or to create an intermediary file for Printed output. The
intermediary file is in turn used by a Weaver engine to prepare the Print output. (For more
information see: "Connect: a peek under the hood" on page 133).

Settings for these engines are made in the Connect Server Configuration tool (see "Server
Configuration Settings" on page 91).

Connect allows for the parallelization of jobs. This means you can allocate 1 or more engines
to process jobs.

The number of each type of engine - on each machine in a Server Clustering setup - is
configurable, as well as the amount of Merge engines than can work together on the same job
(determined by job size: small, medium or large) and at what maximum speed.

The "Parallel Processing preferences" on page 106 allow you to control precisely how the
PReS Connect Connect Server handles jobs.

This gives you, as solution developer or application manager, full control of how to apply a
machines power. For example, you can share the available resources to process multiple jobs
at once or allocate all resources to process one single job as fast as possible, or anything in
between.

Connect distinguishes 5 type of jobs:

Small Print
Medium Print
Large Print
Email

Web

o bh =

Connect categorizes print jobs on the number of pages they will produce. What constitutes a
Small, Medium or Large job can be configured per server (see below, in "Allocating
processing power to jobs" on page 101).

There is no distinction between small, medium and large jobs for Email and Web output.
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This topic explains all of these settings and the principles behind them, and it provides
guidelines for letting the Server manage the workload in such a way as to achieve the highest
possible output speeds.

Factors to take into account are:

« Your licence, which imposes a speed quota (see "Speed quota: Pages Per Minute"
below).

« The processing power of your machine. How many cores it has determines how many
engines can be launched (see "Launching multiple engines" on the next page).

« The size and number of jobs of one kind that need to be handled, sequentially or
simultaneously. In other words, your use case. By allocating processing power to jobs of

different sizes you can make the setup match your usage situation (see "Allocating
processing power to jobs" on page 101).

Tip
Other ways to enhance performance are described in another topic: "Performance
considerations" on page 27.

Speed quota: Pages Per Minute

The highest possible output speed depends first and foremost upon your licence.

With no Performance Pack, in PReS Connect, one engine can generate output at 625 PPM
(Pages and emails and web pages - Per Minute). Additional Performance Packs increase this
quota.

The number of engines that are allowed to operate in parallel to create the same type of output
are referred to as the Licensed task limit.

PReS Connect provides 16 Licensed tasks. Additional Performance Packs will increase this
number.

So, with no Performance Pack, up to 16 engines can create the same type of output in parallel,
which means the total maximum output speed is 10,000 PPM per output type (Print, Email,
and Web).

One engine needs at least one free speed unit to be able to create output.

It is important to note that only output operations are limited by this quota.
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- Weaver engines always require a Licensed task to run.

« Merge engines only require a Licensed task when creating Email or Web output. Merge
engines involved in a Print process don't need a Licensed task in order to run.

- DataMapper engines don't need Licensed tasks.

In situations where Print and Email and/or Web output are created at the same time, only the
Merge engines that create Email/Web output count towards the maximum number of Licensed
tasks for that type of output.

Spare speed units are distributed proportionally

Since the number of engines is configurable, and jobs may run concurrently, the number of
engines in use may not match the exact number of available Licensed tasks.

When there are more Licensed tasks than there are engines in use, the Connect server
distributes the speed units and the maximum 'pages' per minute to all running jobs in proportion
to the number of engines they are using.

Note

Output speed is the speed at which the output is created by the engine in question. Data
mapping and other steps in a production process are not taken into account. The
throughput speed is the speed of the entire production process. This will always be
lower than the output speed.

Launching multiple engines

One single engine can only process a single job at a time and will run mostly single-threaded.
In order to benefit from multi-core systems it is recommended that several engines run in
parallel.

As a rule of thumb, you will want to run one less engine in total on a machine than the system
has cores, leaving one CPU core free for the Connect Server and the operating system to use.

Modern hardware typically has both full cores and hyper-threading or logical cores. The
logical cores should not be counted as a full core when determining how many engines to use.
As a guide, count logical cores for only 25%-50% of a full core.

For example: on an Intel i7 CPU that comes with 4 cores and 4 additional hyper-threading




cores, Windows Task Manager will show 4 cores and 8 logical processors on its performance
tab. On a CPU like this, 5 or 6 engines can be configured to run in parallel.

To configure the number of engines:

1. Open the Connect Server Configuration utility tool (see "Server Configuration Settings"
on page 91).

2. Under Parallel Processing, go to the Content Creation tab and set the number of Merge
engines for the various tasks.

3. Go to the Output Creation tab and set the Reserved Weaver (Output) engines.
See "Deciding how many engines of each type to launch" below.

4. Click Apply or Apply and Close.

Itis advised that you do not configure more engines than can be backed by actual processing
power. This adds overhead while not adding processing power.

Deciding how many engines of each type to launch

When jobs run in parallel, different types of engines may run at the same time. It depends on
the usage situation which type of engines has the biggestimpact on performance.

The more and the larger operations of a kind need to be performed simultaneously with smaller
operations, the sooner you will see a performance increase when using multiple engines.

Merge engine

Generally, launching a relatively high number of Merge engines results in better performance,
as Merge engines are involved in the creation of output of all kinds (Print, Email and Web) and
because content creation is relatively time-consuming.

DataMapper engine

Adding DataMapper engines might be useful in the following circumstances:

« When large data mapping operations have to be run simultaneously for many jobs.

« When frequently using PDF or XML based input. Particularly in the case of XML input
with large individual records.

« When the All In One plugin is used often in Workflow configurations and there are more
than two Merge engines running.
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The Connect MySQL database needs a fast storage system (SSD or other fast devices) to be
able to keep up with two or more DataMapper engines.

When the database is installed on a system with a slow hard drive, adding a DataMapper
engine may not increase the overall performance.

Weaver engine

Adding extra Weaver (Output) engine(s) might be useful when large Print jobs are to be run
simultaneously with smaller Print jobs.

Memory per engine

By default, each engine is set to use up to a predetermined amount of RAM. To make optimum
use of a machine's capabilities it might be useful to increase the amount of memory that the
various engines can use.

« DataMapper engines may perform better with greater memory when running jobs
containing a lot of data.

« For complex templates with a lot of pages per document, there is a chance that Merge
engines will run better with more memory.

« The maximum memory usage of a Weaver engine can be relevant for jobs with heavy
graphics; or for jobs that use Cut & Stack impositioning; or for jobs using particular
variables that entail page buffering (see "Content variables" on page 1503).

The Maximum memory per engine setting is found in the Engines preferences.

These settings only control the maximum size of the Java heap memory that an engine can
use; the total amount of memory that will used by an engine is actually a bit higher.

Also keep in mind that the Connect Server and the operating system itself will need memory to
keep running.

Allocating processing power to jobs

Which engine configuration is most efficient in your case depends on how Connect is used.
What kind of output is needed: Print, Email, and/or Web? How often? How big are those jobs?
Do they have to be handled at the same time or in sequence? Would it be useful to give priority
to small, medium or large jobs, and/or to jobs of a certain kind?
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Depending on the answers to these questions, you can allocate processing power to jobs in
order to run them as fast as possible, and/or in the order of your preference.

The first step in this process is to define the size of small, medium and large jobs.

Job size

Connect lets you define job sizes by setting the maximum number of pages a job can have and
still be considered a small job, and what the minimum number of pages a job can have in order
to be considered large. Jobs that fall between the small and large jobs are medium jobs.
Defining small, medium and large jobs is important, as you can assign additional resources to
jobs that are considered either medium or large, via the settings for Merge and Weaver
engines.

There is no recommendation regarding what number of pages constitute a small, medium or
large job. Job size is a relative concept: in a small service company a job may be considered
large when it outputs 1,000 pages, whereas that same job in a large insurance company might
be seen as small. This setting needs to be based on an assessment of the actual (or expected)
workload of Connect.

To setthe job sizes:

1. Open the Connect Server Configuration utility tool (see "Server Configuration Settings"
on page 91).

2. Under Parallel Processing, go to the Oufput Creation tab and enter the maximum
number of pages in a small job.

3. Enter the minimum number of pages in a large job.
4. Click Apply or Apply and Close.

Medium jobs will be those that fall between the maximum pages of a small job, and the
minimum pages of a large job.
The number of engines used for small, medium and large jobs is configurable (see below).

Running a job as fast as possible

Number of parallel engines per Print job

Two or more engines of a kind can be combined to work on the same Print job. Generally jobs
will run faster with more than one engine, because sharing the workload saves time.
However, running one job with multiple engines reduces the number of jobs that can be
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handled at the same time by that kind of engine, because there are only so many engines (and
speed units) available.

Note

When each individual record in a job is composed of a very large number of pages, the
Memory per engine setting and the machine's hard drive speed are probably more
important than the number of Merge engines, since one record cannot be split over
multiple machines or even cores (see "Memory per engine" on page 101).

Target speed per Print job

If a Print job of a specific size has more than one parallel speed unit assigned to it, that
multiplies its speed, however it reduces the number of Print jobs that can be run
simultaneously.

When no other Print output operations run at the same time, a single job will use all available
speed, or the maximum target speed reserved for jobs of that size (see "Dividing processing
power over jobs" below).

To set a number of speed units per Print job:

1. Open the Connect Server Configuration utility tool (see "Server Configuration Settings"
on page 91).
2. Under Parallel Processing, go to the Oufput Creation tab.

3. Setthe Target speed when running simultaneous jobs for small, medium and large
Print jobs.

4. Click OK or Apply.

Dividing processing power over jobs

There is a number of ways in which you can divide processing power over output operations of
a certain kind and/or size.

« By reserving engines for jobs of a certain kind (and size, in the case of a Print job). Note
that reserved engines cannot be used by any other type of job. This means there will be
fewer engines to handle other jobs. Consequently, the other jobs may take more time and
may have to wait (or wait longer). However, if the server receives many web requests then
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having engines reserved for HTML output can help performance.

« By reserving a number of parallel engines for Print jobs of a certain size (see "Number
of parallel engines per Print job" on page 102). More parallel engines will make them run
faster, but they will have to wait (longer) if the required number of engines isn't available
when they come in.

» By specifying target speeds for simultaneous Print jobs of a certain size.

All of these engine configuration settings are found in the Parallel Processing Preferences:

1. Open the Connect Server Configuration utility tool (see "Server Configuration Settings"
on page 91).

2. Under Parallel Processing, check out the information contained in both Content Creation
and OQutput Creation tabs.

How the Server decides if a job can be handled

In summary, this is how jobs are handled when they can run in parallel.

o Whenever a job comes in, the number of engines to use is determined. (For Print jobs,
this is based on whether the operation is small, medium or large; see "Job size" on
page 102.)

. Ifthere are enough reserved Merge engines for that type of job available then those
engines will be used.

« Ifthere are not enough reserved Merge engines available, then any unreserved Merge
engine that is available will be used.

« Ifno, or not enough, Merge engines are available then the job will have to wait until the
required number of appropriate Merge engines becomes available.

The following limitations apply at all times:

« The maximum number of concurrent Merge engines working on jobs of the same kind or
size may not be exceeded.

« Ifno - or not enough - speed units are available for that type of output, the job must wait.

Examples

Here are a few examples of use cases and settings that would be appropriate in such cases.
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Batch processing. In a batch processing situation, jobs don't have to be handled
simultaneously. All jobs - whether they are big and small - are processed one after another.
Every job should be handled as quickly as possible. It is therefor recommended to assign the
maximum number of engines and target speeds to all jobs. Do not reserve engines for certain
jobs.

Web requests. In online communication, response times are critical. If the Server receives a lot
of Web requests, it should handle as many as possible, as quickly as possible, at the same
time. It is recommended to launch as many Merge engines as possible and to reserve most of
them for HTML output. The jobs will generally be small and can do with just one Merge engine.

Mixed jobs that are processed in parallel. In a situation where small, medium and large jobs
can come in at any time and should be handled in parallel, the challenge is to find a balance
between how much power can be allocated to jobs (to minimize the time they cost) and how
long they can wait. No single job should require all of the processing power, unless itis
acceptable for it to have to wait until the maximum number of engines finally comes available -
and then all other jobs will have to wait.

Automatic Restart Settings

Itis considered good management to restart the Connect Engines periodically. This dialog
provides the controls for scheduling Connect Engines restarts.

Automatically restart engines to safeguard system availability

« Time Limit checkbox: This enables engine restarts to be scheduled to occur either after a
specified period of time, or within a daily time window.
This means daily Engine restarts can be scheduled to run outside of production hours.

« Rolling restart checkbox: This sets the engines restarts to occur in a "rolling" fashion,
whereby each engine is stopped and restarted individually, one after the other.
Each engine is only stopped when the previously restarted engine is once again ready to
start processing.

« Restart method: Chose between restarting after a specified number of minutes (Restart
after interval) or within a daily time window (Daily restart in period).

« Restart after (minutes): Only available if Restart after interval selected.
Specify the amount of minutes that the restarts are to occur after.
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« Daily restart period begin: Only available if Daily restart in period selected.
Enter the daily start time for the time window in which automatic restarts will be scheduled
to occur.

- Daily restart period end: Only available if Daily restart in period selected.
The end of the daily time window in which the automatic restarts are scheduled to occur.

Memory limit

Enter the memory limit for individual Engines. If any of these memory limits are exceeded, an
automatic restart of those Engine types will be triggered.

« Data Mapper Engine (MB): Enter the memory limit for Data Mapper Engine.
« Merge Engine (MB): Enter the memory limit for Merge Engine.
« Weaver Engine (MB): Enter the memory limit for Weaver (Output) Engine.

Language preferences

» Display language: Select a language from the drop-down list to be used as the language
of the OL Connect Server Configuration tool, and all log files created by OL Connect
Server and its components (after the software/service is restarted).

Parallel Processing preferences

The parallel processing preferences (previously referred to as Scheduling preferences, prior to
2019.2) page provides the means to control precisely how the PReS Connect and Connect
Server (Master or Slave) handles jobs that operate in parallel.

There is considerable difference between the preferences that are available in the Designer
Parallel Processing page and the Server Configuration Parallel Processing page.

« Forthe Designer specific preferences, see "Parallel Processing properties (Designer
Preferences)" on the next page.

« Forthe Server Configuration specific preferences, see "Parallel Processing properties
(Server Configuration)" on page 108.

For additional information on how these preferences can enhance performance, see "Engine
configuration" on page 97 and "Performance considerations" on page 27.
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Parallel Processing properties (Designer Preferences)

Preset selection (Designer Preferences)

Only the Custom setting is applicable to the Designer Preferences, so this option is always
selected and the field made read-only.

Content Creation Tab (Designer Preferences)

A Tab with data that relates solely to Content Creation.
The options are:
. Total Merge engines configured read only display: This is a read only entry that shows

the total number of Merge engines available. To change this value, you must update the
Merge Engines in the Engines preferences page.

« Multi tasking group:
When starting a new Content Creation task, the task will immediately commence if there
is a Merge engine available. How many Merge engines to use is based on the number of
records in the input data.

Select from the following options:

» Optimize per task: This runs each task with as many Merge engines as needed
(until engines are exhausted).
Using this option means that Merge engines will not be reassigned when new tasks
come in.

This option is better suited for batch processing.

« Maximize simultaneous tasks: Merge engines will be reassigned from a running
task to new tasks when they arrive.
To accommodate as many tasks as possible, the server can dynamically reassign
Merge engines to new tasks as they arrive. Thus a running Content Creation task
need not block other tasks.
If multiple Merge engines are processing a task, an engine can be taken from that
task and reassigned to a new task.
As each task finishes, any freed up Merge engines get re-assigned back to still
running tasks, if no new tasks were waiting.

This option is better for on demand (ad hoc) and simultaneous job processing.
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« Additional engine every (records) entry: This controls how many Merge engines
are used for a Content Creation task. It means that for every additional 'x' records in
the task, an additional Merge engine will be used.

For example, with the default 100 record threshold, tasks with 1-100 records will be
assigned 1 Merge engine, tasks with 101-200 get assigned 2 merge engines, tasks
with 201-300 get assigned 3 merge engines, and so on.

Note

These entries aren't applied instantaneously. There is often a lag. Thatis why
you can reserve a specific number of engines for new jobs, in the options
below. Those reservations operate in real time.

The default of 100 records was chosen purely because it is an easily multiplied
number, not because it has been proven to have any significant value. It means that
on an average system (i.e., less than 10 Merge engines) any decently sized task is
allowed to use all Merge engines. It also assumes that using more than one Merge
engine for less than 100 records will probably not make a big enough difference to
throughput speed. Obviously, there are situations where these assumptions will not

apply.

Note

Currently, it's only the print and PDF content creation tasks that use multiple
Merge engines.

Parallel Processing properties (Server Configuration)

These are the options that you will be presented with if the PReS Connect Connect Server was
installed.

Whether options are available for selection on this page or not is entirely dependent upon the
Number of engines selection made in the Engines preferences page. If either of the Merge
Engines or Weaver Engines were set to a value beyond one, then options will become
available in this Parallel Processing properties page.

Preset selection (Server Configuration)

Choose from some common usage scenarios. The preset scenarios are:
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« Default - Basic settings that are good for running most things. Single jobs have preference
over multi-tasking, however.

« Batch Print - Best settings for processing jobs, one by one, in a sequential, first in first out
(FIFO) order.

o On demand Print - Best settings for processing many small print jobs simultaneously.

« On demand - Use when serving web pages, sending emails, and printing many on
demand jobs simultaneously.

« Connect Send - Settings optimized for use with Connect Send.
Connect Send needs a Merge engine available for on demand web pages, to be able to
process on demand print jobs (especially content creation), and have a Weaver engine
available for creating the production output.

« Capture on the Go - Settings optimized for use with Capture on the Go applications.
Capture on the Go needs on demand content creation for web pages (the forms), emails
(notifications), and PDFs (persistent version of forms).

« Custom - where you can chose exactly where and how the engines are to be assigned.

Note

We would recommend basing any Custom settings on one of the preset scenarios.
Select the preset that most closely matches your day to day needs, then tweak
those settings.

Only the Custom setting allows you to manually set where and how the engines are to be
assigned. If selected, then options for Content Creation and Output Creation will become
available under the two Tabs named thus.

Content Creation Tab (Server Configuration)

A Tab with data that relates solely to Content Creation.
The options are:

« Total Merge engines configured read only display: This is a read only entry that shows
the total number of Merge engines available. To change this value, you must update the
Merge Engines in the Engines preferences page.

« Multi tasking group:
When starting a new Content Creation task, the task will immediately commence if there
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is a Merge engine available. How many Merge engines to use is based on the number of
records in the input data.

Select from the following options:

« Optimize per task: This runs each task with as many Merge engines as needed
(until engines are exhausted).
Using this option means that Merge engines will not be reassigned when new tasks
come in.

This option is better suited for batch processing.

« Maximize simultaneous tasks: Merge engines will be reassigned from a running
task to new tasks when they arrive.
To accommodate as many tasks as possible, the server can dynamically reassign
Merge engines to new tasks as they arrive. Thus a running Content Creation task
need not block other tasks.
If multiple Merge engines are processing a task, an engine can be taken from that
task and reassigned to a new task.
As each task finishes, any freed up Merge engines get re-assigned back to still
running tasks, if no new tasks were waiting.

This option is better for on demand (ad hoc) and simultaneous job processing.

- Additional engine every (records) entry: This controls how many Merge engines
are used for a Content Creation task. It means that for every additional 'x' records in
the task, an additional Merge engine will be used.

For example, with the default 100 record threshold, tasks with 1-100 records will be
assigned 1 Merge engine, tasks with 101-200 get assigned 2 merge engines, tasks
with 201-300 get assigned 3 merge engines, and so on.

Note

These entries aren't applied instantaneously. There is often a lag. That is why
you can reserve a specific number of engines for new jobs, in the options
below. Those reservations operate in real time.

The default of 100 records was chosen purely because it is an easily multiplied
number, not because it has been proven to have any significant value. It means that
on an average system (i.e., less than 10 Merge engines) any decently sized task is
allowed to use all Merge engines. It also assumes that using more than one Merge
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engine for less than 100 records will probably not make a big enough difference to
throughput speed. Obviously, there are situations where these assumptions will not

apply.

Note

Currently, it's only the print and PDF content creation tasks that use multiple
Merge engines.

« Reserve engines for on demand tasks group checkbox:
Reassigning engines is not instantaneous when a new task arrives. To avoid
inefficiencies, Merge engines will first finish work on their current selection of records,
before being reassigned. Reserving engines better ensures that on demand tasks get
picked up right away, but it also means that less engines will be available for large tasks.

The total amount of Merge Engines available for selection here must be setin the
Engines preferences page.

Select from the following options:
- Email (engines): Set the amount of Merge engines to reserve for Email jobs.
« Web (engines): Set the amount of Merge engines to reserve for Web based jobs.

« Printand PDF (engines): Set the amount of Merge engines to reserve for Print
output jobs.

- Merge engines available for any task: A read only value that shows how many
Merge engines remain available for selection.

« On demand task size limit (records): An on demand task is a task that has
someone (or something) waiting for it to finish, so these typically need to finish “as
soon as possible”. Often these are single documents but not necessarily always.
This option allows you to designate what a Content Creation on demand task is,
based upon the number of records.

Output Creation Tab (Server Configuration)

A Tab with data that relates solely to job Output Creation.

If only the single Weaver Engine is configured in the Engines preferences page, then this
whole tab will be disabled.
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« Licensed speed limit (pages per minute): This read only entry shows the current
license speed limitations, in pages per minute. The speed limitations are determined by
your Connect license.

This information is to help you choose what settings would make sense when assigning
the “Target speed’ values later in the Tab.

« Licensed tasks limit: This read only entry shows the current license task (or job)
limitations.

Note

The terms "job" and "task" can be used interchangeably.

» Total Weaver engines configured: This read only entry shows the total number of
Weaver engines available. To change this value, you must update the amount of Weaver
Engines in the Engines preferences page.

Job sizes group:

These two settings allow you to define what type of jobs are to be considered Small jobs and
what types are to be considered Large. Any job that falls between these two settings (if there is
a gap between the two) will be considered a Medium job.

« Small job max (pages): Enter the maximum number of pages a job can have and still be
considered Small.

« Large job max (pages): Enter the minimum number of pages a job must have before it is
considered to be a Large job.

Reserved engines group:

These settings allow you to reserve some Weaver (Output) engines for small and medium
Output Creation tasks. This it to prevent large jobs from using all available engines and
blocking small or medium jobs from running. Since Weaver engines cannot switch tasks, such
behaviour can only be achieved through reserving engines for small and/or medium jobs.

Engines may be reserved both for small, and for medium sized jobs. Engine reservations are
not required for either though.

- Small job (engines): Optionally enter the number of Weaver engines you wish to reserve
for Small jobs.
To make sure large batch jobs get sufficient speed during Output Creation, set a lower
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target speed for small jobs, this will automatically allow more for the large and medium
jobs.

o Medium job (engines): Optionally enter the number of Weaver engines to reserve for
Medium jobs.

« Total Weaver engines configured: This read only entry shows the number of Weaver
engines still available. This is the Total engine count, minus the number of engines
assigned to both Small and Medium jobs.

To change this value, you must update the total amount of Weaver Engines in the
Engines preferences page.

Target speed when running simultaneous jobs group:

If a single Output Creation task is running, it will be run at the full speed in the license. But
when multiple tasks run in parallel, this speed has to be divided between them. By default, the
maximum speed will be divided equally between tasks.

Use these settings to override what speed (in Pages Per Minute) should apply for each type of
job. This allows you to prioritize one or more type of job above the others. For example, if your
production process normally handles lots of small jobs, you might want to provide the smaller
jobs greater speed (throughput) than the less frequent Medium and Large jobs.

But if there are so many small jobs that they start limiting the throughput of larger jobs? If there
is always at least one small job running, then the maximum speed for the larger job will stay at
half of the licensed limit. In this case, you might want to increase the target speed for Large
jobs.

There are no hard and fast answers as to what settings will work best. It will likely be a matter of
trial and error. But many sites will not need to change speed settings at all.

The options are:

« Small job (PPM): Enter the target speed for Small jobs, in Pages Per Minute (PPM).
o Medium job (PPM): Enter the target speed for Medium jobs, in Pages Per Minute (PPM).
« Large job (PPM): Enter the target speed for Large jobs, in Pages Per Minute (PPM)

The entire licensed speed limit will always be distributed among jobs when running jobs
simultaneously.

After assigning a target speed, any remaining licensed speed will be distributed throughout any
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simultaneous jobs by a ration of the target speed.
Some general rules of thumb to apply when distributing target speed:

m Do you need to change speeds? In many cases there will likely be no need to change the
target speed.

m The target speed is not a guaranteed actual speed, but a speed limit that the engine is
allowed to exceed in order to utilize the licensed speed.

m When changing the target speed, don’t be overly precise, you are unlikely to get that
exact value anyway. It will likely be a matter of trial and error.

m As long as you don’t overdo it, the actual speed limit for a task will usually be higher than
the target speed.

m If there is a chance of not getting the target speed, you will see a warning in the
preference page. This is just a warning, and nothing will break if you choose to ignore it.

Buttons

The Parallel Processing preferences also provides you with buttons to :

» Restore Defaults. This option restores the preferences to Defaults. This applies to the
current Preferences page only, but not other Preferences.

« Apply: This option applies the settings made within the current Preferences page, but
does not close the Preferences dialog.

Server Clustering

Server Clustering, available in PReS Connect, enhances the processing capabilities of PReS
Connect Server by load-balancing jobs between the main Server module (master) and one or
more Server Extension installations.

Setting up Server Clustering requires two or more installations of PReS Connect on separate
machines.

The Master server is setup by installing the PReS Connect Server module during the
"Installation Wizard" on page 38, while any Slave Servers are setup by installing the PReS
Connect Server Extension module instead.
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Quick Howto

1. Install the Master server (PReS Connect Server module), making sure to select the
MySQL module.

Grant access to the MySQL root user for the appropriate IP range on the Master server.
Restart the MySQL Service on the Master server.
Install Slave servers (PReS Connect Server Extension module).

Install the license on the Master server (a Performance Pack license is required).

o a bk wbd

Set the preferences for the engines (see "Engine configuration" on page 97) on both the
Master and Slaves.

7. Install the license on the Slave servers.

8. Restart the Master server then, once restarted, restart the Slave servers.

What if MySQL is not on the Master server?

Itis possible to setup clustering with a MySQL instance thatis on a Slave server instead of on
the master. In this case, the Slave server must be installed with the Server Extension and
MySQL modules, the MySQL instance configured (steps 2-4 above) then the master and other
slaves can be installed. The remainder of the instructions remain the same.

It is also possible to setup clustering with MySQL being installed completely separately from
PReS Connect, such as using an existing MySQL instance. In this case, the instructions for the
bind address must be followed, but the user does not have to be root. A user for MySQL must,
however, be created and have full access (GRANT ALL PRIVILEGES) to a database called
"objectiflune" that can be created before Connect is installed.

Binding and Root access on the Master server

« The MySQL server's binding must be set to accept connections from the slave servers.
To do this,open C:\Program Files\Objectif Lune\OL
Connect\MySQL\my. ini in a text editor and change the line bind-address=
127.0.0.1t0bind-address=0.0.0.0.

Once the changes have been made and saved you need to restart the MySQL services.

« Access must be granted to the root user on the IPs from which the Slave server will
connect.>

o Open a Command Prompt in the following folder:
C:\Program Files\Objectif Lune\OL Connect\MySQL\bin
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Note

Navigate to the folder, SHIFT+Right-click and select "Open a command
prompt here"

« Type in the following command to connect to the database, where <password> is
your MySQL password. (This password is the MySQL root password entered as part
of Connect installation process. It had to be at least 8 characters long and contain
mixed case characters, numeric digits and a punctuation character):
mysgl --user=root --password=<password> objectiflune

You should see the prompt become mysqgl>.

« Here, type the command to allow the "root" user to be accessed from a specific IP
subnet range.

For example, to accept communication on 192.168.*.*, use:

GRANT ALL PRIVILEGES ON objectiflune.* TO
'root'@'192.168.0.0/255.255.0.0" IDENTIFIED BY 'password';,
where password is the one provided during installation. ( ref:
http://dev.mysql.com/doc/mysql-security-excerpt/5.5/en/adding-users.html)

Tip
IP Subnets understanding is beyond the scope of this documentation. If you want to learn

more, please see the Subnetwork article on Wikipedia
(http://en.wikipedia.org/wiki/Subnetwork).

Clustering Preferences and Setup

When Server extensions are installed and connected to a Master, the following options and
settings change in availability or behaviour:

« The "Clean-up Service preferences" on page 856 requires special configuration on
Clustering setups:

« Clean-up service should not run simultaneously on all machines (staggered clean-
up).
Doing so may cause jobs not to be processed since all servers are busy.
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« Only the machine where the MySQL Server product is installed should attempt to
clean-up database items. Essentially servers that do not have MySQL should only
run Orphan File Clean-up.

Known Issues
This page lists important information about issues that apply to PReS Connect 2021.2.

Dynamic tables causing issues

In some specific circumstances the dynamic tables feature does not behave correctly. The
following scenarios should be avoided to prevent subsequent issues with the template:

o Using page-break-before:always on the top TR of a TBODY causes a problem and
results in a pagination error

« ltis possible to specify conflicting attributes on a TR element:
e page-break-before:always Of page-break-after:always combined with data-repeat

e page-break-after:always combined with page-break-before:avoid on the next
sibling TR (or similar combinations)

These issues will be addressed in a later PReS Connect release.
DataMapper: Automatic Date/Time does not work with certain negative UTC time
zone offsets

The new "Automatic" date parsing option in the DataMapper cannot parse dates with negative
UTC time zone offsets of non-zero minutes.

For example: 2021-03-01T10:00-03:00 will work, but 2027-03-01T10:00-03:30 will not.
Positive time zones with non-zero minutes (such as +70:30) are unaffected.
The negative time zone offsets affected are: UTC -02:30; -03:30; -04:30 and -09:30

This issue will be fixed in a later release. In the meantime, the workaround is to use “Custom” or
“ISO8601” date parsing options in DataMapper.
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CSS inlining colour values now converted to RGB

As of PReS Connect 2021.2 when using the CSS inlining mode "Apply CSS properties on
elements" for emails, all colour values are now converted to RGB, rather than to HEX.

Issues running Connect on Hyper-V 9.0

Some customers have reported difficulties running PReS Connect on Hyper-V version 9.0. In
some instances PReS Connect cannot install and in others the PReS Connect Server service
sometime stops with a signature error.

To resolve these issue we recommend downgrading to Hyper-V version 8.0 where these
issues are not reported.

Minor font changes

As of Connect 2021.1 we no longer round fonts to pixel size. This can lead to tiny differences in
the output (of 1-2 pixels) when compared to earlier versions.

Installation warnings regarding Cloud License service

Upgrades of PReS Connect from 2020.2 or 2021.1.0 to PReS Connect 2021.1.1 can
sometimes throw the following warnings:

WARN [ModalContext] com.objectiflune.installer.ui.actions.InstallAction.a(InstallAction.java)
Failed to register the OL Cloud Licensing Service

WARN [ModalContext]
com.objectiflune.installer.ui.actions.AbstractProvisioningAction.logSoftError
(AbstractProvisioningAction.java) Could not install Cloud License service

These warnings can be safely disregarded as the installation will still fully complete, thereafter.

Changed Omit Master Page Back behaviour

In versions of Connect prior to 2020.2, if a page had no content except for a linked DataMapper
background, then Connect would consider it an "empty" page when determining whether or not
to "Omit Master Page Back in case of an empty back page" (available as an option in the sheet
configuration of a section). This has now been fixed in Connect 2020.2, and such pages are no
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longer considered empty.

This could impact on the output from existing templates.

Print Wizard Preview showing some Landscape mode jobs in Portrait mode

Print jobs featuring an associated Connect "Output Creation Presets" on page 1492 which
have "Imposition options" on page 1268 set to Landscape will not Preview in Landscape, but
rather in Portrait mode. The printout is unaffected, however.

Issues associating PDF files with Connect

Under certain circumstances, Connect Setups prior to 2019.2 would fail when attempting to add
the "Enhance with Connect" association with PDF files. This would then cause the setup to
appear to fail.

Whilst this issue has been fixed in the Connect 2019.2 installer, if a user had previously
experienced the issue and temporarily worked around it to complete the installation, then the
Connectinstaller will fail on upgrade or uninstallation.

To get around this, a manual uninstall is required, or a modification to registry entries.

Issues when loading some Workflow plugins for the first time

Under some circumstances, certain of the new Workflow plugins introduced with Connect
2019.2 will fail to load correctly when run for the first time. Instead of opening the plugin dialog
as expected, the plugin hangs and displays a message thatitis "Loading Ul ....". This is due to
an issue with a third party library which will be addressed in a future release.

To get around the problem, please close and reopen the plugin. The problem only occurs on
the initial opening, and should work fine thereafter.

The license update introduced in OL Connect 2019.1 does not cater for
existing AFP input licenses

AFP Inputis an add on option for OL Connect licenses. Unfortunately, the update to the 2019.1
version of the OL Connect license does not cater for existing AFP input licenses.
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If you have an existing AFP input license we ask that you contact your local Customer Care
team after the initial license update is complete and have them add the AFP input option back
into your license. (See (https://www.objectiflune.com/WebActivationManager/Carelnfo.aspx.)

The Connect Print Manager is a standalone Connect tool thatis used in production sites to
manage print jobs. It can be installed and run on standalone machines without a Connect
license.

The Update Client for Connect 2019.1 looks for a Connect license as part of the update
process, but it will not find one on standalone Connect Print Manager installations. As a result
the Update Client will not recognize that there is a Connect update available to the Print
Manager machine.

In order to update Connect Print Manager to version 2019.1 you will need to download the
Connect 2019.1 installer outside of the Update Client. The Connect 2019.1 installer can be
downloaded from the Web Activation Manager site. See
https://www.objectiflune.com/webactivationmanager/. Or you could ask your local
Administration for the installer, as it would likely already have been downloaded for installation
by the document designers.

Page break changes in 2019.1

Improved page breaking in Connect 2019.1 might impact upon some existing templates.
It is recommended that you check page breaking in existing jobs, where page breaks at a
specific location are a known criteria.

Minor differences in AFP and IPDS output introduced in 2019.1

Connect 2019.1 now defaults to "Scale to Fit" for both IPDS and AFP output.
Please note that this may have an impact when printing pre-existing Connect jobs (made in
Connect versions predating 2019.1) on older printer models that do not support "Scale fto Fit".

Issue with image placement in 2019.1 when using some customized AFP and
IPDS Printer Definitions
An issue with image placementin Connect 2019.1 AFP and IPDS output was discovered just

prior to the release. The issue is specific to AFP and IPDS 600 DPI Printer Definitions that are
not set to "Scale to Fit".
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As "Scale to Fit" is now switched on by default in all standard Connect 2019.1 AFP and IPDS
Printer Definitions, none of those should encounter the issue.

This issue will be fixed in a subsequent patch release.

Issue after erroneous or incomplete update or re-installation

If one or more products (the Connect Designer, Connect Server, Software Activation, Print
Manager, or Server Configuration Tool) or engines exit within a second of starting, this may be
caused by a recent erroneous or incomplete uninstall before a reinstall or upgrade to a newer
version of OL Connect. (See Product or engine exits within a second of starting in Connect's
Knowledge Base: http://help.objectiflune.com/en/kb-connect/#KB/FAQ/OL
Connect/KB2019.htm.)

This may be solved by deleting the suserProfile%\Connect\.eclipse directory.

For guidance on a full manual uninstallation please see the Solution in: Problems during a
Connectinstallation or version upgrade in Connect's Knowledge Base:
http://help.objectiflune.com/en/kb-connect/#KB/FAQ/OL Connect/KB2002.htm.

Backend database might require periodic maintenance

Databases maintain a variety of statistics in order to optimize performance. When high levels of
inserts and/or deletions occur, the statistical data keeping can struggle to keep up. Over a
period of prolonged and intensive processing this can resultin a degradation in performance,
with the whole database slowing down as it struggles to clean itself up.

In Connect terms the effect can be felt as the Data Mapper and/or Job Creation progressively
slowing down.

To cure this issue, it is recommended that you periodically run manual maintenance on the
backend database.

If using MySQL, the following script should be run in a query window:

set @a=null, @c=null, @b=concat ("show tables where",ifnull (concat ("
"Tables in ",database(),"  1like '",Qc,"' and"),'')," (Qa:=concat ws
(',',Q@a, Tables in ",database()," ))");

Prepare "bd’ from @b;
EXECUTE “bd’;
DEALLOCATE PREPARE "bd’;
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set (@a:=concat ('optimize table ', Qa);
PREPARE “sgl° FROM (@a;

EXECUTE "sqgl;

DEALLOCATE PREPARE “sqgl ;

set @a=null, @b=null,@c=null;

If using Microsoft SQL Server run the following command in a query window:

sp_updatestats

Windows 10 Search service impacting Connect

The Windows 10 Search service runs as a background task, indexing files and folders. It has
been noted that this background task is sometimes preventing files being added to the Connect
temporary files folder when large amounts of files are being output and copied.

If this is an issue for you, we suggest disabling Search Indexing on the
C:\Users\<username>\Connect folder.

This issue will be fixed in a later release.

Job Creation Presets: External Sorting change introduced in 2018.2

Versions prior to 2018.2 did not correctly save the line end characters for external sort
configurations in Job Creation Presets, which meant the job could not be externally sorted. This
issue has been fixed in version 2018.2. However, Job Creation Presets created with an earlier
version may still have the wrong line end character for external sorting. To fix this, open the Job
Creation Preset in the new version, reset the line end setting in the sorting options and then
save the preset.

Engine Preferences: Backward Compatibility Issues introduced in 2018.2

« Priorto version 2018.2 Connect allowed a mixture of internal and external engines. As of
PReS Connect 2018.2 this is no longer allowed.

When upgrading to PReS Connect 2018.2 from such installations, the pre-existing
settings will not only no longer apply, but can cause scheduling preference conflicts for
the Merge and Weaver engines.
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To fix this, any pre-existing Connectinstallation that was running a mixture of internal and
external Merge and Weaver Engines must first restore their scheduling preferences to the
default values. This can be done by clicking on the Restore Defaults button in the
Scheduling pages of the Server Preference or the Designer Preference dialogs.

« The Designer's scheduling settings are only updated correctly for the user actually
performing the update.

Business Graphics: Backward Compatibility Issues introduced in 2018.1

As a consequence of changes in both the user interface and the underlying technology,
Business Graphics made with a version prior to PReS Connect 2018.1 may not display
correctly when opened in version 2021.2.

The currently known backward compatibility issues are listed here:

All charts

« Legend position: The position of the legend is not converted. It defaults to 'left' in a
converted chart.

« Rows are series/Columns are series: Only one type of data structure for detail tables is
supported in the new version: the one that corresponds to the former Columns are series
setting (with which charts display one series per record, one bar/point per data field). After
conversion to 2018.1, charts that used the Rows are series setting will be displayed as if
the Columns are series setting were used. Pie charts will thus only show data from the
first record in the detail table. If the number of records in the detail table remains
consistent, then the charts can be corrected by modifying the data mapping configuration
(see "Preparing a data table" on page 711 in the Online Help:
https://help.objectiflune.com/en/PReS-connect-user-guide/2021.2.). Otherwise the data
needs to be transposed via script.

« NOTE: Expanded custom chart scripts cannot be converted.
Pie charts

« Default colors: The default colors (used when no pie chart colors are specified) have
changed.

Line and Bar charts

« Legend label: In previous versions, the name for a values series (needed for the legend)
could only be taken from a field outside the detail table. The value of the selected field
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would be used. Setting a different label required expanding the chart script. After
conversion, the name of the field is used instead of the value. Setting a different label can
now be done in the Edit Chart Script dialog (see "Selecting data for a Business Graphic"
on page 710 in the Online Help: https://help.objectiflune.com/en/PReS-connect-user-
guide/2021.2.

Known Font issues

The following font(s) are known to have issues in PReS Connect 2021.2:

« Benton Sans CFF font

Minor differences in PCL, AFP and IPDS output introduced in 2018.1

The browser component (Mozilla Gecko) used in the WY SIWY G editor of the Designer was
updated for Connect 2018.1. This allows use of new CSS properties, such as flexbox.

However this update could lead to increased output file sizes for some PCL, AFP and IPDS
jobs. This is generally not a cause for concern, however there might be some associated
increase in processing times, as well as some minor differences in the output. For example,
table line widths and font spacings might differ slightly (particularly for SMALL CAPS text),
which could lead to slightly different word-wrapping in some circumstances.

Windows Server 2016 issue
As of PReS Connect 2018.1 Connect is officially supported under Windows Server 2016.

Please note, however, that the Objectif Lune Inc. Update Client application might be blocked
by the enhanced security settings in Windows Server 2016.

To fix this, add http://Jupdates.ca.objectiflune.com to the list of trusted web sites on that machine,
or lower the internet access rules.

Limit of 100MB of image files within a single job

The browser component (Mozilla Gecko) used in the WY SIWY G editor of the Designer was
updated for Connect 2018.1. This allows use of new CSS properties, such as flexbox.
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However this update also introduced a limit of 100MBs for image files included within a single
job. The limitis set at 100MB deliberately, as this allows most jobs to run faster. However, if a
job requires more than 100MBs of image files, then the Connectimage cache size can be
increased to cater for such.

Please contact OL Support for instructions on how to modify the image memory cache value, if
needed.

Print Output: Booklet Impositioning changes introduced in 2018.1

When Booklet Impositioning is enabled, all pages within a document need to be changed to
duplex prior to Impositioning . The method for duplexing jobs has been changed to now always
combine existing pages into the front and backsides of sheets, rather than adding empty
backsides to any simplex pages.

The result is that now every document in the job becomes a booklet without any empty pages
between the first page and the last page.

With some exceptions. Booklet Impositionings that require a multiple of 4 pages (Saddle
binding and Perfect binding) will still get empty pages added, when needed.

Memory usage in clustered environments

If Database Petitioning is not selected, then PReS Connect can fill the database faster than the
Clean-up service can clear it (the ratio is approximately 3:1), in high speed clustered
environments. Therefore if the system needs to run for some time under a considerable load, a
larger database should be used to prevent production from being interrupted. Or set the clean-
up service to use Database Partitioning.

We also recommend only the Master Server performing the database clean-up, or the local
Server Extension if the database is not installed with the Master, to maximize performance. For
all Designers, Server and Server Extensions except one, set the clean-up of the database
entities to run every 100 months and disable the clean-up for any Designer which also has a
Server or Server Extension on that machine.

Note that if the Designer is a stand-alone then itis not connected to the central database for
clean-up purposes.
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The Database Petitioning option can be found in the "Clean-up Service preferences" on
page 856, see https://help.objectiflune.com/en/PReS-connect-user-guide/2021.2 in the Online
Help.

Issues with Microsoft Edge browser

The Microsoft Edge browser fails to display web pages when the Workflow's CORS option (in
the HTTP Server Input 2 section) is setto "*". This issue will be resolved in a future release.

Installation paths with multi-byte characters

When installing the Chinese (Traditional or Simplified) or Japanese versions of Connect, if the
user specifies an alternative installation path containing multi-byte/wide-char characters it can
break some of the links to the Connect-related shortcuts in the Start Menu and cause an error to
appear at the end of the installer. The workaround for the moment is to use the default
installation path. The problem will be addressed in a later release.

Switching languages

Changing the language using the Window > Preferences > Language Setting menu option
does not currently change all of the strings in the application to the selected language. This is a
known issue and will be fixed in a later release.

In the meantime we offer the following workaround for anyone who needs to change the
language:

1. Go to the .ini files for the Designer and Server Config:

e C:\Program Files\Objectif Lune\OL Connect\Connect
Designer\Designer.ini

e C:\Program Files\Objectif Lune\OL Connect\Connect Server
Configuration\ServerConfig.ini

2. Change the language parameter to the required one under Duser.language=en | es | de |
fr|it|ja| ko |pt|tw|zh

Only one of the above language tags should be selected. Once saved, Connect will appearin
the selected language at next start-up.
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GoDaddy certificates

When installing Connect offline, dialogs allow installing the GoDaddy certificates. Most users
should use the default settings and click Next. In some cases, however, this may not work
correctly. For this reason those users should activate Place all certificates in the following
store and then select the Trusted Root Certification Authorities as the target certificate store.

MySQL Compatibility

After installing Connect 2021.2 a downgrade to a Connect version earlier than Connect 1.3 or
to a MySQL version earlier than 5.6.25 is not seamlessly possible. This is because the
database model used in Connect 1.3 and later (MySQL 5.6) is different to that used in earlier
versions. If you need to switch to an older version of Connect/ MySQL, itis first necessary to
remove the Connect MySQL Database folder from "%ProgramData%\Connect\MySQL\data"
before installing the older version.

The minimum supported MySQL version is MySQL 5.6.

PostScript print presets

The print presets for PostScript were changed from Version 1.1 onwards meaning that some
presets created in Version 1.0 or 1.0.1 may no longer work.

Any PostScript print preset from Version 1.0 that contains the following will not work in Version
2021.2: *.all[0].*

Any preset containing this code will need to be recreated in Version 2021.2.

Available Printer Models

Note that only the single Printer Model (Generic PDF) will appear on the Advanced page of the
Print Wizard by default.

To add additional printer models click on the settings =% button next to the Model selection
entry box.
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External resources in Connect

There are certain limitations on how external resources can be used in Connect. For example if
you want to link a file (e.g., CSS, image, JavaScript etc.) from a location on the network but you
do not want to have a copy of the file saved with the template you need to do the following:

1. The resource must be located where it can be accessed by all Servers/Slaves run as
users. Failure to do this will cause the image to appear as a Red X in the output for all
documents which were merged by engines which could not access the file. The job will
terminate normally and the error will be logged.

2. The file must be referenced via a UNC path e.g.,
file://lllw2k8r2envan/z%?20images/Picture/Supported/JPG/AB004763.jpg

o UNC paths are required because the services will be unable to access mapped
network drives (Windows security feature).

« The engine processing the job will look on the local file system for the direct file
path leading to the “resource not found” issue mentioned above.

Warning

Important Note: The Designer itself and Proof Print do not use processes that run as
services and they may find local files with non-UNC paths which can lead to the false
impression that the resources are correct.

Using Capture after installing Workflow 8

If PReS Connect Workflow 8 is installed alongside PlanetPress Suite Workflow 7, Capture can
no longer be used within Workflow 7. The plugins are now registered uniquely to Workflow 8
and the Messenger for Workflow 7 is taken offline. It is only possible to use Capture from PReS
Connect Workflow 8 thereafter.

Capturing spool files after installing Workflow 8

If PReS Connect Workflow 8 is installed alongside PlanetPress Suite Workflow 7, the
PlanetPress Suite 7 option to capture spool files from printer queues will no longer function.
The solution is to use PReS Connect Workflow 8 to capture spool files from printer queues.
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Color Model in Style Sheets

The color model of colors defined in a style sheet can sometimes change after editing the style
sheet. This is a known issue and will be addressed in a subsequent release.

Image preview in Designer

Ifin the Windows Internet settings (Connection Settings > LAN configuration) a proxy is
enabled, but "Bypass proxy settings for local addresses" is not checked, the image preview
service, conversion service and live preview tab in the Designer will not work and exhibit the
following issues:

« Images will be shown as 0 size boxes (no red 'X' is displayed).

« Live preview does not progress, and when re-activated reports "browsers is busy".

To fix the issue you must check the "Bypass proxy settings for local addresses" option.

Merge/Weaver engines when printing

The print operation in the Designer will automatically detect whether the Merge\Weaver
engines are available and display a message for the user to retry or cancel if not. Once the
Merge/Weaver engine becomes available and the user presses retry the print operation will
proceed as normal. This message can also occur in the following circumstances:

« Ifthe serveris offline and you are not using Proof Print.

« On some occasions before the Print Wizard opens.

REST Calls for Remote Services

The Server will accept REST calls for all remote services and will make commands wait
indefinitely until the required engines become available. The Server will log when it is waiting
for an engine and when it becomes available. Note that there is no way to cancel any
commands other than stopping the Server.

Print Content and Email Content in PReS Workflow

In PReS Workflow’s Print Content and Email Content tasks, the option to Update Records from
Metadata will only work for fields whose data type is set to String in the data model. Fields of
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other types will not be updated in the database and no error will be raised. This will be fixed in
a later release.

Print Limitations when the Output Server is located on a different machine

The following limitation may occur when using the Print options from a Designer located on a
different machine to the Output Server:

« The file path for the prompt and directory output modes is evaluated on both the client
AND server side. When printing to a network share it must be available to BOTH the
Designer and Server for the job to terminate successfully.

« The Windows printer must be installed on both the Server and Designer machines.

o When printing via the Server from a remote Designer, the output file remains on the
Server machine. This is remedied by selecting “Output Local” in the Output Creation
configuration.

VIPP Output
Some templates set up with landscape orientation are being produced as portraitin VIPP. It can

also sometimes be the case that text and images can be slightly displaced. These are known
issues and will be addressed in a later release of Connect.

Magic Number changes when installing Docker

Installing Docker on a system where Connect has already been installed may impact Connect's
licensing mechanism and require reactivation.

Note

Installing Connect after Docker has already been installed will not cause issues.

Uninstalling

This topic provides some important information about uninstalling (removing) PReS
Connect2021.2.
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To uninstall PReS Connect select the application from within the Add/Remove programs option
under the Control Panel. This will start the PReS Connect Setup Wizard in uninstall mode.

Note

The PReS Connect Setup Wizard might take some seconds to appear.

Important: Stop any active Anti-Virus software before uninstalling Connect.

Some anti-virus systems are known to block the uninstallation of MySQL datafiles, as well as
blocking the uninstallation of the MySQL database application itself. Therefore itis highly
recommended that any anti-virus application be stopped prior to uninstalling PReS Connect,
as otherwise the Connect uninstallation might not work correctly.

Impacts upon other applications and services

« The Uninstall will terminate the installed Server / MySQL service(s).

» The following applications / services should be stopped in a controlled fashion, before
running the PReS Connect Uninstall:

1.

PReS Connect

2. Connect products on remote systems which refer to this MySQL database.
3.
4

. PReS Connect Server Extensions on remote systems which connect to this

Any Connect Workflow using PReS Connect plugins which connect to this server.

machine as the Master Server.

Uninstallation Wizard

The uninstallation is done by running the PReS Connect Setup Wizard in uninstall mode. The
Wizard consists of the following pages:

1. PReS Connect Setup: An information page, listing what will be uninstalled, and also
warning about impacts upon running Applications and Services.

2. Data Management: A page that provides options for backing up or deleting Connect
data. Selections are as follows:

« Delete Connect Workspace Data: Check this box to delete the Workspace data for

the current user, or for selected users (as determined by the "Select Users" button)
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« Backup Connect Workspace Data for all specified Users: Check this box
to backup the Workspace data for the specified users (as previously
determined) into a compressed ZIP file (whose location can be customized),
before deletion of the full Workspace data.

o Delete MySQL objectlune Data: Check this box to delete the MySQL database
installed with PReS Connect.

« Backup MySQL Date: If the deletion checkbox is selected, this option
appears to allow backing up the MySQL database to a customizable location,
prior to uninstallation.

Note

If an error occurs during uninstallation or after/when re-installing Connect after
uninstalling it, please see: Problems during a Connect installation or version upgrade in
Connect's Knowledge Base (https://help.objectiflune.com/en/kb-
connect/#KB/FAQ/OL%20Connect/KB2002.htm).
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General information

Connect consists of visible and invisible parts. The invisible parts process the Connect job to
provide the actual output. They are introduced to you in the topic: "Connect: a peek under the

hood" below.

For information about Connect logging, see "Log files" on page 138.

For a list of all file types used in Connect, see: "Connect file types" on page 140.

You can find additional information that complements the user manuals, such as error codes
and frequently asked questions about PReS Connect, in the Knowledge base.

Connect: a peek under the hood

Connect consists of visible and invisible parts.
The visible parts are the tools you use to create templates, data mapping configurations, and

Print Presets (the Designer/DataMapper), and to create Workflow configurations (the Workflow

configuration tool).

The invisible parts process the Connect job to provide the actual output. This topic introduces

you to those parts.

Here's a simplified, graphical representation of the architecture of PReS Connect. The
components described below are all located in the 'Server' part.
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The Workflow server
The Workflow server (also referred to as the 'Watch service') executes processes

independently, after a Workflow configuration has been uploaded and the services have been
started. The Workflow server can run only one configuration at a time.

Watch

service

HTTP service

Messenger
service

There are a number of services related to Workflow. The PReS Messenger service, for
example, receives the files sent to Workflow from the Designer and the Workflow configuration
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tool.
The Workflow Service Console lets you start and stop the different services, except the
Connect server, and see their log files (see Workflow Service Console).

Note that Workflow isn't limited to Connect functionality. It was originally developed as part of
the PlanetPress Suite. Many of the plugins in the Workflow configuration tool are older than
Connect. They were left in for compatibility reasons, even though they aren't all useful or usable
within Connect. However, the Connect plugins cannot be used with the PlanetPress Suite
software.

The Connect server

As opposed to the Workflow server, the Connect server was designed to be used only with
Connect. The Connect server performs several different tasks, all of which are related to
Connect content and content management:

It communicates with the Workflow service (with the Connect plugins, specifically) and with the
Designer when output is generated from the Designer. It creates records (by extracting data
from a data source using a data mapping configuration), and jobs. It communicates with the
engines (see below) in order to make them create content items and output (spool) files.

. DatalMapper
Data Mapping ——

Content Connect

Merge engine(s)

OL Connect Server Creation Database

service
Job Creation
Output Weaver
Creation engine(s)

The Connect server is one of the components that has to be installed with Connect (see
"Installation Wizard" on page 38).

In the Workflow Configuration Tool preferences you have to set the OL Connect server settings
to enable Workflow to communicate with the server (see Workflow Preferences).
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The Connect Server Configuration tool lets you change the settings for the Connect server,
the engines and the service that cleans up the database and the file store. These settings can
also be made in the preferences of the Designer.

The Connect database

The Connect database is the database back-end used by Connect itself when processing jobs.
It can be either the MySQL instance provided by the Connect installer, or a pre-existing
(external) instance (see "Database Considerations" on page 18).

All generated items (records, content items etc.) are stored in this database. They can be used
by the next task in the same process or in a process that runs later, making it possible to
commingle Print jobs, for example.

Note

Email content items are not stored in the Connect database.

A clean-up of the database is performed at regular intervals in accordance with the settings
(see "Clean-up Service preferences" on page 856).

The File Store

Connect has its own File Store which it uses for transient files.
The Clean-up service takes care of removing obsolete files when those files are not marked as
permanent (see "Clean-up Service preferences" on page 856).

Tip

The File Store is accessible for customer implementations. The Workflow configuration
tool implements three tasks that allow you to Upload, Download and Delete files in the
Connect File Store. The files can be accessed through the REST API, which means web

portals could potentially access the files directly without having to go through a Workflow
process (see The Connect REST API CookBook).
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The engines

DataMapper engines. A DataMapper engine extracts data from a data file. The number of
DataMapper engines is configurable (Engines preferences).

Merge engine/s. A merge engine merges data with a template using the scripts in the template,
in order to create content items.

The number of merge engines is configurable (see Engines preferences): it can be increased
depending on the capacity of the machine that runs the solution (see "Performance
considerations" on page 27).

Weaver engines. A Weaver engine creates Print output from Print content items. It takes the
settings made in Print Presets or in the Print Wizard into account.
The number of Weaver engines is configurable as well (see Engines preferences).

Note

The Proof Print function doesn't print via the Connect Server; it uses the Designer's
internal engines.

The REST API

The Connect server receives REST commands (see The Connect REST API CookBook),
normally either via the Workflow service or from the Designer. This design allows the Connect
functionality to be used by other applications. The server forwards the commands to the
appropriate engine and returns the results to the caller. The results are the id's of the items
(records, content items, job etc.) that are stored in the Connect database (see below). All
Connect tasks except the Create Web Content task integrate the results in the Metadata in
Workflow.

The figure below shows the communication between Connect tasks and the Connect serverin
a Print process.
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Printing and emailing from the Designer

To print or send email from within the Designer, the PReS Connect service has to be running.
The service is started automatically when the Designer starts, but it may not be running if the
Connect Server and the Designer are installed on different computers. The PReS Connect
service can be found on the Services tab in the Task Manager.

For a proof print the Connect server is not used. Proof printing is always done locally, by the
Designer.

Log files

Location

Connect's log files are located in the following folder: c:\Users\ [UserName] \Connect\1logs.
Where [username] is replaced by the appropriate Windows user name.

Tip
Actually, the path may not begin with 'C:\Users', as this is language-dependent. On a
French system, for example, it would be 'C:\Utilisateurs'.

Type suserprofiles in a Windows File Explorer and press Enter to open the actual
current user's home directory.
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Every time output is generated, the Designer and/or Connect Server and any engines involved
in the operation produce their own log files.

Each component writes its log files to a dedicated subfolder of the Log folder. Merge engines
write to the 1ogs/Mergeengine folder, Weaver engines to the 10gs/weaverengine folder,
DataMapper engines to the 1ogs/batamapperengine folder, Server to the 1o0gs/server folder,
and so forth.

Note that actions of the Cleanup service are only logged in the Server's log file. (See also:
"Clean-up Service preferences" on page 856.)

Note

Workflow services write their logs to a different location. See Accessing the Workflow
logs.

Tip
For more information about Connect's architecture, see: "Connect: a peek under the
hood" on page 133.

Name

The name of a log file consists of the component's name, a time stamp and the Windows
process ID.

The Windows process ID is needed since multiple engines of the same type could be running
at the same time, depending on the engine configuration (see "Engine configuration" on

page 97) and the size of a job.

Format

The log files are text files that can be opened in any text processor. Each log file contains a
header section containing a snapshot of the current working environment (operating system,
Connect version, system locale settings, disk and RAM information, and such like).

The logging level is configurable, as well as the exact format - the "logging pattern” - of the
individual log messages.
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« The Designer's logging preferences are set via the Designer; see: "Logging preferences"
on page 874.
o The Connect Server's settings are maintained by the Connect Server Configuration

utility tool; see "Server Configuration Settings" on page 91. The logging level that is set
applies to the Server as well as the engines.

The Designer's log messages are also displayed in the Messages pane (see "Preflight Results
and Messages" on page 1074). The Log Filter allows to define what kind of events may be
shown in the Messages pane (see "Log Filter" on page 1075). That doesn't change the actual
logging level of the Designer, however; it only filters the log file.

Connect file types

This article describes the different file types that are related to PReS Connect and its different
modules. These are files that are generally transferable between machines, can be sent via
email or other means.

.OL-template: A Designer Template file (see "Templates" on page 456). Is linked to a
data mapping configuration by default, but not necessarily.

« .OL-datamapper: A data mapping configuration file, which can include sample data
(excluding database source files such as mySQL, oracle, etc). See "Data mapping
configurations" on page 203.

« .OL-datamodel: A data model file which can be imported or exported into either a data
mapping configuration or a template. Contains a list of fields and their data type (date,
currency, string, etc). See "The Data Model" on page 274.

« Print Presets are used when generating a job, ready for output, from Designer (see
"Generating Print output from the Designer" on page 1483) or through Workflow (see
"Print processes with OL Connect tasks" on page 192).

» .OL-jobpreset: A Job Creation Preset file has settings for data filtering and sorting,
grouping (groups are used to split the print output), adding metadata fields, and
finishing options that override the template's Media and Section settings. (See "Job
Creation Presets" on page 1489.)

« .OL-outputpreset: An Output Creation Preset file is used to generate the actual
print output in the appropriate format (pcl, afp, ipds, pdf, etc). It includes print settings
such as impositioning (N-up, cut & stack), inserter marks, tray settings, separation
etc. (See "Output Creation Presets" on page 1492.)
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.OL-package: A transfer file used to package one or many of the above files (the data
model being part of both the template and the data mapping configuration). Created by
using the File > Package dialog. (See "Package dialog" on page 996.)

« .OL-script: One or more Designer scripts. Scripts personalize the output of a template.
They are either added via wizards (see "Personalizing content” on page 796) or self-
written (see "Writing your own scripts" on page 884). They can also be imported or
exported from the Scripts pane in Designer when a template is open.

o .OL-printerdef: A Printer Definition File is used by the Output Creation Preset (see
"Output Creation Presets Wizard" on page 1194) to determine what type of output to
produce. These definition files are generated by an internal application that is not
currently distributed outside of OL, but the definition files themselves can be provided.

« .OL-workflow: A Workflow file used by PReS Workflow. Equivalent to .pp7 files (they are,
in fact, essentially the same format), containing the processes and such used by
Workflow.
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OL Connect projects

An OL Connect project is an automated process, or combination of processes, in which the
Connect Server and Database are used. (For an overview of the architecture of the OL Connect
software, see "Connect: a peek under the hood" on page 133).

Typically, an OL Connect project aims at automating (part of) a company's communication with
its customers, suppliers, or other parties. Data is received - in whatever form -, processed,
stored, and used in communications which are sent out through one or more output channels
(print, email, web, etc), immediately or at a scheduled time.

Automation with Workflow

The process automation server included in PReS Connect is called Workflow.
The Workflow server (also sometimes referred to as the 'Watch service') executes processes
independently, after a configuration has been uploaded and the services have been started.

Usually, all of OL Connect's design tools are involved in the development process:

« Input data is extracted from a data source using a data mapping configuration, created
with "The DataMapper" on page 202.

« Communications are created by merging the data with one or more templates, designed
with "The Designer" on page 454.

« Ifthe output channel is print, Print Presets, also created with the Designer, determine
how the documents are printed.

« The pieces come together in an automated process, e.g. a Workflow configuration,
created with the Workflow Configuration Tool.

Each of the tools has its own Online Help, but if you're new to either Workflow or the OL
Connect software in its entirety, this chapter will help you get started on building OL Connect
solutions.
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Tip
Project Wizards

The OL Connect software comes with a number of Project Wizards that generate a
Workflow configuration, and any Connect templates, data mapping configurations, and
Print Presets required to make the project work. For more information, see "Project
Wizards" on page 1010 in the online help or the Project Wizards overview video on the

OL Learn website.

Typically, in an OL Connect project there is a number of Workflow processes that
communicate with the Connect Server, Database and/or File Store through one or more of the
specially developed OL Connect tasks.

For help on building these Workflow processes see "Workflow processes in OL Connect
projects" on page 185 and "OL Connect tasks" on page 187.

Using the REST API

The OL Connect Server, Database and File Store can also be accessed through the REST
APl i.e.in a script. The script could be part of a Workflow process (i.e. a Run Script task), but it
could also be in a web page or portal, which means you could potentially access the OL
Connect Server, database and File Store directly, without having to go through a Workflow
process, or with another automation tool such as Node-RED.

The OL Connect REST API gives access to a number of areas including its processes, data
entity management and File Store operations.

These services can be used to perform various interactions with the OL Connect server such
as:

« Upload and manage data files, data mapping configurations and templates in the File
Store.

« Create, manage and find data entities internal to the OL Connect Server.

« Create and monitor processing operations within the OL Connect Server.

For examples and the REST API reference see The Connect REST API CookBook.

Page 143



https://learn.objectiflune.com/videos/project-wizards-overview/
http://help.objectiflune.com/en/PReS-connect-rest-api-cookbook/2021.2/

Tip
The Designer can send templates, data mapping configurations and print presets to a
Connect Server; see "Sending files to Connect Server or to another server" on page 462.

Project Wizards

A Project Wizard generates a small Connect solution that is ready to be tested and deployed.
The solution contains a specific Workflow configuration, as well as the Connect templates, data
mapping configurations, and any Job Presets and Output Presets that are used in that
configuration.

This chapter describes the Project Wizards and the projects that they install. It will help you
install, comprehend and customize the projects.

There is an introductory Project Wizards overview video on the OL Learn website.

For generic information about Connect solutions and their components, see "OL Connect
projects" on page 142.

Note

The projects require that the Connect Server and Connect Workflow be installed on the
local machine.

These are the projects that can be installed with a wizard.

« Print promotional jobs. This project generates a batch of basic personalized letters, in
the format that was selected in the wizard: PDF, PCL or PostScript Level 3. (See: "Project
Wizard: Print Promotional Jobs" on page 160.)

The Workflow configuration uses the All In One plugin (see "Print processes with OL
Connect tasks" on page 192).

« Print transactional jobs. This project creates print content items - invoices - and uses
multiple Create Output tasks to generate various print output variants:
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o A single PDF for the entire job (in which the invoices are grouped per customer).
o One PDF per customer.

o One PDF perinvoice.
(See: "Project Wizard: Print Transactional Jobs" on page 167.)
The Workflow process implements the typical Print plugins (see "Print processes with OL
Connect tasks" on page 192).

- Basic web page. This project serves a simple web page, personalized via URL
parameters. (See: "Project Wizard: Serving a Web Page" on page 180.)

« Submitting data with webforms. This project illustrates how to serve multiple web
pages, one of them a web form, using a single Workflow process. It stores submitted data
in the Data Repository. (See "Project Wizard: Submitting Data with Web Forms" on

page 174.)
« Basic email setup. This project sends email messages with attachments. Pre-rendered

PDFs are attached based on the provided sample data. (See "Project wizard: Basic
Email" below.)

« Capture OnTheGo Timesheets. This project deploys and serves COTG Timesheet
forms. Additional processes capture the submitted data and output them in JSON, XML
and PDF. In order to create the PDF, the data are merged with a Connect template. (See:
"Project Wizard: COTG Timesheets" on page 152.)

Project wizard: Basic Email

The Basic Email project wizard creates an OL Connect project that sends emails with two
attachments: a Return and Refund Policy (PDF) which is the same for all emails, and a delivery
note (PDF) which is attached to the email dynamically. The email has a mailto link.

For an introduction to this Project Wizard, see Project Wizards overview video on the OL Learn
website (start at 21:07) or on Youtube: Email.

Installing the project

To start the project wizard, select File > New > Project Wizards > Basic Email from the menu.
(See also: "Basic Email - Project Wizard" on page 1011.)

Page 145



https://learn.objectiflune.com/videos/project-wizards-overview/
https://youtu.be/6TD1rHD5m7g?t=1267

Note

In order to use the project, OL Connect Server and OL Connect Workflow must be
installed on the local machine.

The wizard lets you select the folder in which you want the solution to be installed.

In the selected folder, the Project Wizard will create two subfolders: Configurations and
Workspace.

The project's resource files are saved to the Configurations folder.

The Workspace folder is used for debugging or running the solution. It has an In folder that
may be used to monitor incoming data and an Out folder to write output files to.

The selected folder's path is saved to a global variable in the Workflow configuration (see "The
Workflow configuration" on page 148).

The variable is used in the data mapping configuration (see "Project details" on the next page).

In addition you have to make the settings for outgoing mail (for the details see "Basic Email -
Project Wizard" on page 1011).
These settings are copied to the Create Email Content task in the Workflow process.

Testing and running the project

Once the project wizard has finished the installation, the project is ready to be tested.

1. If the templates and data mapping configurations haven't been sent to Workflow yet,
do that first (see "Sending files to Workflow" on page 461). This requires that the
Workflow service is running (see Starting the Workflow service in Workflow's Online
Help).

2. Locate the Workflow configuration in the project folder and open itin OL Connect
Workflow.

3. Selectthe em_basic_sending_email process

4. Open the Debug ribbon and click Run.

The process should send the email messages along with a delivery note and the Return and
Refund Policy to the email address entered in the project wizard. This is the sender's address.
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Running the project

Having tested the project, you will be ready to send it to Workflow; see Saving and sending a
Workflow Configuration in Workflow's Online Help.

The project will run when you copy the Sample Data.xml file from the Configurations\Data
folder to the Workspacel\ln folder.

By default the project will still send all the emails to the sender's address. To change this:

1. Open the Create Email Content task and select the Email Info tab; then uncheck the Send
emails to sender (test mode) option.

2. Replace the test data with real data:
a. Open the Sample Data.xml file. You will find it in the Configurations\Data folder.

b. Replace the email addresses in this file by real email addresses that you have
access to.

c. Copy the modified sample data file from the Configurations\Data folder to the
Workspace\in folder.

The emails should now be sent to the email addresses that you entered in the sample data file.

Project details

The email template

The email's design is in the EM_BASIC Email Message template. It contains one Email
section (see "Email templates" on page 534).

Styling is done via style sheets (see "Local formatting versus style sheets" on page 752). The
style rules are in the context_htmlemails_styles.css file. Note how they use HTML tags, IDs and
classes to select elements. (See also: "Selectors in Connect" on page 905.)

The @media rules make the email responsive (see also: "Designing an Email template" on

page 525).

Note

Even though email clients do not read CSS files, CSS files can be used with the Email
context in the Designer. See "Using CSS files with HTML email" on page 527.

Two attachments are added to the email, in different ways.
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« The Return and Refund Policy PDF is stored in the template (in the Images folder). Right-
click the Email section and select Attachments to see how this is attached to the email.

« The delivery note is a dynamic attachment, based on a data field. It is attached to the
email by the Attachment script. To learn how to create dynamic attachments, see
"Dynamic attachments: creating file names based on data fields" on page 547.

All scripts are listed on the Scripts pane. You can double-click to open them.

Tip
Hover over the name of a script in the Scripts pane to highlight parts of the template that
are affected by the script.

o Some data are added to the email via simple text scripts. Such scripts search the
template in order to replace a certain text that is surrounded by @ (e.g. @First@) by the
correct data. To add a text script you just drag-and-drop data onto the template. (See:
"Variable Data" on page 813.)

« The To and Subject scripts apply to email fields. (Click Email Fields at the top of the
email to expand all email fields.) For information about this kind of scripts, see: "Email
header settings" on page 538.

« Finally, there are two custom scripts:

o The Personalize Support link script adds the order number to the 'support team'
link (which is a mailto link).

« The Year script puts the current year in the footer.
For more information about writing custom scripts, see: "Writing your own scripts" on

page 884.

The Workflow configuration

The project's Workflow configuration, Sending Email, contains just one process. Itis a simple
OL Connect Email process (see "Email processes with OL Connect tasks" on page 190).

To open the configuration, open Workflow, click the Workflow button, select Open and browse
to the project's Configurations\Resources folder.

Double-click on a task to see its properties.
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« The Folder Capture task reads the project's Workspace path from a global variable. The
value of that variable is set by the project wizard when it installs the project.

« The Execute Data Mapping task extracts data from the sample data file and outputs
them in the Metadata.

« The Create Email Content task creates the emails, using the Metadata as data source.
Note that it sends the emails in test mode, which means it will send the emails to the
sender.

The settings on the Email Info tab are taken from the project wizard.

« The Delete task is an Output task that does nothing, actually; it doesn't even remove
anything. This step is sometimes useful when running a project step by step in Debug
mode, as it forces preceding tasks to return their output to the Workflow process. The
Create Email Content task, however, does not return the generated emails to the
Workflow process.

The data mapping configuration

The Workflow process uses a data mapping configuration, made with "The DataMapper" on
page 202: EM_BASIC Data.

To open the data mapping configuration, open the Designer, select File > Open from the menu
and browse to the Configurations\Resources folder.

This data mapping configuration will of course only work with the appropriate data files. It was
designed for XML files that are structured like this file: Sample Data.xml (in the
Configurations\Resources\Data folder).

The sample data yields 5 records with customer data including a detail table with invoice
details.

Much of the information in the extracted records isn't used in the email, but was used to create
the delivery notes.

The email addresses are used in the template (in the To field), but ignored in the Workflow
process because it sends emails in test mode (see "The Workflow configuration" on the
previous page).

Using a Workflow variable

The path to the delivery note is constructed via JavaScript:
automation.variables.em_basic_workspace + \\Delivery Notes\\' + record.fields.OrderNumber +
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".pdf;

The script uses a property: automation.variables.em_basic_workspace, which is defined in the
Preprocessor step. (See also: "Properties and runtime parameters" on page 263.)

In this case, the variable holds the project's path. The order number in the path is extracted from
the sample data.

Note

In order to use the value of a Workflow variable - an 'Automation variable' - as a property
in the Preprocessor step, the property and the Workflow variable must have the exact
same name.

To see the script, click on the DeliveryNote field in the Data Model pane at the right; then take a
look at the Step Properties pane (in the middle).

To see where the property is defined, click the Preprocessor step on the Steps pane (at the left);
then look at the Properties section on the Step Properties pane.

Customizing the project

A project is a great starting point for building an OL Connect solution. This part explains how to
make changes to the project.

Do you intend to expand the projectinto a solution where Workflow runs on a different machine
that also has a different regional setting? Then indicate the desired encoding in the Designer
preferences (see "Project Wizard deployment settings" on page 878) before installing the
project.

Input data

If your input data is in a file, but the file is of a different type or has a different structure, create a
new data mapping configuration to match it. (See "Creating a new data mapping configuration"
on page 204.)

When it's finished, send the new data mapping configuration to Workflow (see "Sending files to
Workflow" on page 461).

Then open the Workflow configuration, double-click the Execute Data Mapping task to open it
and select the new data mapping configuration.
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To capture input data from a different source:

1. Replace the Folder Capture Input task by the appropriate Input task. See: Input tasks in
Workflow's Online Help.

2. Add a Send to Folder task directly after the new Input task and set its output folder to the
Workspace\Debug folder (3 {global.pr prom workspace}\Debug). This task
writes the job file to a file, which can then be used as sample data file when creating a
data mapping configuration and debugging the Workflow process.

3. Run the process once (see "Testing and running the project" on page 146) to capture the
job file that contains the input data.

4. Use thatfile to create a new data mapping configuration, send the data mapping
configuration to Workflow, and adjust the Workflow configuration, as described above.

Note

If the input data is JSSON, you don't need a data mapping configuration: JSON data can
be used in a template as is. See: "Adding JSON sample data" on page 810.

However, if you want the data to be saved in the OL Connect database, put the
XML/JSON Conversion plugin before the Send to Folder task to convert the JSON to
XML, and create an XML data mapping configuration to extract the data.

The email

Often this type of email has a Call to Action button which redirects the user to the website of
the vendor, where the user could log on to the site and follow an online payment process, for
instance.

To get an example (or to start over) you could use one of the template wizards that start an
'action email'; see "Email Template Wizards" on page 531.

You could add text, images and other elements to the email (see "Content elements" on
page 640) and change the layout (see "Styling and formatting" on page 752). Keep in mind
though that there are special design standards for HTML email (see "Designing an Email
template" on page 525).

In order to further personalize the email, open your data mapping configuration (or JSON data,
if the input data will be in that format; see "Adding JSON sample data" on page 810) and use
the data fields to personalize the email. (See: "Personalizing content" on page 796.)
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Tip
The Designer can have one data mapping configuration and one template open at the
same time. Use the tabs at the top of the workspace to switch between the two. Click the

synchronize button on the Data Model pane to make sure that the Data Models are the
same in both.

Once the template is ready, send it to Workflow (see "Sending files to Workflow" on page 461).

Finally, in Workflow, adjust the process: double-click the Create Email Content task to open it,
and select the new template. This is only necessary when the file name has changed.

Workflow configuration

The current Workflow configuration is very simple. In reality, a process that generates email
output will be part of a larger project, in which, for example, invoices are produced in a separate
process, stored in a folder and attached to an email at a later time.

For general information about processes in Workflow see About Processes and Subprocesses,
in the Online Help of Workflow.

Project Wizard: COTG Timesheets

The COTG Timesheets Project Wizard creates a Capture OnTheGo project that creates a
web page with a web form and serves it to the COTG app. When the form is submitted, the
project handles the submitted data by creating an XML, JSON and PDF output file in a folder.

For an introduction to this Project Wizard, see Project Wizards overview video on the OL Learn
website (start at 25:19) or on Youtube: COTG Timesheets.

Installing the project

From the menu, select File > New > Project Wizards > COTG Timesheets to start the wizard.

The wizard lets you select the folder in which you want the solution to be installed.

In the selected folder, the Project Wizard will create two subfolders: Configurations and
Workspace.

The project's resource files are saved to the Configurations folder.
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The Workspace folder is used for debugging or running the solution. It has an In folder that
may be used to monitor incoming data and an Out folder to write output files to.

The selected folder's path is saved to a global variable in the Workflow configuration (see "The
Workflow configuration" on page 156).

You also need to enter the host. This address will be used by the COTG app to download
forms and submit data to the OL Connect Workflow service.

If you want to use localhost, the OL Connect Server, Workflow and COTG app must be installed
on the local machine.

Finally, you need a valid COTG account, Repository ID and password. You could use
dummy data to create the Project Wizard and finish the installation, but you won't be able to test
the project.

For more information about the options, see: "COTG Timesheets - Project Wizard" on
page 1012.

Tip
If you own PlanetPress Connect or PReS Connect, free COTG trial licenses may be
available to you; see http://www.captureonthego.com/en/promotion/.

Note

Your network setup may make it impossible for the COTG app to communicate with the
OL Connect Workflow service. The app needs to be able to communicate with OL
Connect Workflow in order to download forms and submit data. Network and firewall
settings may block these requests. Please contact your local IT department for advise on
how this can be resolved in your setup.

Testing the project
Once the Project Wizard has finished the installation, the project is ready to be tested.
1. If the templates and data mapping configurations haven't been sent to Workflow yet, do

that first (see "Sending files to Workflow" on page 461).
This requires that the Workflow service is running (see Starting the Workflow service in
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Workflow's Online Help).

2. Send the Workflow configuration to the Workflow service; see Saving and sending a
Workflow Configuration in Workflow's Online Help.

3. Open the Workflow configuration from the project's Resources\Workflow folder.

4. Selectthe cotg_ts_deploy_form process, open the Debug ribbon and click Run to
execute the process. This deploys a number of forms to the COTG account entered in the
Wizard.

Note

The process is pre-configured to use the sample data file, which comes with the
project, when it runs in Debug mode.
Alternatively you could copy the sample data file to the In folder.

5. Launch the COTG app and log in using the COTG account that you entered in the Project
Wizard.

In the app, open the Repository and download one of the forms.
From the app's Library, open the form.

Enter data and draw a signature.

© 0o N

Submit the form.

Note

If the COTG app is unable to submit the data, you may have to change your network
setup or remove the built-in restrictions in Windows 10 that prevent applications from
sending data to the same computer. See "Installing the project" on page 152.

Project details

The templates

The form

The COTG Timesheet Form template contains a Web context with one Web section: Section
1 (see "Web pages" on page 556 and "Forms" on page 723). The form has regular Form
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elements as well as COTG elements (see "Form Elements" on page 728 and "COTG
Elements" on page 716).

The template was started with the Time Sheet Wizard (see "Capture OnTheGo template
wizards" on page 589), which also provides the necessary JavaScript files and style sheets.

Most of the scripts are simple Text Scripts (see "Using the Text Script Wizard" on page 816).
They put data in one of the form's fields, selecting the field by its ID.

Tip
Hover over the name of a script in the Scripts pane to highlight parts of the template that
are affected by the script.

« The guid script adds data to the guid field. This is a hidden field. It is only visible in the
Source view.

« The result of the form action script is added to the form's action attribute. To see how
that is done, double-click the script; then click Options.

« The Year script puts the current year in the footer of the page. This is a custom script. For
more information about writing scripts, see: "Writing your own scripts" on page 884.

The report

The COTG Timesheet Report template contains a Print context with one Print section:
Section 1 (see "Print sections" on page 494) and one Master Page (see "Master Pages" on
page 513).

Personalization is mostly done via simple text scripts. Such scripts look for a text surrounded
by @ (e.g. @city@) and replace that by the correct data. To add a text script you just drag-and-
drop data onto the template. (See: "Variable Data" on page 813.)

The template also contains a dynamic table which is filled and expanded dynamically by the
scripts in the Table folder. To learn how to insert and edit such a table, see "Dynamic Table" on

page 832.

Note that this table does not use one of the default table styles, and that the style sheet with the
default table styles is not present in the template. To add that style sheet to the template, insert
a table using the Dynamic Table wizard.
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The data mapping configurations

This project has two data mapping configurations, made with "The DataMapper" on page 202.
To open one of them, select File > Open from the menu in the Designer and browse to the
Configurations\Resources folder.

COTG Timesheet Form

The COTG Timesheet Form data mapping configuration is designed to extract data from the
sample data file (Sample Data.xml).

The configuration also adds two fields to each record, using JavaScript: a unique ID (guid) and
a field that contains the action of the Form.

Note that the COTG account is the same in all of the records in the sample data. It is inserted
into the sample data by the Project Wizard.

COTG Timesheet Report

The COTG Timesheet Form data mapping configuration is designed to extract the data that are
submitted via the app. It first extracts the common fields, and then the information from the rows
in the form, in a loop. For information about how to extract a variable number of similar
elements from an XML file, see: "From an XML file" on page 248.

In order to create this data mapping configuration, the input data needed to be saved to a file
first (see "Saving input as sample data" on page 158).

The sample data file is located in the Configurations\Data folder, but you will also see it when
you open the data mapping configuration itself.

The Workflow configuration

There are four processes in the COTG Timesheets Workflow configuration. Some of them use
the OL Connect tasks that are normally used in a Web process or a Print process (see "Web
processes with OL Connect tasks" on page 194 and "Print processes with OL Connect tasks"

on page 192).

Creating the forms

The cotg_ts_deploy_form process is triggered when any file enters the Workspace\ln folder,
but its Execute Data Mapping task expects an XML file that is structured exactly like the Sample
Data.xml file (in the Resources\Data folder).

The Execute Data Mapping task outputs records in the Metadata.
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Subsequently, the Metadata Sequencer task creates a loop; the rest of the process is
performed as many times as there are records in the Metadata, for one record at a time:

« The Set Job Infos and Variables task reads data from the (current record in the)
Metadata and puts them into variables.

o The Create Web Content task merges the record with the COTG Timesheet Form
template.

« The Send to Folder task saves the form to the Forms folder in the project folder, using the
value of one variable as the file name.

« Finally, the Output to Capture OnTheGo task sends information about the form to the
COTG Server. Double-click the task to see how variables are used in its settings.

The Delete task is an Output task that does nothing, actually; it doesn't even remove anything.
However, this step is useful when running the project step by step in Debug mode. Tasks will
only return their output to the process - where it can be viewed - as long as they are followed by
another task.

Serving a form

When the user chooses to download a form in the app, the app sends a request using the URL
that was set for the form in the properties of the Output to Capture OnTheGo task (on the
Deposit tab). The URL contains one parameter: a unique ID.

The cotg_ts_serve_form process receives the request and loads the form (if it exists). The
Load External File task replaces the job file with the form. At the end of the process the Server
Input task returns the job file (the form) to the app.

Capturing data and generating output

When the user submits a form, the cotg_ts_capture_data process writes the job file - the
request in the form of XML - to a Temp folder in the Workspace and sends a response code to
the app. This way there is no need for the COTG user to wait while output is being generated.
The response to the app can be sent right away.

The cotg_ts_generate_report process picks up the XML file from the Temp folder, converts it
to JSON and saves itto a JSON file. Note how the Branch task keeps a backup of the job file. It
is the backup file - the XML - that is handed down to the next Branch, where itis saved as an
XML file.

Finally, the process extracts data from the job file and merges them with the COTG Timesheet
Report template, generating a PDF.

All output files are stored in the Workspace\Out folder
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Customizing the project

A project is a great starting point for building an OL Connect solution. This part explains how to
make changes to the project.

Do you intend to expand the project into a solution where Workflow runs on a different machine
that also has a different regional setting? Then indicate the desired encoding in the Designer
preferences (see "Project Wizard deployment settings" on page 878) before installing the
project.

The form

If you want to add inputs to the form and extract the submitted data, here's how to do that.

1. Open the Web section and add elements to the Web Form (see "Using COTG Elements"
on page 603 and "Using Form elements" on page 567).
You could also add text, images and other elements (see "Content elements" on
page 640) and change the layout of the page (see "Styling and formatting" on page 752).

2. Save the template and send it to Workflow (see "Sending files to Workflow" on page 461).

3. Upload the Workflow configuration to the server (see Saving and sending a Workflow
Configuration in Workflow's Online Help) and let the process save the input data to a file
(see "Saving input as sample data" below).

4. Use the saved file to expand the data mapping configuration (see "Opening a data
mapping configuration" on page 208). Send the data mapping configuration to Workflow.

5. Send the Workflow configuration to the server.

Saving input as sample data

Testing a process in Debug mode is only possible with a sample data file. The process is pre-
configured to use the Sample Data.xml file located in the Configurations\Data folder.
To create your own sample data file:

1. Locate the Workflow configuration in the Configurations\Workflow folder and open itin
Connect Workflow.

2. Select the process.
3. Enable the Send to Folder step (step 2 in the process).

4. Send the Workflow configuration to PlanetPress Workflow service (see Saving and
sending a Workflow Configuration) and run it again, with a custom name value.
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The Send to Folder step will now write the input data - the job file - to a file in the
Workspace\Debug folder.

When you select the file as sample file (on the Debug ribbon), it can be used to debug the
process.

Tip

The saved file can be used to create a data mapping configuration.

The report

Using different data in the report requires changing the COTG Timesheet Report template
(see "Personalizing content" on page 796).

Tip
The Designer can have one data mapping configuration and one template open at the
same time. Use the tabs at the top of the workspace to switch between the two. Click the

synchronize button on the Data Model pane to make sure that the Data Models are the
same in both.

You could also:

Add text, images and other elements (see "Content elements" on page 640)

Change the layout (see "Styling and formatting" on page 752)

Change the "Media" on page 517. If you have an image of the stationery the PDF will be
printed upon, add it to the Media to make designing the template little easier.

« Change the "Master Pages" on page 513

» Add sections (see "Print context" on page 490)

Once the template is ready, send it to Workflow (see "Sending files to Workflow" on page 461)
and send the Workflow configuration to the server again.
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Workflow configuration

To transform the project into a real solution, the Workflow configuration has to be adapted in
two important respects.

« The timing and manner of the production of forms will need to change. The Input task of
the cotg_ts_deploy_form process must be adapted to the actual input data. You will
also need to create an appropriate data mapping configuration for that data, which
probably means saving the input as sample data first (see "Saving input as sample data"

on page 158).

« How the submitted data must be handled depends entirely on what they are used for. You
may have to write them to a database and use them in an email, for example.
The cotg_ts_generate_report process demonstrates only a few of the things that you
can do with the submitted data.

Tip
The Submitting Data with Web Forms Wizard shows how to use a data selection

function - xm1get () -to read data from the request XML and how to store data in
the Data Repository (see "Project Wizard: Submitting Data with Web Forms" on

page 174).

For general information about processes in Workflow see About Processes and Subprocesses,
in the Online Help of Workflow.

Project Wizard: Print Promotional Jobs

The Print Promotional Jobs Project Wizard creates a simple, yet complete OL Connect project
that produces promotional print output.

The project extracts data from an XML file and uses that data to personalize a promotional
letter. The output is a single file containing all the letters, in the format that was selected in the
wizard (PDF, PCL or PostScript Level 3).

For an introduction to this Project Wizard, see Project Wizards overview video on the OL Learn
website (start at 0:52) or on Youtube: Print Promotional Jobs.
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Installing the project

Select File > New > Project Wizards > Print Promotional Jobs from the menu to start the
Print Promotional Jobs Project Wizard. (See also: "Promotional Print Jobs - Project Wizard" on

page 1014.)

Note

In order to use the project, OL Connect Server and OL Connect Workflow must be
installed on the local machine.

The wizard lets you select the folder in which you want the solution to be installed.

In the selected folder, the Project Wizard will create two subfolders: Configurations and
Workspace.

The project's resource files are saved to the Configurations folder.

The Workspace folder is used for debugging or running the solution. It has an In folder that
may be used to monitor incoming data and an Out folder to write output files to.

The selected folder's path is saved to a global variable in the Workflow configuration (see
"Workflow configuration" on page 164).

That variable is used in the settings of the Capture Folder and Send to Folder tasks.

Next, you have to select the desired output type: PDF, PCL or PostScript Level 3. Each of the
output types is available in two variants. The 'Stationery' variants will include the virtual
stationery (stored in the OL Connect template) in the output. This is a setting in the Output
Creation Preset (see "Print settings" on page 163).

Testing and running the project

Once the Project Wizard has finished the installation, the project is ready to be tested.

1. Locate the Workflow configuration in the Configurations\Workflow folder and open itin
OL Connect Workflow.

2. Select the pr_prom_generate_output process.
3. Open the Debug ribbon and click Run.
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In Debug mode, the first Input task is skipped and the process is executed using a sample data
file. This project is pre-configured to use the file: Sample Data.xml.

A successful test run results in a subfolder in the Workspace\Out folder, named after the
current month and year. The Print output is written to that subfolder. It consists of one file that
should have the proper file extension.

Running the project

Having tested the project, you will be ready to send it to the Workflow service; see Saving and
sending a Workflow Configuration in Workflow's Online Help.

To test the project, which then runs on the server, copy the Sample Data.xml file from the
Configurations\Data folder to the Workspacel\ln folder. The output should appear in the same
folder as before.

Project details

The letter template

The promotional letter is designed in the PR_PROM Letter template. It contains one Print
section (see "Print sections" on page 494).

There are two Master Pages that are each applied to different pages in the Print section
(see "Applying a Master Page to a page in a Print section" on page 515).

The Media contains the virtual stationery. Whether this is included in or omitted from the final
output depends on a setting in the Output Creation Preset.

Personalization is mostly done via simple text scripts. Such scripts look for a text surrounded
by @ (e.g. @city@) and replace that by the correct data. To add a text script you just drag-and-
drop data onto the template. (See: "Variable Data" on page 813.)

A few scripts are a little bit more sophisticated.

« The sales_rep script combines some data fields and adds a line break. Double-click the
script to open the Text Script Wizard with which this script was made. (See: "Using the
Text Script Wizard" on page 816.)

« The Promo script shows or hides a paragraph (with the ID 'promo') depending on
whether the customer's address is in Montréal. (See: "Showing content conditionally" on

page 823.)
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« The year script changes the year in the conditional paragraph to the current year. This
script only has to look for @year@ in an element that has the ID 'promo’, instead of in the
entire letter, which makes it run faster.

« The Dynamic Signature script switches the signature, with a file name based on a data
field. (See: "Dynamic images" on page 830.)

« The sender's address is adjusted depending on where the customer lives. The two
different sender's addresses are saved in snippets. (See: "Loading a snippet via a script"

on page 911.)

Styling is done via CSS. The context_all_styles.css file contains style rules for certain HTML
elements (level 1 and 2 headings) and for elements with a certain class or ID.

The data mapping

The data with which the template is merged come from an XML file: Sample Data.xml. They
are extracted from the XML file with a data mapping configuration: , made with the DataMapper
module in the Designer.

The data mapping configuration is very straightforward. It extracts all data without modifications
and it does no pre- or post-processing. Simple data mapping configurations like this are made
with the XML Data Mapping Wizard (see: "Using the wizard for XML files" on page 219). The
wizard creates a configuration with only one step: the Extract All step.

Of course, this will only work with the appropriate data files. This data mapping configuration
was designed for XML files that are structured like this file: Sample Data.xml.

The sample file is located in the Configurations\Data folder, but you will also see it when you
open the data mapping configuration itself: select File > Open from the menu; browse to the
Configurations\Resources folder and select the data mapping configuration: PR_PROM Data
XML.

Print settings

The Print context and Print sections can have their own print settings, such as Duplex printing
or binding style (see "Print settings in the Print context and sections" on page 492). Butin this
template, they don't have any. The way the letter is outputted is determined (mostly) by an
Output Creation Preset.

The Project Wizard installs six Output Creation Presets; two for each type of output. Per output
type, all settings in the Output Creation Presets are the same, except one: Print Virtual
Stationery. The ones that have this option enabled will include the Media - the Virtual
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Stationery - in the output. The other presets will not print the Media.
Only the selected Output Creation Preset is put to use in the Workflow configuration.

To see the exact settings, open an Output Creation Preset in the Designer: first select File >
Output Creation Presets from the menu; then click the Import button and browse to the
Configurations\Resources\Output presets folder to select the preset.

Note that the Output Type, on the Print Options page in the Output Creation dialog, is set to
Prompt for file name. This setting is overruled in the Workflow configuration (see below).

Workflow configuration

Whenever new input data appears in the Workspacel\ln folder, the letter template is
automatically merged with it and then printed. That s, if the Workflow server is running with the
Workflow configuration installed by the Project Wizard.

This project's Workflow configuration: Print Promotional Jobs, contains just one process: a
basic OL Connect Workflow Print process (see "Print processes with OL Connect tasks" on

page 192).

It consists of three plugins:

« The Folder Capture Input task. This task retrieves all XML files that enter the
Workspace\in folder.

« The AllIn One plugin. This plugin uses the data mapping configuration and template that
come with the project, and the Output Creation Preset selected in the Project Wizard. The
plugin is set to handle the output 'Through Workflow'. This means that the task will return
the output file to the Workflow process.

« The Send to Folder Output task. This task writes the output file to a subfoler in the
Workspace\Out folder. It makes use of system variables (see Standard variables) to
dynamically create a subfolder based on the current month and year (%M_%y). The name
of the file consists of the original file name (%O0), the current time (%h%n%s) and the file
extension. The file extension (.pdf, .pcl or .ps) matches the output technology selected in
the Project Wizard.

Both the Folder Capture and the Send to Folder task read the project's Workspace path from a
global variable. The value of that variable is set by the Project Wizard when it installs the
project.
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Customizing the project

A project is a great starting point for building an OL Connect solution. This part explains how to
make changes to the project.

Do you intend to expand the project into a solution where Workflow runs on a different machine
that also has a different regional setting? Then indicate the desired encoding in the Designer
preferences (see "Project Wizard deployment settings" on page 878) before installing the
project.

Input data
Here's how to adjust the project to input data that has a different structure or file type or comes
from a different source.

1. Create a new data mapping configuration to match your input data. (See "Creating a new
data mapping configuration" on page 204.)

2. When it's finished, send the new data mapping configuration to Workflow (see "Sending
files to Workflow" on page 461).

3. Open the Workflow configuration: Print Promotional Data.

4. Double-click the Folder Capture Input task and change the file mask, or replace the task
by the appropriate Input task. See: Input tasks in Workflow's Online Help.

5. Double-click the All In One task and select the new data mapping configuration on the
Data Mapper tab.

Note

If the input data is JSON, you don't need a data mapping configuration: JSON data can
be used in a template as is. See: "Adding JSON sample data" on page 810.

However, if you want the data to be saved in the Connect database, let the XML/JSON
Conversion plugin convert the JSON to XML and create an XML data mapping
configuration to extract the data.

Template

There are countless ways to customize the template to meet your exact requirements. You
could, for example:
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« Add text, images and other elements (see "Content elements" on page 640)

Change the layout (see "Styling and formatting" on page 752)

Change the "Media" on page 517

Change the "Master Pages" on page 513

Add sections (see "Print context" on page 490)

In order to further personalize the letter, you need to open your data mapping configuration.
(See: "Personalizing content" on page 796.)

Tip
The Designer can have one data mapping configuration and one template open at the
same time. Use the tabs at the top of the workspace to switch between the two. Click the

synchronize button on the Data Model pane to make sure that the Data Models are the
same in both.

When the template is ready, send it to Workflow (see "Sending files to Workflow" on page 461).

Finally, in Workflow, adjust the process: double-click the All In One task to open it, and select
the new template on the Content Creation tab. This is only necessary when the file name has
changed.

Send the Workflow configuration to the server (see Saving and sending a Workflow
Configuration in Workflow's Online Help).

Print output

To save the output to another kind of file, you could use one of the other Output Creation
Presets. To do that, adjust the process in Workflow: double-click the All In One task to open it,
and select the Output Creation Preset of your choice on the Output Creation tab.

To change the settings in an Output Creation Preset, open itin the Designer:

1. Select File > Output Creation Presets from the menu

2. Click the Import button and browse to the Configurations\Resources\Output presets
folder to select the preset.
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All of the presets provided by the wizard save the output to one file. You might want to save the
output to a number of files, for instance, one per customer. The Transactional Print Jobs project
shows you how to do that.

Project Wizard: Print Transactional Jobs

The Print Transactional Jobs Project Wizard creates an OL Connect project that produces
transactional print output. It prints invoices to:

o A single PDF for the entire job (in which the invoices are grouped per customer).
o One PDF per customer.

o One PDF perinvoice.

For an introduction to this Project Wizard, see Project Wizards overview video on the OL Learn
website (start at 7:56) or on Youtube: Print Transactional Jobs.

Installing the project

Select File > New > Project Wizards > Print Transactional Jobs from the menu to start the
wizard. See also: "Transactional Print Jobs - Project Wizard" on page 1015.)

Note

In order to use the project, OL Connect Server and OL Connect Workflow must be
installed on the local machine.

The wizard lets you select the folder in which you want the solution to be installed.

In the selected folder, the Project Wizard will create two subfolders: Configurations and
Workspace.

The project's resource files are saved to the Configurations folder.

The Workspace folder is used for debugging or running the solution. It has an In folder that
may be used to monitor incoming data and an Out folder to write output files to.

The selected folder's path is saved to a global variable in the Workflow configuration (see
"Workflow configuration" on page 171).
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That variable is used in the settings of the Capture Folder task.
The path is also copied to the Output Creation Presets which are used in the Create Output
tasks.

Testing and running the project

Once the Project Wizard has finished the installation, the project is ready to be tested.

1. Locate the Workflow configuration in the Configurations\Workflow folder and open itin
OL Connect Workflow.

2. Select the pr_tran_generate_output process.

3. Open the Debug ribbon and click Run.

The debugger always skips the first Input task. It needs a sample data file to work with.
Normally you'd have to select a sample data file in Workflow. However, the projectis pre-
configured to use this file: Sample Data.xml (located in the project's Configurations\Data
folder). The dates in the file are based on the date on which the projectis installed.

A successful test run results in the following output in the Workspace\Out folder:

« One PDF containing all invoices, grouped by customer number.
« A subfolder containing PDFs that have one invoice each.

« A subfolder containing one PDF per customer. (Some customers have more than one
invoice.)

Running the project

Having tested the project, you will be ready to send it to PlanetPress Workflow service; see
Saving and sending a Workflow Configuration in Workflow's Online Help.

To test the project when it runs on the server, copy the Sample Data.xml file from the
Configurations\Data folder to the Workspacel\ln folder. The same output should appear in the
same folders as before.

Project details

The invoice template

The invoice is designed in the PR_TRAN Invoice template. It contains one Print section (see
"Print sections" on page 494) and one Master Page (see "Master Pages" on page 513).
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The Media (virtual stationery) is included in the output - it is printed on the page's background -
, according to a setting in the Output Creation Presets.

Styling is done via style sheets (see "Local formatting versus style sheets" on page 752). The
style rules are in the context_print_styles.css file. Note how they combine the HTML tag, ID and
class of elements to select them. (See also: "Selectors in Connect" on page 905.)

Scripts

Scripts personalize content. Most of the scipts in the Information folder (on the Scripts pane)
are made with the Text Script Wizard (see "Using the Text Script Wizard" on page 816).

Tip
Hover over the name of a script in the Scripts pane to highlight parts of the template that
are affected by the script.

Text that should be replaced by data is not only surrounded by @ (e.g. @date@) but also
wrapped in a span (see "Span" on page 706). Each span has an ID, or a class if the same text
occurs more than once, to use that as the selector of the script. The selector of the Invoice Total
script, for instance, is a class: .inv-total.

Wrapping elements in a box (see "Boxes" on page 703) orin a semantic HTML element makes
it easier to target them in a script or in a style sheet. Place the cursor in the element or select
multiple elements. Then, on the menu, click Insert > Wrap in Box. You can now use the
wrapper element as a script's or style's selector; see "Using the Text Script Wizard" on

page 816 and "Styling and formatting" on page 752.

The Text Script Wizard has an Expand button that opens the Script Editor, where you can edit
the code or add your own. (For an introduction, see "Writing your own scripts" on page 884).
When you double-click on the Invoice Meta script, the Script Editor opens immediately. This
script shows how to add data using the replace() method (see
https://www.w3schools.com/jsref/jsref replace.asp).

Note that this is a native JavaScript function. Functions that are only available in Designer
scripts are listed in the "Designer Script API" on page 1293.
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Dynamic Table

The table in the invoice is a Dynamic Table. ltis filled and expanded dynamically by the scripts
in the Products folder. To learn how to insert and edit such a table, see "Dynamic Table" on

page 832.

Note that this table does not use one of the default table styles, and that the style sheet with the
default table styles is not present in the template. To add that style sheet to the template, insert
a table using the Dynamic Table wizard.

The data mapping configuration

The template is merged with data from an XML file: Sample Data.xml. They are extracted from
the XML file with a data mapping configuration, made with the DataMapper (see "The_
DataMapper" on page 202).

The data mapping configuration first extracts the common invoice fields, and then the
transactional data, in a loop. For information about how to extract transactional data from an
XML file, see: "From an XML file" on page 248.

Of course, this will only work with the appropriate data files. This data mapping configuration
was designed for XML files that are structured like this the sample file: Sample Data.xml.

Itis located in the Configurations\Data folder, but you will also see it when you open the data
mapping configuration itself: select File > Open from the menu; browse to the
Configurations\Resources folder and select the data mapping configuration: PR_TRAN Data
XML.

Print settings

A Print context and Print sections can have their own print settings (see "Print settings in the
Print context and sections" on page 492). The only print setting that the Print section has in this
template, is the Duplex setting. (Right-click the section and select Sheet Configuration. See
also: "Sheet Configuration dialog" on page 1033.)

All other print settings are in the three Output Creation Presets. These are used by the Create
Output tasks in the Workflow process.

To see the exact settings, open an Output Creation Preset in the Designer: first select File >
Output Creation Presets from the menu; then click the Import button and browse to the
Configurations\Resources\Output presets folder to select the preset.
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The three Output Creation Presets all create PDF output, add the template's name to the PDF's
meta data, and save the file in a certain directory. They all have the Print Virtual Stationery
option enabled. So, what are the differences between these presets?

Groups and separation

The PR_TRAN PDF Full Job preset outputs only one file.

The PR_TRAN PDF per Invoice preset outputs one file per invoice, separating the output by
document.

The PR_TRAN PDF per Customer preset outputs one file per customer, separating the output
by document set.

The last output preset needs the invoices in the job to be grouped in document sets first (by
customer number, in this case). That is what the Job Creation Preset does. This presetis used
by the Create Job task in the Workflow configuration.

Variable file names

The Job Creation Preset does something else, too: it attaches extra information - meta data - to
the documents and to the document sets. Both Output Creation Presets that produce multiple
files use that information in the output file names.

They do that by using a variable in the file output mask field. The variable refers to certain meta
data attached to items at a certain level (the document or document set, respectively). For more
information see "Print output variables" on page 1499.

Workflow configuration

Whenever new input data appears in the Workspacel\ln folder, the invoices are automatically
merged with the data and printed to one file, one file per customer, and one file per invoice.
That s, if the Workflow server is running with the Workflow configuration installed by the Project
Wizard. (See "Running the project" on page 168.)

This project's Workflow configuration contains just one process. Itis a typical OL Connect Print
process (see "Print processes with OL Connect tasks" on page 192), with the difference that it
does not have one Create Output task, but three. Each of them uses its own Output Creation
Preset (see "Print settings" on the previous page).

Note that the Branch tasks back up the job file and job information, so that the main branch
continues with a job file that is unaffected by what happens to the job file inside the branch.
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The Folder Capture task reads the project's Workspace path from a global variable. The value
of that variable is set by the Project Wizard when it installs the project.

Customizing the project

A project is a great starting point for building an OL Connect solution. This part explains how to
make changes to the project.

Do you intend to expand the project into a solution where Workflow runs on a different machine
that also has a different regional setting? Then indicate the desired encoding in the Designer
preferences (see "Project Wizard deployment settings" on page 878) before installing the
project.

Input data
Here's how to adjust the project to input data that has a different structure or file type or comes
from a different source.

1. Create a new data mapping configuration to match your input data. (See "Creating a new
data mapping configuration" on page 204.)

2. When it's finished, send the new data mapping configuration to Workflow (see "Sending
files to Workflow" on page 461).

3. Open the Workflow configuration: Print Promotional Data.

4. Double-click the Folder Capture Input task and change the file mask, or replace the task
by the appropriate Input task. See: Input tasks in Workflow's Online Help.

5. Double-click the All In One task and select the new data mapping configuration on the
Data Mapper tab.

Note

If the input data is JSON, you don't need a data mapping configuration: JSON data can
be used in a template as is. See: "Adding JSON sample data" on page 810.

However, if you want the data to be saved in the Connect database, let the XML/JSON
Conversion plugin convert the JSON to XML and create an XML data mapping
configuration to extract the data.
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Template

There are countless ways to customize the template to meet your exact requirements. You
could, for example:

« Add text, images and other elements (see "Content elements" on page 640)

Change the layout (see "Styling and formatting" on page 752)

Change the "Media" on page 517

Change the "Master Pages" on page 513

Add sections (see "Print context" on page 490)

In order to further personalize the invoice, you need to open your data mapping configuration.
(See: "Personalizing content" on page 796.)

Tip
The Designer can have one data mapping configuration and one template open at the
same time. Use the tabs at the top of the workspace to switch between the two. Click the

synchronize button on the Data Model pane to make sure that the Data Models are the
same in both.

Note that a "Dynamic Table" on page 832 can't exist without a detail table in the data.

When the template is ready, send it to Workflow (see "Sending files to Workflow" on page 461).

Finally, in Workflow, adjust the process: double-click the Create Print Content task to open it,
and select the new template. This is only necessary when the file name has changed.

Send the Workflow configuration to the server (see Saving and sending a Workflow
Configuration in Workflow's Online Help).

Print output

To save the output to another type of file, or to send it to a printer, you must change the Output
Creation Presets. Output Creation Presets are edited in the Designer.
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1. Select File > Output Creation Presets from the menu.

2. Click the Import button and browse to the Configurations\Resources\Output presets
folder to select the preset.

3. Click Next and adjust the Printer and Output options.

To separate the output differently, for example, by city in which the customers live, you need to
change the Output Creation Preset as well as the Job Creation Preset.

1. Open the Job Creation Preset in the Designer: select File > Job Creation Presets from
the menu.

2. Change the Grouping Options by selecting the relevant fields on the Job, Job
Segment, and/or Document Set tab.

3. Adjust the Separation Options in the Output Creation Preset accordingly.

Tip
The Execute Data Mapping task, Create Job and Create Output task may be replaced

with the All In One task, with its Output Creation set to None. Using the All In One instead
of the separate tasks makes the process a little faster.

Project Wizard: Submitting Data with Web Forms

The Submitting Data with Web Forms Project Wizard creates an OL Connect project that
responds to a request by serving a web page with a web form. When the form is submitted, it
handles the submitted data, saving them to the Data Repository.

For an introduction to this Project Wizard, see Project Wizards overview video on the OL Learn
website (start at 16:50) or on Youtube: Submitting Data with Web Forms.

Installing the project

From the menu, select File > New > Project Wizards > Submitting Data with Web Forms to
start the wizard. See also: "Submitting Data with Web Forms - Project Wizard" on page 1016.)
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Note

In order to use the project, OL Connect Server and OL Connect Workflow must be
installed on the local machine.

The wizard lets you select the folder in which you want the solution to be installed.

In the selected folder, the Project Wizard will create two subfolders: Configurations and
Workspace.

The project's resource files are saved to the Configurations folder.

The Workspace folder is used for debugging or running the solution. It has an In folder that
may be used to monitor incoming data and an Out folder to write output files to.

The selected folder's path is saved to a global variable in the Workflow configuration (see "The
Workflow configuration" on page 177).

Testing and running the project
Once the Project Wizard has finished the installation, the project is ready to be tested.
1. If the templates and data mapping configurations haven't been sent to Workflow yet, do

that first (see "Sending files to Workflow" on page 461). This requires that the Workflow
service is running (see Starting the Workflow service in Workflow's Online Help).

2. Send the Workflow configuration to PlanetPress Workflow service; see Saving and
sending a Workflow Configuration in Workflow's Online Help.

3. Access the web page by entering the following URL in a browser on the machine that
runs Workflow: http://localhost:9090/form. (The process starts with a NodedS
Server Input task, and Workflow's NodeJS Server listens on port 9090 by default.)

4. Fill in some data and submit the form. You will now be presented with a Thank You web
page.

Saving input as sample data

Testing a process in Debug mode is only possible with a sample data file. The process is pre-
configured to use the Sample Data.xml file located in the Configurations\Data folder.
To create your own sample data file:

1. Locate the Workflow configuration in the Configurations\Workflow folder and open itin
Connect Workflow.
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2. Select the process.
3. Enable the Send to Folder step (step 2 in the process).

4. Send the Workflow configuration to PlanetPress Workflow service (see Saving and
sending a Workflow Configuration) and run it again, with a custom name value.
The Send to Folder step will now write the input data - the job file - to a file in the
Workspace\Debug folder.

When you select the file as sample file (on the Debug ribbon), it can be used to debug the
process. Note however that the process will not return the web page to a browser, as it wasn't
started by a browser.

Tip

The saved file can be used to create a data mapping configuration.

Project details

The web templates

Both web pages are designed in the WEB_FORM Web Page template. It contains a Web
context with two Web pages: form and thank_you (see "Web pages" on page 556).

Styling is done via style sheets (see "Local formatting versus style sheets" on page 752). The
style rules are in the context_web_styles.css file. Note that they use the HTML tag (e.g.
section), ID (#thelD) and/or the class (.theclass) of elements to select them. (See also:
"Selectors in Connect" on page 905.)

Dynamic contentis inserted by scripts, which are listed on the Scripts pane. You can double-
click a script to open it.

The scripts in the Thank you folder only affect the thank_you Web page; on the form Web
page, nothing matches their selectors.

Tip
Hover over the name of a script in the Scripts pane to highlight parts of the template that
are affected by the script.
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« Most of the scripts in the Thank you folder directly insert data that were submitted via the
Web form; see "Inserting variable data directly (drag-and-drop)" on page 814.

« The Snippets script (also in the Thank you folder) loads two snippets, depending on the
values of two data fields (see "Loading a snippet via a script" on page 911). Note that it
selects the table, in order to insert the snippet after the table (via results.after ();
see "after()" on page 1383).

« The Year script puts the current year in the footer of both Web pages.

For more information about writing scripts, see: "Writing your own scripts" on page 884.

The Workflow configuration

The project's Workflow configuration contains just one process: an OL Connect Web process
(see "Web processes with OL Connect tasks" on page 194).

Its NodeJS Server Input task has two HTTP Action entries: form and thank_you. This means
the process will be triggered when the server receives a request that ends with either /form or
/thank_you.

The request is saved to an XML file, which becomes the job file.

The Text Condition task checks if the request's header is thank_you. (For the function that is
used to read the header from the job file, see: XML data selections.)

Ifitis, the tasks in the branch run. The submitted data are merged with the thank_you Web
section and saved in Workflow's Data Repository.

Otherwise the main branch renders and returns the web form.

Note how the Section setting in the Create Web Content tasks determines which web page is
outputted (double-click the task to open the properties).

The Delete task is an Output task that does nothing, actually; it doesn't even remove anything.
However, this step is useful when running the project step by step in Debug mode. When itis
followed by another task, the Create Web Content task returns its output to the Workflow
process, where it can be viewed (click View as HTML).

The data mapping configuration

To extract the submitted data from the job file (the request XML), the process uses the data
mapping configuration: WEB_FORM Data.

To open it, select File > Open from the menu and browse to the Configurations\Resources
folder.
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In order to create the data mapping configuration, the input data needed to be saved to a file
(see "Saving input as sample data" on page 175).

The sample data file is located in the Configurations\Data folder, but you will also see it when
you open the data mapping configuration itself.

For more information about data mapping configurations see "The DataMapper" on page 202.

Customizing the project

A projectis a great starting point for building an OL Connect solution. This part explains how to
make changes to the project.

Do you intend to expand the project into a solution where Workflow runs on a different machine
that also has a different regional setting? Then indicate the desired encoding in the Designer
preferences (see "Project Wizard deployment settings" on page 878) before installing the
project.

The form

If you want to add inputs to the form and use the submitted data in the Thank You web page,
here's how to do that.

1. Open the form Web section and add inputs to the Web Form (see "Using Form elements"
on page 567).
2. Save the template and send it to Workflow (see "Sending files to Workflow" on page 461).

3. Upload the Workflow configuration to the server (see Saving and sending a Workflow
Configuration in Workflow's Online Help) and let the process save the input data to a file
(see "Saving input as sample data" on page 175).

4. Use the saved file to add the new data to the data mapping configuration (see "Opening a
data mapping configuration" on page 208). Send the data mapping configuration to
Workflow.

5. Open the thank_you Web section and use the new data fields to personalize the page
(see: "Personalizing content" on page 796). Then send the template to Workflow again.
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Tip
The Designer can have one data mapping configuration and one template open at
the same time. Use the tabs at the top of the workspace to switch between the two.

Click the synchronize button on the Data Model pane to make sure that the Data
Models are the same in both.

6. Send the Workflow configuration to the server.

Web pages

Apart from the form, there are lots of ways to modify the template. You could add text, images
and other elements (see "Content elements" on page 640) and change the layout of the web
pages (see "Styling and formatting" on page 752).

Once the template is ready, send it to Workflow (see "Sending files to Workflow" on page 461).

Finally, in Workflow, adjust the process: double-click the Create Web Content task to open it,
and select the new template. This is only necessary when the file name has changed.

Send the Workflow configuration to the server (see Saving and sending a Workflow
Configuration in Workflow's Online Help).

Note

If you want the web pages to be responsive (have a different layout on screens of
different sizes), you could add Media Queries to the style sheet (see Media Queries on
W3schools), or start a new template with a wizard; see "Creating a Web template with a
Wizard" on page 551.

Workflow configuration

Serving the two web pages could also be achieved using separate processes, butin factitis
more efficient to have a single process, as activity needs to be monitored for each process.

In real life the submitted data will probably not be stored in the Data Repository, but used
differently. This means that the Push to Repository task will need to be replaced by the
appropriate tasks, but that won't change the way the submitted data is retrieved.

To see how the current process does that, double-click the Push to Repository task and take a
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look at the task's properties. The xmliget() function, used in the Value fields, is a data selection
function (see Data Selections). Data selection functions are available in many plugins, in any
field that accepts variables. Try right-clicking a field and select Get Data Location from the
contextual menu. (See also: Variable Task Properties.)

For general information about processes in Workflow see About Processes and Subprocesses,
in the Online Help of Workflow.

Project Wizard: Serving a Web Page

The Serving a Web Page Project Wizard creates an OL Connect project that responds to a
request by serving a web page. This project extracts data from a parameter in the given URL
and shows the value on the web page.

For an introduction to this Project Wizard, see Project Wizards overview video on the OL Learn
website (start at 12:44) or on Youtube: Serving a Web Page.

Installing the project

To start the Project Wizard, select File > New > Project Wizards > Serving a Web Page from
the menu. (See also: "Serving a Web Page - Project Wizard" on page 1017.)

Note

In order to use the project, OL Connect Server and OL Connect Workflow must be
installed on the local machine.

The wizard lets you select the folder in which you want the solution to be installed.

In the selected folder, the Project Wizard will create two subfolders: Configurations and
Workspace.

The project's resource files are saved to the Configurations folder.

The Workspace folder is used for debugging or running the solution. It has an In folder that
may be used to monitor incoming data and an Out folder to write output files to.

The selected folder's path is saved to a global variable in the Workflow configuration (see "The
Workflow configuration" on page 183).
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Testing and running the project

Once the Project Wizard has finished the installation, the project is ready to be tested.

If the templates and data mapping configurations haven't been sent to Workflow yet, do that
first (see "Sending files to Workflow" on page 461).

This requires that the Workflow service is running (see Starting the Workflow service in
Workflow's Online Help).

To test the project:

1. Send the Workflow configuration to the OL Connect Workflow service; see Saving and
sending a Workflow Configuration in Workflow's Online Help.

2. Access the web page by entering the following URL in a browser on the machine that
runs Workflow: http://localhost:9090/hello.

3. Follow the instructions on the page to see how values in the URL change the text of the
page.

Saving input as sample data

Testing a process in Debug mode is only possible with a sample data file. The process is pre-
configured to use the Sample Data.xml file located in the Configurations\Data folder.
To create your own sample data file:

1. Locate the Workflow configuration in the Configurations\Workflow folder and open itin
Connect Workflow.

2. Select the process.
3. Enable the Send to Folder step (step 2 in the process).

4. Send the Workflow configuration to PlanetPress Workflow service (see Saving and
sending a Workflow Configuration) and run it again, with a custom name value.
The Send to Folder step will now write the input data - the job file - to a file in the
Workspace\Debug folder.

When you select the file as sample file (on the Debug ribbon), it can be used to debug the
process. Note however that the process will not return the web page to a browser, as it wasn't
started by a browser.
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Tip

The saved file can be used to create a data mapping configuration.

Project details

The web template

The web page is designed in the WEB_HELLO Web Page template. It contains one Web
section (see "Web pages" on page 556).

Styling is done via style sheets (see "Local formatting versus style sheets" on page 752). The
style rules are in the context web_styles.css file. Note how they combine the HTML tag, ID and
class of elements to select them. (See also: "Selectors in Connect" on page 905.)

There are only two scripts in the template, as you can see on the Scripts pane. You can
double-click to open them.

Tip
Hover over the name of a script in the Scripts pane to highlight parts of the template that
are affected by the script.

« The My name is script looks for an element that has the ID: hero. Inside that element it
looks for the text: @name@ and replaces that with either the default name ("John Doe") or
the name given in the URL.

« The Year script puts the current year in the footer.

For more information about writing scripts, see: "Writing your own scripts" on page 884.

Tip
You don't have to write a script yourself if you just want to insert some data directly into

the template. You could simply drag-and-drop the data on the template or use the Text
Script Wizard (see: "Variable Data" on page 813).
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The Workflow configuration

The project's Workflow configuration, Serving a Web Page.OL-workflow, contains just one
process. Itis a simple OL Connect Web process (see "Web processes with OL Connect tasks"

on page 194).

The NodedS Server Input task's HTTP action is set to hel1o. This means that this process will
be invoked whenever someone tries to access the Workflow server with this URL: http://

{server's address}/hello.

The Delete task is an Output task that does nothing, actually; it doesn't even remove anything.
However, this step is useful when running the project step by step in Debug mode. If it wouldn't
be followed by another task, the Create Web Content task would not return its output to the
Workflow process, where it can be viewed (click View as HTML).

The data mapping configuration

When the browser sends the request to Workflow, the Workflow process starts and puts the
request into XML, including the values that were given in the URL. To extract those values from
the ‘job file' (the XML) the process uses a data mapping configuration, made with the
DataMapper: WEB_HELLO Data.

To open the data mapping configuration, select File > Open from the menu and browse to the
Configurations\Resources folder.

To create the data mapping configuration, the input data needed to be saved to a file first (see
"Saving input as sample data" on page 181).

The sample data file is located in the Configurations\Data folder, but you will also see it when
you open the data mapping configuration itself:

For more information about data mapping configurations see "The DataMapper" on page 202.

Customizing the project

A project is a great starting point for building an OL Connect solution. This part explains how to
make changes to the project.

Do you intend to expand the projectinto a solution where Workflow runs on a different machine
that also has a different regional setting? Then indicate the desired encoding in the Designer
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preferences (see "Project Wizard deployment settings" on page 878) before installing the
project.

Input data
If you want to add other parameters to the URL and use those data in the template, here's how
to do that:

1. Run the project, add more parameters to the URL and let the process save the input data
to a file (see "Saving input as sample data" on page 181).

2. Use the file to create a new data mapping configuration that extracts the additional data.
(See "Creating a new data mapping configuration" on page 204.)

3. Send the new data mapping configuration to Workflow (see "Sending files to Workflow"
on page 461).

4. Open the Workflow configuration, double-click the Execute Data Mapping task to open it
and select the new data mapping configuration.

5. Use the data in the template (see: "Personalizing content" on page 796), send the new
template to Workflow and select itin the properties of the Create Web Content task.

6. Send the Workflow configuration to the server (see Saving and sending a Workflow
Configuration in Workflow's Online Help).

Alternatively you could use input data from a Web form. This is demonstrated by another
Project Wizard: .

Web page

There are countless ways to modify the template. You could add text, images and other
elements (see "Content elements" on page 640) and change the layout (see "Styling and
formatting" on page 752).

In order to further personalize the web page, open your data mapping configuration (or JSON
data, if the input data will be in that format; see "Adding JSON sample data" on page 810) and
use the data fields to personalize the page. (See: "Personalizing content" on page 796.)
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Tip
The Designer can have one data mapping configuration and one template open at the
same time. Use the tabs at the top of the workspace to switch between the two. Click the

synchronize button on the Data Model pane to make sure that the Data Models are the
same in both.

Once the template is ready, send it to Workflow (see "Sending files to Workflow" on page 461).

Finally, in Workflow, adjust the process: double-click the Create Web Content task to open it,
and select the new template. This is only necessary when the file name has changed.

Send the Workflow configuration to the server (see Saving and sending a Workflow
Configuration in Workflow's Online Help).

Note

If you want the web page to be responsive (have a different layout on screens of different
sizes), itis recommended to start a new template with a wizard; see "Creating a Web
template with a Wizard" on page 551.

Workflow configuration

The current Workflow configuration is very simple. In a real-life solution, a process that
generates a web page could be part of a larger solution, in which, for example, emails are
generated with a link to a personal landing page.

For general information about processes in Workflow see About Processes and Subprocesses,
in the Online Help of Workflow.

Workflow processes in OL Connect projects

About Workflow processes

A Workflow configuration consists of one or more processes. Each of these processes waits
until it is time to run or until it receives the necessary input, and then does its job. A process is
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made up of tasks (also referred to as plugins). In the Workflow configuration tool they are
divided into groups. For example:

« Input tasks look for certain input data on a certain channel and start a process when they
find it. The data that enter the process are handed from one plugin to the nextin the form
of a file: the 'job file".

« Process logic tasks help you to control the process, for example by branching it, creating
a loop, or referring to another process or a subprocess.

« Action tasks perform a wide variety of operations.

« Metadata - data about a job, kept in the process - can be accessed and manipulated
using Metadata tasks.

« OL Connect tasks enable the process to communicate with the Connect Server and/or
database. (See: "OL Connect tasks" on the next page.)

A process ends with an Output task.

Note

Workflow was originally developed - and is still used - as part of PlanetPress Suite.
Nevertheless, most plugins are just as useful in Connect as in PlanetPress Suite. Where
plugins are restricted to one software package or the other, itis indicated in Workflow's

Online Help.

Common OL Connect Workflow processes

In an OL Connect project there are typically a number of Workflow processes that communicate
with the Connect Server and/or database through one or more of the OL Connect tasks.

These are the most common Workflow processes in Connect solutions.
» Print process. A process that results in print output implements either the typical OL

Connect Print plugins, or the All in One plugin which combines the Print plugins; see
"Print processes with OL Connect tasks" on page 192.

« Email process. An email process outputs one or more emails; see "Email processes with
OL Connect tasks" on page 190.
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« Web process. A web process serves one or more web pages. The output can vary from a
plain and simple web page to an extensive web form. See: "Web processes with OL
Connect tasks" on page 194.

o COTG processes. The process that creates a form for the Capture OnTheGo app is in
essence a web process, buta COTG solution consists of more than one process. The
typical COTG processes are described here: "Capture OnTheGo Workflow processes" on

page 189.

Tip

Project Wizards

The OL Connect software comes with a number of Project Wizards that generate a
Workflow configuration, and any Connect templates, data mapping configurations, and
Print Presets required to make the project work. For more information, see "Project
Wizards" on page 1010 in the online help or the Project Wizards overview video on the

OL Learn website.

In each process, runtime parameters can pass variables from PReS Connect Workflow to the
template, data mapping configuration or Job Creation Preset. For more information see
"Runtime parameters" on page 1527.

OL Connect tasks

In Workflow there is one set of plugins developed especially for OL Connect: the OL Connect
tasks. These plugins are designed to communicate to the OL Connect Server and database,
and work with components that are only available within OL Connect: templates, data mapping
configurations, and Print Presets.

This topic describes the available OL Connect tasks, which are commonly used in Workflow
processes in OL Connect projects (see "Workflow processes in OL Connect projects"” on

page 185).

Data extraction

The Execute Data Mapping task is likely to appear in a lot of OL Connect Workflow processes.
It generates a record set in the OL Connect database by executing a data mapping
configuration on a data source.

Page 187



https://learn.objectiflune.com/videos/project-wizards-overview/
http://help.objectiflune.com/en/PReS-workflow-user-guide/2021.2/#Workflow/TasksProperties/OLConnect-ExecuteDataMappingTask.html

Output creation

Merging the records with a template is the job of one of the following tasks.

Email

The Create Email Content task creates email content items and sends them to the recipient.
See "Email processes with OL Connect tasks" on page 190.

Web

The Create Web Content task can handle only one record at a time and returns a web page.
See "Web processes with OL Connect tasks" on page 194.

Print

The Create Print Content task generates a set of Print content items in the OL Connect
database, but it is not an Output task. Following this task, the Create Job task assembles Print
contentitems into a Print job. The Create Output task turns the job into a print output file.

The All In One task combines the four tasks involved in a Print process. If a process's only goal
is to create Print output, this task is often the better choice because it is faster and more
efficient. (See "Print processes with OL Connect tasks" on page 192.)

However, sometimes using the separate tasks is inevitable.

For example when you want to merge jobs with the Merge Jobs task, or when Print content
items created at different times should be put into the same job, or when the same extracted
data should be used to create different kinds of output.

The Create Preview PDF task generates a PDF preview for a single record as fast as possible.
This preview is typically used for PDF previews embedded in web pages.

PlanetPress Suite Documents

The Create PDF/VT task creates PDF/VT files from a PlanetPress Suite Document (created
with PlanetPress Design). This PDF/VT is compatible with the Create Print Content task
directly, without the use of an OL Connect template (PDF/VT mode).

OL Connect database

The following tasks let you act directly upon the OL Connect database:
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« The Set Properties task adds properties as tags to items/sets in the OL Connect
database.

« The Retrieve ltems task retrieves items (records, or content items, etc.) or sets of items
from the OL Connect database, by ID or by property.

Note

Combined, the Set Properties and Retrieve ltems tasks make it possible to batch
and commingle Print content items.

The following two tasks use the Metadata (data about the current job, maintained in the
Workflow process; see Metadata) to do something with records in the Connect database:

« The Mark Connect Sets for Deletion task marks the sets found in the current Metadata as
'to be deleted' in the OL Connect database, so that they will be deleted the next time the
database's Cleanup process runs.

« The Update Data Records task updates records in the OL Connect database using
values from the current Metadata.

File Store

The OL Connect Server has a File Store which it uses for transient files. This File Store is
managed by the Cleanup service who takes care of removing obsolete files when those files
are not marked as permanent.

You can make use of the File Store in your own Workflow processes. The Workflow
configuration tool has three tasks to that end: the File Store - Upload File task, File Store -
Download File task, and File Store - Delete File task.

Capture OnTheGo Workflow processes

A Capture OnTheGo solution requires no less than three basic processes in a Workflow
configuration:

« One process that generates a document (most often, a form), stores it and notifies the
COTG app of the document's existence. Note that this process doesn't send the actual
document. It sends a ticket to the Capture OnTheGo Server so that when the intended
user logs in, the name of the document will appear in the app's Repository, signaling to
the user that the document can be downloaded.

The key task in this process is the Output to Capture OnTheGo plugin.
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« One process that authenticates and replies to document requests from COTG users. This
process returns the actual document directly to the app. It starts with a Server Input task
(the NodedS Server Input task or the older HTTP Server Input task), which returns the
final output of the process to the caller.

« One process that receives and handles the data when a COTG user submits a form. This
process starts with a Server Input task as well.

The three basic processes are described in more detail in the Capture OnTheGo manual: Basic
processes involved in COTG

Tip
An easy way to create a COTG solution, including the Workflow configuration and other

files that it needs, is to use the COTG Timesheets Project Wizard. See "Project Wizard:
COTG Timesheets" on page 152.

Email processes with OL Connect tasks

Sending out emails, based on a Connect template, via an automated process requires you to
design a Connect email process in the Workflow configuration tool.
This topic explains which tasks and files are used in a Connect email process.

Tip
An easy way to create a Connect email project, including the Workflow configuration and
the files that it needs, is to use a Project Wizard. See "Project wizard: Basic Email" on

page 145.

The structure of an OL Connect email process

In an OL Connect Email process only one plugin is essential: the Create Email Content
plugin.

The Create Email Content task creates a set of emails, using the Email contextin a Connect
template, and sends them to the email server.

You have to select the Connect template in the task's properties.

If the template doesn't need any data, you can set the Data Source of this task to JSON and
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enter an empty JSON string: {}.
However, if the template should be merged with data, you will need to add one or more tasks to
provide the required data. The Create Email Content task must receive either Metadata

containing information regarding a valid Record Set, or JSON data. This can be the output of
tasks like:

« An Execute Data Mapping task which retrieves data from the job file (such as the
request XML). In addition to creating records in the Connect database, this task can
output the (IDs of the) records in the Metadata.

« A Retrieve Items task which retrieves an existing record set from the Connect database
and outputs it in the Metadata or as JSON data.

« A Create File task that creates a JSON file.
« Etc.

Which task or tasks fit best, depends on where the data come from.

The Create Email Content task can be found on the OL Connect tab of the Plug-In Barin
Workflow.

For a description of all OL Connect tasks, see "OL Connect tasks" on page 187.

Files used in a Connect email process

Before creating the Email process in the Workflow configuration tool, you will need to create:

« A template with an Email context. (See "Creating a template" on page 456.)

« If the email should contain variable data, you might need to make a data mapping
configuration (see "Creating a new data mapping configuration" on page 204). If the input
is going to be JSON data, you could add them to the design using a JSON file (see
"Adding JSON sample data" on page 810).

Templates and data mapping configurations must be sent from the Designer to PReS Workflow
before they can be used in the Workflow process; see "Sending files to Workflow" on page 461.

The next step is to create a process in PReS Workflow that generates Email output, using these
files.

For more information about how to create a process in Workflow, please refer to the Online
Help of Workflow.
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Print processes with OL Connect tasks

Generating print output from a template via an automated process requires you to design a print
process in the PReS Workflow configuration tool.
This topic explains which tasks and files are used in a print process.

Tip
An easy way to setup a print project in OL Connect, including the print process and the

files that it needs, is to use a Project Wizard. There are two Project Wizards that create a
sample print project. See "Project Wizards" on page 1010.

There is also a Walkthrough sample that helps you build a Print process for Connect
documents in the Workflow Configuration tool by yourself, step-by-step: Creating a Print
process in Workflow.

The structure of a print process

In its simplest form, such a process may consist of only two plugins: an Input task and the All In
One plugin.

The All In One task combines the following four OL Connect tasks:

« The Execute Data Mapping task, or the Retrieve Items task.
The Execute Data Mapping task extracts data from the job data file and puts themin a
record set. This task works according to the instructions in a data mapping configuration,
made with the DataMapper (see "Data mapping configurations" on page 203).
The Retrieve Items task can be used to retrieve records from the OL Connect database.

« The Create Print Content task. This task merges data with a template, resulting in Print
Content ltems. Templates are made with the Designer (see "Templates" on page 456).

« The Create Job task. This task turns a set of Print Content ltems into a print job. Any
settings are passed on to Workflow via a Job Creation Preset.

« The Create Output task. This task creates the actual output file(s). Any settings are
passed on to Workflow via an Output Creation Preset.

The All In One task is the fastest and most efficient way to create print output. The task
exchanges less data with the server than the separate plugins do and it has multi-threading
support: it can produce the data set and content items in parallel.
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Nevertheless, the separate plugins would be used in the following situations:

« The record set, created by the Execute Data Mapping task, is also needed to create
another kind of output in the same process.

« The inputis JSON data, which can be used directly. In this case there is no need to use
the Execute Data Mapping task or Retrieve ltems task.

« Ifthe input data is paginated (e.g. a PDF) and doesn't need to be merged with a template,
the Execute Data Mapping task can create Print Content ltems as well. This makes it
possible to omit the Create Print Content task.

« The necessary Print Content Items have already been created, whether in the same orin
another Workflow process. Print Content ltems can be retrieved from the OL Connect
database using the Retrieve ltems task. Subsequently, the Create Job and Create Output
tasks can generate print output from them.

Note that at the time the Print Content Items are created, their ID or the Print Content Set
ID needs to be stored somewhere where the print process can access them, in order to
retrieve the Print Content ltems.

The tasks mentioned here can all be found on the OL Connect tab of the Plug-In Bar in
Workflow. For a description of each task, see "OL Connect tasks" on page 187.

Files used in a print process

Before creating the print process in the Workflow configuration tool, you will need to create:

« Atemplate with a Print context. (See "Creating a template" on page 456.)

In addition, the process may use:

« A data mapping configuration, or a data model at the very least, if the documents should
contain variable data. (See "Creating a new data mapping configuration" on page 204.)

« A Job Creation Preset. (See "Job Creation Presets Wizard" on page 1178.) A Job
Creation Preset defines where the output goes and makes it possible to filter and sort
records, group documents, and add metadata.

o An Output Creation Preset. (See "Output Creation Presets Wizard" on page 1194.) An
Output Creation Preset can split a print job into smaller print jobs, and set printing options
such as binding, OMR markings and the like.

All of these files are made with the Designer and need to be sent to PReS Workflow before they
can be used in the Workflow process; see "Sending files to Workflow" on page 461.
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When the necessary files have been created and sent to Workflow, the next step is to create a
process in PReS Workflow that generates Print output, using these files.

For more information about how to create a process in Workflow, please refer to the Online
Help of Workflow.

Web processes with OL Connect tasks

Serving a web page, made with a template, via an automated process requires you to design a
web process in the PReS Workflow configuration tool.
This topic explains which tasks and files are used in a web process.

Tip
An easy way to start an OL Connect web project including the web process and the files

that it needs, is to use a Project Wizard. There are two Project Wizards that generate a
sample web project. See "Project Wizards" on page 1010.

Note

With a trial or reseller license, Connect Web outputis limited to the localhost. This means
that the Connect Server and Workflow must be on the same workstation in order to create
Web output.

The structure of a web process

In a web process two plugins are essential:

« An Input task.
o The Create Web Content plugin.

If the Input task is a Server Input task, that task will return the output of the process - the web
page - to the caller.

The HTTP Action of the Server Input task determines how the process is triggered. If, for
example, the HTTP Action is /hello, the process will be invoked when the Workflow server
receives a request for a resource called hello. (You could, for example, trigger the process by
typing the following URL in the address bar of your browser: http://localhost:9090/hello, if the
browser runs on the same machine as the Workflow server and the Input task is a NodeJS
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Server Input task. The protocol could be HTTPS, depending on the settings of the Input task.)
To trigger the process from a Web Form, set the Action of the Form to the HTTP Action of the
Input task. (See "Forms" on page 723.)

The Create Web Content task creates an HTML output file from the Web context in a template.
Select the Web template in the task's properties.

If the Web template doesn't need any data, you can set the Data Source of this task to JSON
and enter an empty JSON string: {}, or set it to Record ID and enter O (zero).

However, if the template should be merged with data, the task needs either a valid Record ID or
a JSON object. In that case, one or more steps must be added to the process to provide the
required data. For example:

« An Execute Data Mapping task that retrieves data from the job file (such as the request
XML). This task outputs one or more records to the Metadata. By default, the Create Web
Content task uses the first Record ID from the Metadata.

« A Retrieve Items task that retrieves an existing record from the OL Connect database and
outputs itin the Metadata or as JSON object.

Which task or tasks fit best, depends on where the data must come from.

Of course, numerous other tasks could be added to the process. If you'd want to save the output
of the Create Web Content task - the web page - to a file, for example, the task would have to
be followed by a Send to Folder task.

The Create Web Content task can be found on the OL Connect tab of the Plug-In Bar in
Workflow.
For a description of all mentioned OL Connect tasks, see "OL Connect tasks" on page 187.

Files used in a web process

Before creating the web process in the Workflow configuration tool, you will need to create:

« A template with a Web context. (See "Creating a template" on page 456.)

« Ifthe web page should contain variable data, you might need to make a data mapping
configuration (see "Creating a new data mapping configuration" on page 204). If the input
is going to be JSON data, you could add them to the design using a JSON file (see
"Adding JSON sample data" on page 810).
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Templates and data mapping configurations need to be sent from the Designer to PReS
Workflow before they can be used in the Workflow process; see "Sending files to Workflow" on

page 461.

The next step is to create a process in PReS Workflow that generates Web output, using these
files.

For more information about how to create a process in Workflow, please refer to the Online
Help of Workflow.

Batching and commingling

A Connect Print process in its simplest form merges data with a template and creates the print
job(s) in one go, as shown in "Print processes with OL Connect tasks" on page 192.

In reality, however, a company might want to create letters and invoices during the week, for
example, and then print them out only over the weekend. For such a scenario, it would be better
to separate the data mapping and content creation process from the production of the actual
print job(s), and work with print batches.

Batching means gathering and then printing previously created print content items.
Commingling refers to documents originating from different templates being combined into one
print batch.

This topic explains how to batch, commingle, and - not the least importantly - sort and separate
items into print batches with Connect.

The Workflow tasks mentioned here can all be found on the OL Connect tab of the Plug-In Bar
in Workflow. For descriptions of the tasks, see "OL Connect tasks" on page 187.

Batching

Batching refers to creating print jobs from print content items that were created earlier. A
batching print process is split up in 2 phases:

« Phase 1: Contentis created by merging a print template with data. Newly created print
content items are always automatically saved in the Connect database. Information
about the set of items (the "content set"), including the Content Set ID, gets stored in the
database as well.
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« Phase 2: Print content items are retrieved from the Connect database using the Retrieve
ltems task. The Create Job and Create Output tasks transform these items or sets into one
or more print jobs.

In order to retrieve print content from the Connect database in the second phase, some
preparatory work must be done in the first phase. What needs to be done exactly depends on
what you want to retrieve, and how.

Sorting and separating the output also requires some preparation (see "Sorting and grouping
items in print batches" on page 199).

'Database entries get cleaned up automatically as well. Make sure that the Cleanup Service is
configured appropriately, so that it doesn't remove relevant record sets and content sets before
batching starts (see "Clean-up Service preferences" on page 856).

What to retrieve: content sets or content items

The Retrieve Items task can retrieve only one type of entity from the Connect database ata
time: records, record sets, content items and so forth. Since the Create Job task can only work
with print content items or content sets, in a batching print process the choice is narrowed down
to these two possibilities.

Here are a few things to consider:

« Ifyou want the Create Job task to use a Job Creation Preset, you must retrieve content
sets. A Job Creation Preset can filter, sort, and group print content items, add meta data
and make finishing settings (see "Print Presets" on page 1488).

» From a performance perspective, working with content sets is better. Retrieving content
sets is faster than retrieving content items and thus can improve performance. Also,
working with Job Creation presets is more efficient than working with individual content
items in Workflow.

« If you decide to retrieve content sets, you may still have to do preparatory work on the
contentitem level to enable a Job Creation preset to sort the output (see "Sorting and
grouping items in print batches" on page 199).

How to retrieve: selection methods

The Retrieve Items task can retrieve items/sets by ID or based upon conditions.
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Retrieving items/sets by ID

New print content items are automatically saved in the Connect database when the Create
Content task creates them. The task returns the IDs of those items, as well as the ID of the
content set, to the Workflow process via Metadata (see About Metadata).

In order to retrieve (sets of) items by ID later on, you will have to get the IDs from the Metadata
and store them somewhere else. Workflow's Data Repository would be a good place to store
them in; you can use the Push to Repository task to store the IDs there.

Retrieving items or sets using conditions

When the Retrieve Items task retrieves items or sets based upon conditions, the respective
database entities are matched against the values of data fields or by the values of properties
set on entities in the Connect database.

« Values: Print content items and sets don't contain data fields, but they do have a link to
the data record with which they were created, so selecting and sorting them by value is
still a possibility.

« Properties are key/value pairs that can be set on entities in the Connect database. There
are two ways to do that:

« Using the Set Properties task.
Ideally, the Set Properties task directly follows the Create Print Content task in a
Workflow process. The Create Print Content task returns the IDs of the content items
as well as the ID of the content set to the process via the Metadata. Using those IDs,
the Set Properties task can either set properties on all new Content ltems or on the
Content Set that was just created.
Use two consecutive Set Properties tasks to set properties on both levels.

« Through a Post Pagination script in the template. (See "Post Pagination Scripts" on
page 936 and "contentitem" on page 1456.)

In order to retrieve (sets of) items by data values, you may have to adjust the data mapping
configuration (see "Data mapping configurations" on page 203).

Note that a property can only be used to retrieve entities on the level on which the property
was explicitly set. For example, when you set a property on a content set, you can only use that
property to retrieve the content setin its entirety (i.e. all content items that belong to that content
set); itisn't possible to retrieve individual content items using that property. Properties added to
a content set are not propagated to the individual items in that content set.

To label both a set and the items in it, use the Set Properties task twice.
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Note

Data field values and properties of items in the Connect database are also used when
sorting the output. Make sure to set properties that are necessary for sorting on the
content item level.

Commingling

When documents in one print batch originate from different templates, that is called
commingling.

Commingling isn't very different from batching in how it's done. The content creation phase will
likely be a little different, as there will probably be a separate process or branch for each of the
templates used to create the print content.

However, sorting and grouping can become more important when print content items are
commingled. For instance, when invoices and letters are commingled, they probably need to be
grouped per customer, and sorted in a certain way. Ensure that there is a unique ID in the
different data sets that can be used to group items together that belong to the same mail piece.

Sorting and grouping items in print batches

Print content items can be grouped and sorted by the values of data fields or by the values of
properties set on them in the Connect database.

» Values: Print content items and sets don't contain data fields, but they do have a link to
the data record with which they were created, so selecting and sorting them by value is
still a possibility.

« Properties are key/value pairs that can be set on entities in the Connect database. There
are two ways to do that:

« Using the Set Properties task.
Ideally, the Set Properties task directly follows the Create Print Content task in a
Workflow process. The Create Print Content task returns the IDs of the content items
as well as the ID of the content set to the process via the Metadata. Using those IDs,
the Set Properties task can either set properties on all new Content ltems or on the
Content Set that was just created.
Use two consecutive Set Properties tasks to set properties on both levels.
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« Through a Post Pagination script in the template. (See "Post Pagination Scripts" on
page 936 and "contentitem" on page 1456.)

Sorting by property is only possible if the property has been set explicitly on the respective
content items (not content sets) in the Connect database.

Itis also important to note that in order to use a data field or property in a sorting rule, it should
be presentin all content items.

You may have to set properties on content items (not content sets) or add data fields to a data
model (see "Data mapping configurations" on page 203), for no other reason than to sort the
items by them eventually.

In Connect there are two places where you could group and sort print content after it has been
retrieved from the Connect database:

« In a Job Creation Preset.

« On the Batching/Commingling tab of the Retrieve ltems task.

Job Creation Preset

Based on the settings in a Job Creation Preset, the Connect Server can filter, sort, and group
print content items, add meta data and make finishing settings (see "Job Creation Presets" on
page 1489). Compared with the Batching/Commingling tab of the Retrieve ltems task, a Job
Creation Preset offers a /ot more options. It is also usually more efficient; that's why it's the
recommended method, for larger jobs at least.

A Job Creation Preset can only take content sets as input. So, if you want to use a Job
Creation Preset, the Retrieve ltems task must retrieve content sets from the Connect database,
not content items.

This also means that if you want to use properties in conditions to retrieve the correct items,
those properties must be set on the content set level.

However, any properties that you want to be used for filtering, grouping or sorting must be set
on the content items.

Batching/Commingling tab of Retrieve ltems task

The Batching/Commingling tab of the Retrieve Items task allows you to group and sort print
content on two levels. You can:
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« Bundle contentitems into "documents" (mail pieces) and sort the items within each
document.

o Putdocuments in "groups", and define how documents are sorted within a group.

Note that this tab is only available when the Retrieve ltems task is configured to retrieve
content items - not content sets.

Separating the output

Print output in batches can be separated just like all other print output, using an Output Creation
Presetin the Create Output task (see "Output Creation Presets" on page 1492).

This requires that the output be grouped beforehand, either via a Job Creation Preset or via the
Batching/Commingling tab of the Retrieve ltems task.

Note that the terminology used on the Batching/Commingling tab and in an Output Creation
Preset is slightly different.

« Select Document Set in the Separation Settings to separate the "documents" defined on
the Batching/Commingling tab.

« Select Job Segment in the Separation Settings to separate the "groups" defined on the
Batching/Commingling tab.
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The DataMapper

The DataMapper is the tool to create a data mapping configuration. Data mapping
configurations are used to extract data and transpose that data into a format that can be shared
amongst different layouts and outputs created with the OL Connect Designer and Workflow.

The original data, located in a file or database outside of OL Connect, is called a data source.
The first step in the data extraction process is making settings for the input data (see "Data
source settings" on page 231), including boundaries for each record inside the data sample.
When you define the boundaries, you are actually defining a series of records inside your data
sample file.

After configuring these settings you can start working on the logic to extract data from each of
those records. You need to identify and extract data from each record. To achieve this, you will
create a data mapping workflow, consisting of multiple steps (extractions, loops, conditions and
more) (see "Data mapping workflow" on page 228 and "Extracting data" on page 238).

When this process is complete, the resultis a Data Model. This model contains the necessary

information to add variable data to OL Connect Designer templates. (see "The Data Model" on
page 274 for more information). It has a generic format with an emphasis on content, free from

any restrictions imposed by the file types or the origin of the data. This allows a same layout or
output to be populated with data from different sources and formats without the need to modify

it.

DataMapper basics

Connect’s DataMapper lets you build a data mapping workflow to extract data from a variety of
data sources. The data mapping workflow consists of multiple 'steps' which process and extract
data from each record of a data source and store it in a new, extracted record set. The data
mapping workflow is saved in a data mapping configuration.

1. Create a new data mapping configuration.
Run the Designer and start creating a data mapping configuration by selecting a data
source. See "Data mapping configurations" on the next page.

2. Configure settings for the data source.
The data source can be a file (CSV, PDF, TXT, XML, JSON) or a particular database.
Configure how the data source is read by the DataMapper and create a record structure.
See "Data source settings" on page 231.
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3. Build the data mapping workflow.
A data mapping workflow always starts with the Preprocessor step and ends with the
Postprocessor step. You can add as many steps as you like and edit the Data Model of
the extracted data as required. See "Data mapping workflow" on page 228 and "The Data
Model" on page 274.

What's next?

Use the data mapping configuration in the Designer module to create templates for
personalized customer communications. To learn more, see "The Designer" on page 454.

In Workflow, a data mapping configuration can be used to extract data. The extracted data can
then be merged with a Designer template to generate output in the form of print, email or a web
page. See Workflow and "OL Connect tasks" on page 187.

Data mapping configurations

A data mapping configuration file contains the information necessary for data mapping: the
settings to read the source file (Delimiter and Boundary settings), the data mapping workflow
with its extraction instructions ('Steps'), the Data Model and any imported data samples.

Data mapping configurations are used in the Designer to help add variable data fields and
personalization scripts to a template. In fact, only a Data Model would suffice (see
"Importing/exporting a Data Model" on page 275). The advantage of a data mapping
configuration is that it contains the extracted records to merge with the template, which lets you
preview a template with data instead of field names.

It is also possible to generate output of a data mapping configuration directly from the Designer
(see "Generating output" on page 1480).

Ultimately data mapping configurations are meant to be used by "OL Connect tasks" on

page 187 (i.e. the Execute Data Mapping task or All in One task) in OL Connect Workflow
processes, to extract data from a particular type of data file. Typically the extracted data is then
merged with a template to generate output in the form of print, email and/or a web page. To
make this happen, the data mapping configuration as well as the template and any Print
Presets have to be sent to Workflow; see "Sending files to Workflow" on page 461.
Alternatively these files can be sent to the Connect Server directly; see "Sending files to
Connect Server or to another server" on page 462.
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Note

AFP inputis dependent on a third party library (CDP), which only allows PReS Connect
to run up to 4 AFP input processes on a given machine at a given time.

Creating a new data mapping configuration

A new data mapping configuration can be made with or without a wizard. When you open a
data file with a DataMapper wizard, the wizard automatically detects a number of settings. You
can adjust these settings. Next, the wizard automatically extracts as many data fields (or
metadata, in case of a PDF/VT or AFP file) as it can, in one extraction step.

Without a wizard you have to make the settings yourself, and configure the extraction workflow

manually.

Note

The DataMapper doesn’t use the data source directly, rather it uses a copy of that data: a
data sample. Although the data sample is a copy, itis updated each time the data
mapping configuration is opened or whenever the data sample is selected.

More samples can be added via the Settings pane; see "Data samples" on page 341.

From a file

To start creating a data mapping configuration without a wizard, first select the data file. There
are two ways to do that: from the Welcome screen and from the File menu.

o From the Welcome screen

1. Click New DataMapper Configuration.

2. From the From a file pane and select a file type:

Comma Separated Values or Excel (CSV/XLSX/XLS),
Microsoft Access

PDF, PS, PCL or AFP

Text

XML

JSON
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3. Click the Browse button and open the file you want to work with (for a database,
you may have to enter a password).

4. Click Finish.
« From the File menu
1. Click the File menu and select New.

2. Click the Data mapping Configuration drop-down and select Files and then the
file type:

o Comma Separated Values or Excel (CSV/XLSX/XLS),

« Microsoft Access

. PDF, PS, PCL or AFP

o Text

o XML

. JSON
3. Click Next.
4. Click the Browse button and open the file you want to work with.
5. Click Finish.

After opening the file, you have to make settings for the input data (see "Data source settings"
on page 231) to make sure that the source data is parsed correctly and divided into logical units
of data the way you want. Then you can start building the data extraction workflow.

Note

« Also select XML if you want a JSON file to be converted to and treated like XML. If
there is no root element in the JSON it will be added and each object without a
named parent element is called an 'item".

Note that in addition to being valid, the JSON should follow naming rules for XML
elements. For example, "adress_line_1:" is a valid key name in JSON, but it cannot
be converted to a valid element name in XML because the colon is reserved for
namespaces. For XML naming rules and best naming practices, see: XML elements
on W3Schools.

« Excelfiles saved in "Strict Open XML" format are not supported yet.
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o PCL and PostScript (PS) files are automatically converted to PDF format by the
Connect Server. To allow for this, the default Connect Server and (if itis secured)
an authenticated user must be configured via the Preferences (see "Connect
Servers preferences" on page 881).

Note that when used in a production environment (e.g. a Connect Workflow
process) the conversion to PDF may influence the processing speed, depending on
the available processing power.

- Some advanced PCL to PDF options are available by calling LincPDF (PReS
Connect's PCL to PDF converter) command line module; see "Advanced PCL to
PDF options" on page 220.

« Extracting data from a PDF that comes from a Windows printer queue (a PDF
converted to PostScript, converted back to PDF by an Input task in Workflow) might
not work. The problem lies in the conversion of the original PDF to PostScript.
PostScript code is usually optimized to print and not to keep text searchable, by
maintaining character identities for example.

The rule of thumb is: if copy-paste from Acrobat works, so will data mapping; if not,
the DataMapper won't either. If the original is a PDF, itis recommended to find an
alternative way to get it in the system instead of going through a print operation.

« Rotated pages in a PDF are supported (if rotated 0/90/180/270 degrees). The
Extract step will be able to extract data from horizontal and vertical lines of text on
rotated pages. Motion steps (such as the Repeat step and the Goto step) however,
can only work as expected if text on a page has the same orientation as the page,
not when text has been rotated after the page was rotated.

The page number and rotation of a page are shown in the status bar at the bottom,
next to the region selection information.

With a wizard

Data mapping wizards are available for PDF/VT, AFP, XML, JSON, CSV and database tabular
files, because these files are structured in a way that can be used to automatically set record
boundaries.

The wizard for PDF/VT and AFP files cannot extract data, only metadata. After opening such a
file with the wizard, you can build the data extraction workflow for data and metadata in the
PDF.

The other wizards use the Extract All step to extract data, but they cannot create detail tables,
so they are less suitable for files from which you want to extract transactional data.
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There are two ways to open a data file with a wizard: from the Welcome screen or from the File
menu.

« From the Welcome screen

1. Open the PReS Connect Welcome page by clicking the ¢ icon at the top right or
select the Help menu and then Welcome.

2. Click New DataMapper Configuration.

3. From the Using a wizard pane, select the appropriate file type.
o From the File menu

1. In the menu, click File > New.

2. Click the Data mapping Wizards drop-down and select the appropriate file type.
The steps to take with the wizard depend on the file type. See:

"Using the wizard for CSV and Excel files" on page 210

« "Using the wizard for databases" on page 212
« "Using the wizard for PDF/VT or AFP files" on page 217

« "Using the wizard for XML files" on page 219. This wizard can also be used for JSON
files.

Generating a counter

Instead of creating a data mapping configuration for a certain type of data file, you may create a
data mapping configuration that only contains a series of sequential numbers. This is a solution
if, for instance, you need to create sequential tickets or anything that has an ID that changes on
each record.

Note

You can’tjoin this configuration to another data file. It is just a counter to be applied on a
static template.

To generate a counter:
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« From the Welcome screen

1. Open the PReS Connect Welcome page by clicking the ¢ icon at the top right or
select the Help menu and then Welcome.

2. Click New DataMapper Configuration.

3. From the Using a wizard pane, select Generate counters.
« From the File menu

1. In the menu, click File > New.

2. Click the Data mapping Wizards drop-down and select Generate counters.

You can set the following parameters:

« Starting Value: The starting number for the counter. Defaults to 1.

« Increment Value: The value by which to increment the counter for each record. For
example, an increment value of 3 and starting value of 1 would give the counter values of
1,4,7,10,[..]

« Number of records: The total number of counter records to generate. This is not the end
value but rather the total number of actual records to generate.

« Padding character: Which character to add if the counter's value is smaller than the
width.

« Width: The number of digits the counter will have. If the width is larger than the current
counter value, the padding character will be used on the left of the counter value, until the
width is equal to the set value. For example for a counter value of "15", a width of "4" and
padding character of "0", the value will become "0015".

« Prefix: String to add before the counter, for example, adding # to get #00001. The prefix
length is not counted in the width.

« Suffix: String to add after the counter. The suffix length is not counted in the width.

Opening a data mapping configuration

To open an existing data mapping configuration, in the "Menus" on page 311, select File >
Open. Make sure that the file type is either DataMapper files or Connect files. Browse to the
configuration file to open, selectit and click Open.

Alternatively, click on File > Open Recent to select one of the recently opened configuration
files.
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Saving a data mapping configuration
A data mapping configuration file has the extension .OL-datamapper. The file contains the

settings, the extraction workflow ('Steps'), the Data Model and the imported Data Samples
(excluding database source files such as mySQL, oracle, etc).

To save a data mapping configuration:

« Inthe "Menus" on page 311, click on File > Save, or click on Save As to save a copy of a
data mapping configuration under a different name.

« Inthe "Toolbar" on page 388, click the Save button.

If the data mapping configuration has not been saved before, you have to browse to the location
where the data mapping configuration should be saved and type a name, then click Save.

Down-saving a data mapping configuration

The Connect software is backwards compatible: data mapping configurations that were made
with an older version of Connect can always be opened with the newest version of the
software.

But newer data mapping configurations cannot be opened with an older version of the software.
Connect, however, allows you to save a data mapping configuration in the format of a previous
version of the software, so that you may restore a data mapping configuration that was
accidentally opened and saved in a newer version, or share a data mapping configuration with
users of a previous version of Connect.

Note that it may not always be possible to down-save a data mapping configuration to a an
older version. For instance, a JSON-based data mapping configuration cannot be saved to a
version earlier than 2021.1 because the JSON data type did not exist prior to that version.

To down-save a data mapping configuration, select File > Save a Copy, from the menu. Select
the software version and click OK. Next you can select a location and give the data mapping
configuration a name, as usual.

To save a copy, follow the same procedure without selecting a previous version of the
software.

Note

Since it was not possible to create a data mapping configuration for a JSON file (without
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conversion to XML) until version 2021.1, these data mapping configurations cannot be
saved in the format of an earlier version.

Using the wizard for CSV and Excel files

The DataMapper wizard for CSV and Excel files helps you create a data mapping configuration
for such files. The wizard automatically detects delimiters and extracts all data in one extraction
step.

The wizard interprets each line in the file as a record. If your data file contains transactional
data, you will probably want more lines to go in one record and put the transactional data in
detail tables.

The wizard cannot create detail tables. If the file contains transactional data, the data mapping
configuration is best created without a wizard (see "Creating a new data mapping
configuration" on page 204).

There are two ways to open a CSV file or Excel file with a wizard: from the Welcome screen or
from the File menu.

« From the Welcome screen

1. Open the PReS Connect Welcome page by clicking the ¢ icon at the top right, or
select the Help menu and then Welcome.

Click New DataMapper Configuration.

From the Using a wizard pane, select CSV/XLSX/XLS.

Click the Browse button and open the file you want to work with.
5. Click Next.

o From the File menu

BN

1. In the menu, click File > New.

2. Click the Data mapping Wizards drop-down and select From CSV/XLSX/XLS
File.

3. Click Next.
4. Click the Browse button and open the file you want to work with.
5. Click Next.
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Note

Excel files saved in "Strict Open XML" format are not supported yet.

After selecting the file, take a look at the preview to ensure that the file is the right one and the
encoding correctly reads the data. Click Next.

For an Excel file you can make the following settings:

« First row contains field names: Uses the first row of the Excel sheet as headers, which
automatically names all extracted fields.

« Sheet: Select the sheet from which the data should be extracted.

« Sort on: Allows to select a field on which to sort the data, in ascending (A-Z) or
descending (Z-A) order. Note that sorting is always textual. Even if the selected column
has numbers, it will be sorted as a text.

Fora CSV file the wizard will display the different settings it has detected, allowing you to
change them:

« Encoding: Defines which encoding is used to read the file.
« Separator: Defines which character separates each field in the file.
« Comment Delimiter: Defines which character starts a comment line.

« Text Delimiter: Defines which character surrounds text fields in the file. Separators and
comment delimiters within text are not interpreted as separator or delimiter; they are seen
as text.

« Ignore unparseable lines: Ignores any line that does not correspond to the settings
above.

« First row contains field names: Uses the first line of the CSV as headers, which
automatically names all extracted fields.

« Sort on: Allows to select a field on which to sort the data, in ascending (A-Z) or
descending (Z-A) order. Note that sorting is always textual. Even if the selected column
has numbers, it will be sorted as a text.
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Tip
The Sort on option, combined with the Stop data mapping option of the "Action step" on

page 271, allows to process only a group of items without having to examine all records.
(See also: "Action step properties" on page 360.)

Verify that the data are read properly.

Finally click Finish. All data fields are automatically extracted in one extraction step.

Using the wizard for databases

The DataMapper wizard for database files helps you create a data mapping configuration for a
database file. The wizard extracts the data in one extraction step.

The wizard cannot create detail tables. If the file contains transactional data, the data mapping
configuration is best created without a wizard (see "Creating a new data mapping
configuration" on page 204).

Opening a database file with a wizard

There are two ways to open an XML file with a wizard: from the Welcome screen or from the
File menu.

« From the Welcome screen

1. Open the PReS Connect Welcome page by clicking the ¢ icon at the top right or
select Help > Welcome on the menu.

Click New DataMapper Configuration.
From the Using a wizard pane, select Database.

BN

Use the drop-down to select the database type.
5. Click Next.
o From the File menu
1. In the menu, click File > New.
2. Click the Data mapping Wizards drop-down and select From databases.
3. Click Next.
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4. Use the drop-down to select the database type.
5. Click Next.

Wizard settings for a database file

After opening a database file with a wizard there are a number of settings to make, depending
on the database type (see below).

On the last page of the dialog, click Finish to close the dialog and open the actual data
mapping configuration.

Note

After creating the initial data mapping configuration you may use a custom SQL query via
the Input Data Settings; see "Settings for a database" on page 232.

Tip
The Sort on option, combined with the Stop data mapping option of the "Action step" on

page 271, allows to process only a group of items without having to examine all records.
(See also: "Action step properties" on page 360.)

MySQL, SQL Server or Oracle

« Server: Enter the server address for the database.
« Port: Enter the port to communicate with the server. The default port is 3306.

« Database name: Enter the exact name of the database from where the data should be
extracted.

« User name: Enter a user name that has access to the server and specified database. The
user only requires Readaccess to the database.

« Password: Enter the password that matches the user name above.

- Table name: The selected database is a set of related tables composed of rows and
columns corresponding respectively to source records and fields. Select a table from
which you want to extract data.

« Encoding: Choose the correct encoding to read the file.
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« Sorton: Select a field on which to sort the data, in ascending (A-Z) or descending
(Z-A\) order. Note that sorting is always textual. Even if the selected column has
numbers, it will be sorted as a text.

Microsoft Access

« Password: Enter a password if one is required.

« Table name: The selected database is a set of related tables composed of rows and
columns corresponding respectively to source records and fields. Select a table from
which you want to extract data.

« Encoding: Choose the correct encoding to read the file.

« Sorton: Select a field on which to sort the data, in ascending (A-Z) or descending
(Z-A\) order. Note that sorting is always textual. Even if the selected column has
numbers, it will be sorted as a text.

ODBC Data Source

« ODBC Source: Use the drop-down to select an ODBC System Data Source. This must
be a data source that has been configured in the 64-bit ODBC Data Source Administrator,
as PReS Connectis a 64-bit application and thus cannot access 32-bit data sources.

« This ODBC source is MSSQL.: Check this option if the ODBC source is MSSQL (SQL
Server). The options below appear under MSSQL-ODBC advanced configuration:

« Windows authentication: Select to use the Windows user name and password that
are used by the Connect Service.

« SQL Server authentication: Select to use the User name and Password set below
to connect to the SQL Server:

« User name: Enter the SQL Server user name.
« Password: Enter the password for the above user name.

« Sort on: Select a field on which to sort the data, in ascending (A-Z) or descending
(Z-A) order. Note that sorting is always textual. Even if the selected column has
numbers, it will be sorted as a text.

Page 214




JDBC

Note

Since JDBC can connect to multiple types of databases, a specific database driver and
path to this driver's JAR file must be specified.

- JDBC Driver: Use the drop-down to select which JDBC Driver to use for the database
connection.

« JAR file path: Enter a path to the JAR file that contains the appropriate driver for the
database.

o Server: Enter the server address for the database server.

« Database name: Enter the exact name of the database from where the data should be
extracted.

« User name: Enter a user name that has access to the server and specified database. The
user only requires Read access to the database.

- Password: Enter the password that matches the user name above.

« Advanced mode: Check to enable the Connection String field to manually enter the
database connection string.

« Connection string: Type or copy in your connection string.

« Sort on: Select a field on which to sort the data, in ascending (A-Z) or descending
(Z-A\) order. Note that sorting is always textual. Even if the selected column has
numbers, it will be sorted as a text.

Using the wizard for JSON files

The DataMapper wizard for JSON files helps you create a data mapping configuration for a
simple JSON file. The wizard provides limited options for specifying source records and
boundaries, and adds one extraction step.

The wizard cannot create detail tables. If the file contains transactional data, the data mapping
configuration is best created without a wizard (see "Creating a new data mapping
configuration" on page 204).
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There are two ways to open a JSON file with a wizard: from the Welcome screen or from the
File menu.

« From the Welcome screen

1. Open the PReS Connect Welcome page by clicking the ¢ icon at the top right or
select the Help menu and then Welcome.

2. Click New DataMapper Configuration.

3. From the Using a wizard pane, select JSON.

4. Click the Browse button and select the file you want to work with. Click Next.
o From the File menu

1. Inthe menu, click File > New.

2. Click the Data mapping Wizards drop-down and select From JSON File.
3. Click Next.
4

. Click the Browse button and select the file you want to work with. Click Next.

After selecting a JSON file, specify if and how the JSON file must be split into multiple records.
This is done by selecting an object or array as parent element. Its direct child elements -
objects and arrays, not key-value pairs - can be seen as individual source records. If the root is
selected, there will be only one source record.

Whether source records are output as individual records depends on the trigger. Either:

« Select On element to create a new record in the output for each object or array in the
parent element.

« Select On change to create a new record each time the value in a certain key-value pair
changes. Only key-value pairs that exist at the root of a child element can be evaluated.

When you click Finish, a data mapping configuration will be set up with one Extract all step.

All data found in child elements of the selected parent element are extracted to fields at the root
of the Data Model. If a value consists of an object or array, the entire object or array is extracted
to one data field.

Field names are derived from keys, objects and arrays in the first record, but those aren't
necessarily the same in a subsequent record. If following records have a different structure, for
example if a record has more child elements compared to the first record, some data may not
get extracted.
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Any elements outside the selected parent element are repeated in the source records, but they
don't get extracted automatically.

Using the wizard for PDF/VT or AFP files

The pages in PDF/N/T and AFP files can be grouped on several levels. Additional information,
such as TLEs - a TLE is a Tagged Logical Element - in AFP files, can be attached to each level
in the structure. The structure and additional information are stored in the file's metadata.

The DataMapper wizard for PDF/VT and AFP files lets you select a level to trigger the start of a
new record and it also enables you to extract the additional information from the metadata. You
can extract data from the content afterwards.

Tip
How to extract information from the metadata in the extraction workflow itself is explained
in: "Extracting metadata" on page 241.

If the data file doesn't contain any metadata, each page is a new record - in other words, a
boundary is set at the start of a new page -, which is exactly what happens when you open the
file without a wizard.

You can open a PDF//T or AFP file with a wizard using the Welcome screen or the File menu.

« From the Welcome screen

1. Open the PReS ConnectWelcome page by clicking the ¢ icon at the top right or
select the Help menu and then Welcome.

2. Click New DataMapper Configuration.
3. From the Using a wizard pane, select PDF/VT or AFP.

4. Click the Browse button and open the PDF/VT or AFP file you want to work with.
Click Next.

o From the File menu
1. Inthe menu, click File > New.
2. Click the Data mapping Wizards drop-down and select From PDF/VT or AFP.
3. Click Next.
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4. Click the Browse button and open the PDF/VT or AFP file you want to work with.
Click Next.

After selecting the file, select the following options in the Metadata page:

- Metadata record levels: Use the drop-down to select what level in the metadata defines
a record.

« Field List: This list displays all fields on the chosen level and higher levels in the PDF/NVT
or AFP metadata. The right column shows the field name. The left column displays the
level on which it is located. Check any field to add it to the extraction.

Note

NOP (No Operation) records in AFP files cannot be extracted.

Click Finish to close the dialog and open the actual Data Mapping configuration.
On the Settings pane, you will see that the boundary trigger is set to On metadata. The
selected metadata fields are added to the Data Model.

Note

Extracting data from a PDF that comes from a Windows printer queue (a PDF converted
to PostScript, converted back to PDF by an Input task in Workflow) might not work (see
the Connect Knowledge Base.)

The rule of thumb is: if copy-paste from Acrobat works, so will data mapping; if not, the
DataMapper won't either.

Note

Rotated pages in a PDF are supported (if rotated 0/90/180/270 degrees). The Extract
step will be able to extract data from horizontal and vertical lines of text on rotated pages.
Motion steps (such as the Repeat step and the Goto step) however, can only work as
expected if text on a page has the same orientation as the page, not when text has been
rotated after the page was rotated.

The page number and rotation of a page are shown in the status bar at the bottom, next to
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he region selection information.

Using the wizard for XML files

The DataMapper wizard for XML files helps you create a data mapping configuration for an
XML file. The wizard lets you select the type of node and the trigger that delimit the start of a
new record. Next, the wizard extracts the data in one extraction step.

This wizard can also be used to extract data from a JSON file. JSON files are automatically
converted to XML.

If there is no root element in the JSON it will be added and each object without a named parent
elementis called an 'item".

Note that in addition to being valid, the JSON should follow naming rules for XML elements. For
example, "adress_line_1:"is a valid key name in JSON, but it cannot be converted to a valid
element name in XML because the colon is reserved for namespaces. For XML naming rules
and best naming practices, see: XML elements on W3Schools.

The wizard cannot create detail tables. If the file contains transactional data, the data mapping
configuration is best created without a wizard (see "Creating a new data mapping
configuration" on page 204).

There are two ways to open an XML/JSON file with a wizard: from the Welcome screen or from
the File menu.

o From the Welcome screen

1. Open the PReS Connect Welcome page by clicking the ¢ icon at the top right or
select the Help menu and then Welcome.

2. Click New DataMapper Configuration.
3. From the Using a wizard pane, select XML.

4. Click 